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Introduction

Welcome to Reyburn CyberTuner®, the most advanced visual tuning system
on the inner planets!

Who wrote this manual?
This manual was written by two people with very different experience levels of

Reyburn CyberTuner.
Dean Reyburn, RPT, is a professional piano technician as well as RCT’s designer,

programmer, and, with his wife Martha Reyburn, co-owner of its publishing
company, Reyburn Piano Service, Inc. Obviously, Dean knows the program pretty
well. 

Mitch Kiel, RPT, is also a professional piano technician. Mitch first saw Reyburn
CyberTuner a few months before its initial release when Dean asked him to be a beta
tester (aka guinea pig) and, later, author of this manual.

One guy who knows the program intimately and another who had to learn it from
scratch. We think it’s a winning combination for creating an easy-to-read and
complete manual.

Please read this
Reyburn CyberTuner (RCT) is not copy-protected — you can make as many

copies as you wish. However, RCT is execution protected, meaning it will not run
unless the SentinelKey hardware security device (included with purchase) is attached
to your computer or SoftKey is installed (laptops only). SoftKey is a software
version of SentinelKey which, when installed, lets RCT run without SentinelKey.
Complete instructions for installing SentinelKey and SoftKey are in your Getting
Started Manual and in this User Manual’s chapter 1 “Getting Started.”

Using Reyburn CyberTuner for the first time indicates your acceptance of the
software license agreement/notification of copyright in the Appendix. Please read it
carefully before proceeding.

Are you computer savvy?
We assume you already know how to perform basic computer operations —

opening files, using a mouse, saving documents, pulling down menus, etc. 
If not, please do the following before reading this manual or using RCT:
Study your computer’s User Manual; run its on-line tutorial; read books such as

Windows for Dummies or Macs for Dummies; join a local user group; find a
computer buddy; or take a training course from a local college, computer dealer, or
professional training company.

Learning to use RCT
If you’re like most computer users, you want to fling this User Manual into a dark

closet and plunge right in to tuning with RCT. Please don’t. Even though Reyburn
CyberTuner is easy and intuitive to use, if you don’t first learn a little about it you
might get confused or, even worse, you might never discover some of RCT’s
coolest features.

We don’t expect anyone to read the User Manual cover to cover in one sitting.
Instead, we offer these recommendations:

Read your Getting Started Manual. It’s a separate publication from this User
Manual that’s very short and concise. You have two copies: a print version and one
installed on your hard disk with RCT.

Watch the RCT video. We made it ourselves. It’s corny yet effective, just like us.
You can watch a little at a time. The most important stuff is first.
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If you’re already experienced with computers and piano tuning, read the Getting
Started Manual then open RCT, poke around, and come back to this User Manual
when you’re ready to learn more 

If you’re a less-experienced computer user or tuner, please also read the chapters
“Chameleon 2” and “CyberEar.”

To learn more about saving RCT tunings, read “Editing Files” and “Tools.” The
RCT video also has a great section on saving tunings.

If you’re exchanging data between RCT and another MIDI-capable device, read
“Using MIDI.”

Chameleon 1 has been superseded by Chameleon 2, so Ch1 is rarely if ever used.
If you want to learn about it anyway, read “Chameleon 1.”

Pianalyzer is RCT’s very cool mini-spectrum analyzer, and you can learn about it
in the chapter “Pianalyzer.”

RCT is approved by the Piano Technicians Guild for measuring and scoring the
Registered Piano Technician tuning exam. To learn more about this feature, read
“Scoring the RPT Tuning Exam”.

There may be a “What’s New” file on your hard disk in the RCT folder. This file
may contain last-minute info about RCT not included in this manual.

This manual covers both the Macintosh and Windows versions of RCT. In most
cases RCT works exactly the same on both platforms. When noting small
differences, we’ll let you know with a parenthetical “Mac” for Macintosh-only stuff
or “Win” for Windows-only. For differences requiring longer explanations, we’ll
add cute little icons:

 Macintosh

 Windows

The Appendix contains information on SentinelKey and SoftKey, the software
license agreement, platform-specific help for both Macintosh and Windows, and a
compendium of tips and tricks for using RCT.

Tuna fish?
When we designed RCT and wrote this manual, we assumed you already knew

basic piano tuning theory and have tuned a few pianos. 
RCT is a great educational tool but can’t teach you everything you need to know

all by itself.  You also need a qualified teacher or mentor. Contact the Piano
Technicians Guild Inc., 3930 Washington, Kansas City, MO 64111-2963. PTG’s
phone number is (816) 753-7747, their fax number is (816) 531-0070, their email
address is ptg@ptg.org, and their Web page is at www.ptg.org. PTG is a non-profit
organization with approximately 4,000 members that offers educational and business
support to professional piano technicians and interested amateurs. PTG has
hundreds of local chapters throughout the US, Mexico, Canada, Puerto Rico, and
the Virgin Islands, and is affiliated with the International Association of Piano
Builders and Technicians. 

A Registered Piano Technician is a member of the Piano Technicians Guild who
has passed a rigorous 3-part examination (written, technical, and tuning) covering
most aspects of piano technology. Both Dean and Mitch are Registered Piano
Technicians in the Piano Technicians Guild. 

What computer can I use with RCT?
Reyburn CyberTuner runs on Macintosh and Windows, on both laptops and

desktops.
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Macintosh
RCT runs on Macintosh computers with 68040 CPUs or later, 50 mHz or faster,

running System 7.5 or later. RCT 3.5 needs at least 6 megs of free RAM (4 megs on
68040 Macs) after the OS (and any other running program) is loaded. Virtual
memory must be off when using RCT on a Macintosh. We recommend you set your
disk cache to at least 1024k in the Memory Control Panel to allow RCT to run as
effieciently as possible.

 Windows
RCT runs on Windows computers with Pentium chips 90 mHz or faster (120 or

faster recommended) running Windows 95, 98, 2000, NT, or Me, with at least 6
megs of free RAM after Windows (and any other running program) is loaded. The
computer must have a Windows-compatible sound card capable of recording. It
must have an internal microphone or an external microphone jack and external mic.
An audio line-in jack or external mic-in jack is recommended for calibration.

Differences between RCT/Mac  and RCT/Win 
RCT looks and acts almost exactly the same on Macintosh and Windows

computers. The differences are in appearance only.
Here’s one difference worth noting.We’ve discovered that Windows computers

from different manufacturers sometimes differ in the initial  accuracy of their internal
pitch calibration. After calibration, their pitch is accurate unless a new sound card is
installed. This means that all Windows computers should be calibrated immediately
after installing RCT. It’s also a good idea to check the calibration of your Mac, even
though most Macs are correctly calibrated when new. Both RCT Mac and RCT
Windows include a quartz electronic pitch source we call “CyberFork” for
calibrating your computer. This one-time procedure takes about five minutes. It’s
fully explained in this manual’s CyberEar chapter and on a separate sheet included
with your purchase of RCT.

A small but important difference between RCT/Mac and RCT/Win is keyboard
shortcuts. Macs often use the Command key (also called the Apple key) which will
have printed on it a propeller-like symbol . On Windows, equivalent keyboard
shortcuts use the Control key. (Macs have a Control key, which is different from 
Window’s Control key. The Mac’s Control key is never used for keyboard
shortcuts.) Another modifier key used in RCT/Mac is the Option key; its Windows
equivalent is the Alt key.

Throughout this manual, keyboard shortcuts will be shown for both Mac and Win.
For example: “Command + F (Mac) or Control + F (Win)” means press the
Command key and the F key if you have a Mac or the Control key and the F key for 
Windows. “Option + R (Mac) or Alt + R (Win)” means press the Option key and R
key for Macs or the Alt key and R key for Windows. 

Support
Free unlimited support is provided for one year after purchase of RCT or an RCT

upgrade by Dean and Mitch via phone, email, fax, snail mail (US Postal Service),
carrier pigeon or, if your name is Deanna Troi, mental telepathy.

The best way to continue using our unlimited free (and phone toll free) support is
to have the most recent version of RCT. When you receive an RCT upgrade you
also get an additional year of free support, as well as insuring that your version of
RCT is as compatible as possible with the latest computer technology.

If you purchased your hardware or software from Dean or Mitch, we’re happy to
provide our customary high level of support. If your question concerns hardware or
software purchased elsewhere, please be considerate of Dean’s and Mitch’s time
(we’re probably working on enhancements to RCT!) and seek support from the
company from which you purchased your software or hardware.
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If you have non-RCT questions about using your computer, look in “Macs for
Dummies” or “Windows for Dummies,” your computer’s User Manual, or your
computer’s online Help. If you still need help, contact the computer’s manufacturer. 

Whenever you contact us, please tell us your:
1. RCT version number (e.g. 2.5, 3.0, 3.5, etc.)
2. Your RCT serial number, written on a label on your SentinelKey and displayed

in RCT’s startup screen. You can also open RCT and click the menu item “About
RCT” under the Help menu (Win) or Apple Menu (Mac)

3. Your computer’s manufacturer, model, and specs (e.g., Macintosh 2400c 180
mHz, Sony Vaio 505 200 mHz, etc.)

4. Operating system version and amount of built-in memory:
Mac: Open “About this Mac” or “About this Computer” under the Apple menu.

 Win: Click the Start Menu, Settings, Control Panel, then System.

Email Support
Email is the preferred method of getting support because we can research your

problem and provide you with a detailed written solution. 
There are two ways to get email support.
You can send your support questions to <support@reyburn.com>. (Don’t type the

caret marks < and >.) Email sent to <support@reyburn.com> is forwarded directly
to Dean or Mitch, depending on who’s answering support questions that week.
Please send email to this address rather than directly to Dean or Mitch.

Your second choice is more communal and probably more fun. CTuner is a free
listserv wholly dedicated to RCT. “Listserv” is a term for an email discussion group
in which messages are automatically posted to and from all subscribers.

CTuner is a great way to learn about RCT because Dean, Mitch, and many
advanced RCT users are subscribers. We all love to talk about RCT, so if you post a
question you’ll probably receive lots of interesting answers. After you get a few
pianos under your CyberBelt, you might even want to answer a CTuner question.

All registered users of RCT are eligible to become CTuner subscribers. To use
CTuner, the only hardware you need is your computer and a modem. To connect to
the Internet, you need to sign up with an Internet Service Provider (ISP). Most
ISP’s will assist you in connecting to the Internet.

To subscribe to CTuner, send email to <majordomo@reyburn.com>  and in the
body of the message write <subscribe ctuner>. Don’t type anything else in the
message body. Make sure your full name is in the return address field. After
subscribing, you’ll be able to send and receive CTuner messages at the address
<ctuner@reyburn.com>.

Phone support
RCT comes with one year of free unlimited toll-free phone support from Dean and

Mitch. To enable continuation of this generous policy, please be judicious and
responsible. We spent a lot of time writing this manual so you could answer most of
your own questions. If you phone us for help, the first question you’ll be asked is,
“Have you looked in the manual?” We hope the answer is “Yes.”

When you phone us, please have your computer plugged in to an AC outlet and
running RCT, and have on hand your dock and floppy drive, original RCT floppy
disks or CD, and SentinelKey. Please note that Dean lives in Michigan in the Eastern
Time Zone and Mitch is in Washington state in the Pacific Time Zone.

30 Day Money Back Guarantee
If you’re not completely satisfied, Reyburn CyberTuner can be returned within 30

days of receipt for a full refund, excluding shipping. This 30 day money back
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responsible. We spent a lot of time writing this manual so you could answer most of
your own questions. If you phone us for help, the first question you’ll be asked is,
“Have you looked in the manual?” We hope the answer is “Yes.”

When you phone us, please have your computer plugged in to an AC outlet and
running RCT, and have on hand your dock and floppy drive, original RCT floppy
disks or CD, and SentinelKey. Please note that Dean lives in Michigan in the Eastern
Time Zone and Mitch is in Washington state in the Pacific Time Zone.

30 Day Money Back Guarantee
If you’re not completely satisfied, Reyburn CyberTuner can be returned within 30

days of receipt for a full refund, excluding shipping. This 30 day money back
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guarantee is available only to those in the piano tuning trade or currently enrolled in a
bona fide training program.

Before returning any item, you must first call us and receive a Return
Authorization number. No returns will be accepted without a Return Authorization
number.

Returned merchandise must be received in like-new condition and include all
original packaging and materials.

5 year guarantee on SentinelKey
The SentinelKey included with RCT is guaranteed for a period of five (5) years

from date of purchase. If the SentinelKey fails for any reason other than misuse,
abuse, or failure to follow the cautions in this manual, it will be replaced or repaired
at our option. If it fails after the guarantee period, a SentinelKey can be replaced or
repaired for a nominal cost.

Upgrade Policy
All registered RCT users will be notified of RCT upgrades. If an upgrade is

released within six months of your purchase of RCT, it is available free for
download at our Web site or by regular mail on a floppy disk for a nominal charge.

Reyburn Piano Service 
Reyburn Piano Service, Inc. (RPS) has been producing software products for

piano technicians since 1983. RPS introduced Piano Service Manager in 1990,
Tuning Manager for MS-DOS in 1992, and Tuning Manager for the Macintosh in
1994.  In July 1995 Chameleon 2 was added to Tuning Manager for the Macintosh.
Reyburn CyberTuner for Macintosh was released in July 1996, including the new
innovations CyberEar and Pianalyzer. Reyburn CyberTuner for Windows was
released in October 1998.

Reyburn CyberTuner® version 3.5
by Reyburn Piano Service, Inc.
©1992, 1993, 1994, 1996, 1997, 1998, 1999, 2000, 2001 All Rights Reserved
Dean L. Reyburn, RPT, designer and programmer

The technology in Reyburn CyberTuner®, primarily Chameleon 2 and CyberEar,
is protected under United States Patent 5719343, 5773737 and 57814748. Other
Patents Pending.

CyberTuner and CyberEar are trademarks of Reyburn Piano Service, Inc.

RCT Manual by Mitch Kiel, RPT and Dean Reyburn, RPT
©1996, 1997, 1998, 1999, 2000, 2001 Reyburn Piano Service, Inc. All Rights

Reserved

RCT Authorized Distributors

Reyburn Piano Service, Inc.
Dean & Martha Reyburn
2695 Indian Lakes Road NE
Cedar Springs, MI  49319 USA
1-888-SOFT-440 (1-888-763-8440)
or (616) 696-0500
fax: (616) 696-8121
email: dean@reyburn.com
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Mitch Kiel, RPT
11326 Patsy Drive SE
Olympia WA 98501 USA
1-888-I-LUV-RCT (1-888-458-8728)
or (360) 790-9000
fax: (360) 264-4795
email: mitch@reyburn.com

Odd Aanstad, RPT
Boda Asen
SE - 671 95 KLASSBOL
Sweden
phone (+46) 570 511 84 Fax: (+46) 570 511 94
email: odd@reyburn.com 

Jan R.C. Lensing
Lensing Piano Service / www.pianostemmer.nl
Lutmastraat 141-A
1073 GV AMSTERDAM
The Netherlands
phone (+31) 20 4702 639 or (+31) 6 246 09 428
fax (+31) 20 4702 639
email: jan@reyburn.com 

Mark Bolsius, RPT
Bolsius Piano Services
PO Pox 182
Jamison Centre
ACT 2614 Australia
phone toll free 81-800-675-871 within Australia (or (+61) 02 6254 5810)
mobile: (+61) 041 202 9599
fax: (+61) 02 6254 8844
email: mark@reyburn.com  

Michel Lachance, RPT
12, Pope
Cookshire, Quebec CANADA J0B 1M0
phone toll free 877-875-1485 or 819-875-1485
fax: 819-875-3368
email: michel@reyburn.com  

Hugo Landolfi
Echague 1190 2A
Villa Bosch (1682)
Buenos Aires, Argentina
(541) 844-3306
(541) 564-1179
fax: (541) 844-3409
email: hugo@reyburn.com

Schaff Piano Supply Company
451 Oakwood Road
Lake Zurich, IL, 60047 USA
1-800-747-4266

Visit the RCT Web Site at www.reyburn.com
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chapter 1

GETTING STARTED

SentinelKey and SoftKey
Reyburn CyberTuner (RCT) is not copy-protected — you can make as many copies

as you wish. RCT is execution protected, meaning it will not run unless the
SentinelKey hardware key is used (included with every purchase of RCT) or SoftKey
is installed. SoftKey is a software version of SentinelKey which works on laptops
only. When SoftKey is installed on a laptop (recommended), RCT will open and run
without SentinelKey attached.

Always shut down your computer before attaching or un-attaching SentinelKey.

• If SentinelKey is not attached and SoftKey is not installed, RCT will not open.
• If SentinelKey is attached but SoftKey is uninstalled, RCT will open. On laptops,
the SoftKey dialog box will automatically appear, asking if you want to install
SoftKey.
• If SoftKey is installed but SentinelKey is not attached, RCT will open.
• If SoftKey is installed, SentinelKey will not open RCT on another computer. 

This security system is very simple to use and virtually trouble-free. If you ever
have a problem, call us. We can usually fix it over the phone.

 Hint
SoftKey won’t recognize a version of RCT with a higher number than the
version that was running when it was last installed. This means SentinelKey
must be plugged in before an upgrade of RCT will open and SoftKey must be
re-installed. 
SoftKey recognizes any older versions of RCT. For example, if you installed
SoftKey on RCT 3.0, version 3.5 won’t open but version 2.0 will. If you then
shut down you computer, attach SentinelKey, start up your computer, open
RCT 3.5, and install SoftKey, RCT versions 2.0, 3.0, and 3.5 will all open.

Installing RCT 

 Mac only: Open the Memory control panel. Make sure Virtual Memory is off.
(Virtual Memory must be off whenever running RCT.) Make sure the size of the
Disk Cache is at least 1024k, with 2048K recommended

 Windows Virtual Memory works fine with RCT. Most users should let
Windows handle the VM and Disk Cache details.

Win and Mac

Step 1.  Start up your computer and Insert RCT floppy disk 1 or CD-ROM.

        
     Macintosh  Windows
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Step 2. Double click the icon labelled Install RCT 3.5. The Installer will open.

  Macintosh     Windows

       
Step 3. Follow the Install program instructions.. The Install RCT program will
step you through the entire Install process. RCT and all associated files will be
installed onto your computer automatically.

Step 4.  Shut down your computer. 

Step 5.  Plug SentinelKey into an ADB port (Mac) or parallel port (Win) or USB
port (Mac and Win).
If you’re not sure where the port for the SentinelKey  is located, look at your
SentinelKey and find a matching port on the computer. There will be only one port
that matches. Some laptops have the correct port on a dock.

See Appendix B for more about SentinelKey.

Step 6.  Restart your computer. RCT may open automatically. If not, double click
on the RCT alias (Mac) or shortcut (Win) on the Desktop. On laptops, the SoftKey
dialog box will appear, telling you SoftKey is not installed.

SoftKey not installed

If you forgot to plug in SentinelKey, RCT won’t open and the SoftKey dialog box
won’t appear. You need to shut down, plug in SentinelKey, and restart your
computer. If necessary, start RCT. 

Click Install. SoftKey will automatically be installed onto your computer.

SoftKey installed

Click Quit or Exit. The SoftKey dialog box will close and RCT will quit. 
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A PDF copy of the RCT manual will be installed into the RCT 3.5 folder. It can be
viewed with Adobe Acrobat Reader, which may be included with your computer. If
not, it’s available free on the Internet at www.adobe.com.

Shut down your computer and unplug SentinelKey. Put the SentinelKey back in its
protective silver bag and box. The silver bag protects it from static electricity.

Caution!
Carefully store your SentinelKey in a safe and secure place. If the
SentinelKey is ever lost or stolen, you will need to purchase another
RCT with SentinelEve at full price.

More about installing RCT
• The Installer will put the new version of RCT and associated files into a folder
named “Reyburn CyberTuner 3.5” in the Application (Mac) or Program Files (Win)
folder of your hard drive. Installing to this location is recommended and may make
future upgrades and installations simpler. If you prefer a different location for RCT,
select a folder from within the Installer when prompted. 
• Older versions of RCT will be untouched by this installation. However, once the
new version of RCT is installed and working properly, we recommend the old
version be removed from the hard drive (after moving your tuning files to the new
version’s folder!). Otherwise, there’s a small chance an old version of RCT may
start when an old RCT document is opened. If you want to retain the older version
of RCT, make a backup copy on another drive.
• To save old RCT files, move them to the new RCT folder before putting the folder
containing the old version of RCT into the Trash/Recycle Bin.

The Installer gives you the option to open RCT automatically when the computer
starts up. If you change your mind about this later, then drag the RCT alias/shortcut
in the Startup items folder to the trash/recycle bin. 

On Mac the startup alias is in Macintosh HD:System Folder:Startup Items.
 The Win startup shortcut is in C:\WINDOWS\Start Menu\Programs\StartUp.

  
The RCT Install program deletes the old RCT aliases/shortcuts and replaces them
with aliases/shortcuts of the new version. 

 RCT/Win Install notes
• RCT/Win installer will only be able to find and delete the shortcuts if they have the
original name.
• Don’t move support files out of the RCT folder that have been installed by the
RCT Installer. See Appendix H for more info on these files.

Calibration
You should calibrate your laptop immediately after RCT is installed. Recalibrate if
the motherboard (logic board) or sound card is replaced.
 For a detailed description of calibration, please read the Calibrate section in the
CyberEar chapter or the separate blue sheet included with your copy of RCT.

Uninstalling SoftKey
You need to uninstall SoftKey to be able to use RCT on another computer.

Otherwise, you’ll rarely ever need to uninstall SoftKey.

With the laptop shut down, plug in SentinelKey. Start up the computer. Open
RCT. In the RCT menu bar, pull down the Edit menu and select “SoftKey...”. The
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SoftKey dialog box will appear. Click “Un-Install”.  Click “OK” to close the
SoftKey dialog box.

SoftKey is now uninstalled. After shut-down, SentinelKey can be removed and
plugged into another computer. Then you can start up RCT and, if desired, install
SoftKey on the new laptop.

Caution!
Be sure to uninstall SoftKey before you:
1. sell or lose access to the laptop or hard drive SoftKey is installed on.
2. have service work performed on your laptop computer.
3. format, partition, remove or replace your hard drive.

 Hint
Install SoftKey only on a laptop you own or have permanent access to. If the
computer on which SoftKey is installed becomes unavailable (for instance, you
give your friend back his laptop but forget to uninstall SoftKey first) your
SentinelKey will remain locked to the first computer and, even if your
SentinelKey is plugged into a second computer, RCT won’t open on that second
computer. Also, you won’t be able to run future upgrades to RCT.

We strongly suggest you don’t carry SentinelKey with you. Store SentinelKey in
a secure place. Don’t forget where you put it!

SentinelKey is warranted for five years from date of purchase. See Appendix B
for details. 

Basic Concepts
Here’s a quick overview of RCT’s most important functions.

The RCT modules used to tune a piano are Chameleon 2 and CyberEar. 
A typical procedure:
Place your laptop computer on the piano. Start the computer, open RCT (it may

open automatically), click the Record button and play samples, click the Calculate
button to calculate a tuning, open CyberEar, and tune each string until the Spinner
stops rotating.

Chameleon 2 — the main brain

Chameleon 2 (Ch2) calculates an 88-note piano tuning based on five (or six)
sampled notes.

How does Chameleon 2 work? 
First, Ch2 records a “partial ladder” for A4, A3, A2, A1, A5 and sometimes A6.

A partial ladder is a set of pitch readings for several partials (usually four) of one
note. Here are the partials recorded for each A sample note:

A4 partials 1, 2, 3, 4
A3 partials 1, 2, 3, 4
A2 partials 2, 4, 5, 6
A1 partials 4, 6, 7, 10
A5 partials 1, 2, 3
A6 partials 1, 2
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Ch2 uses these partial ladders to calculate single, double, and triple octaves,
putting the appropriate amount of octave stretch for the chosen tuning style. Ch2
chooses the appropriate octave type for each section of the piano (single octaves 2:1,
4:2, 6:3,  8:4, 10:5, and 12:6; double octaves 4:1 and in the low bass 8:2 and 12:3;
and triple octave 8:1).

Finally, notes between the sampled A’s are filled in using a customized curve
fitting procedure.

Chameleon 2 is based directly on aural tuning principles. That’s why RCT’s
tunings sound so good and why it’s so easy to use.

Ch2 matches one sampled note’s partial ladder to another’s, also called “virtual
direct interval tuning.” 

Ch2 makes thoughtful compromises between octave types, partial choices, and
scale inconsistencies, just like a good aural tuner would. 

Chameleon 2 lets you
• Choose between Easy mode (fewer choices) or Advanced mode (more

choices) 
• Select one of ten Octave Tuning Styles (OTS) to set the overall stretch.
• allow “Limits” to automatically (or compensate for inconsistent or poor

scaling or set your own custom Limits
• Select partials in the low bass, bass, and tenor.
• Edit any note’s cents deviation or partial.
• Save, name, arrange into folders, copy onto floppies, send over the

Internet, etc. an unlimited number of tunings
• Change the pitch of a tuning with just a few mouse clicks. The new pitch is

constantly displayed, as are all notes’ new cents reading.
• Convert any tuning to a pre-loaded historical temperament (57

supplied) or to any temperament you design (unlimited number).
• Instantly create a graph of any tuning.
• Average or compare multiple tunings and graph the result.
• Use Custom Equalizer to micro-adjust the stretch of any octave of any OTS.

CyberEar — the ear that hears

CyberEar (CE) measures and graphically displays a string’s pitch.
CyberEar features:

• Deviation displayed in cents or beats, rate adjustable.
• Target blushes when string is very close to correct pitch.
• NoteSwitcher automatically moves up or down a half-step when an adjacent note

is played. Manual noteswitching is also available.
• Cents reading for any note can be changed and saved directly to a tuning record.
• Aural Temp (Temperament) lets you create multiple tuning sequences for the

first 25 notes. 
• Four Pitch Raise modes, dynamic overpull percentages, automatic original pitch

recording, overpull cents calculated for every note, etc.
• Measure and record an aural tuning in less than 12 minutes.
• With one click of a mouse button, the Listener quickly measures any note’s cents

deviation to an accuracy of a one-hundredth of a cent. 
• With one click, the pitch of an entire tuning can be raised or lowered by either

beats or cents. Current pitch reading always displayed.
• Can use tuning data created by many formats (Chameleon 2, Chameleon 1, SAT,

manual input, etc.).
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Pianalyzer — making piano tone visible

Pianalyzer (PAZ) is a mini-spectrum analyzer. PAZ measures and displays cents
deviation, inharmonicity, sustain time, and volume for partials 1 to 16 for any note.

PAZ will quickly become your favorite research tool for studying tone and
partials. No longer do you need to wish for an extra $20,000 to spend on a fancy
spectrum analyzer. (You can still wish for the extra $20,000!) 

With the advent of PAZ, piano tone can be discussed with objectivity and
accuracy. Compare the tone of two different pianos in far-flung locations or track
one piano’s tonal changes over a twenty year period. PAZ can overlay readings of
two consecutive samples, so the effects of voicing can be easily quantified. For
example, compare volumes of a note’s partials before and after needling. 

The potential of PAZ is exciting and endless. Because PAZ is so new, you may
discover uses for PAZ no one else has thought of. If so, please let us know. There
might be a free RCT T-shirt in it for you. 

MIDI Control — transfer data to other VTDs

Reyburn CyberTuner is the easy way to link your computer to any MIDI-capable
visual tuning device (VTD) such as an SAT. Some common uses of RCT’s MIDI
Control: transfer copies of another VTD’s tunings to your computer for editing then
transfer them back; permanently archive another VTD’s tuning pages; send Ch2-
created tunings to another VTD. You can transfer tuning files between RCT/Mac and
RCT/Win using MIDI, although floppy disk transfer may be simpler.

Chameleon 1  
Chameleon 1 calculates a tuning from physical measurements you take of strings

from sample A notes. Even though it’s been superseded by Ch2, Chameleon 1 is
included with RCT because it takes up very little disk space (less than 10K) and is
used by some rebuilders. For example, if you’re rescaling a piano, you already have
the measurements needed for Ch1.

If you come up with any new uses for Ch1, let us know. If you’ve already won a
T-shirt, we’ll send you a CyberEarRing.
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Definitions and Terminology
Chameleon 2 creates a tuning record for each piano. A tuning record is a set of

cents readings at designated partials for all 88 notes. It also includes information
such as the pitch of A4 at its first partial and a 70-character header into which Ch2
automatically enters the Octave Tuning Style you’ve selected, the resultant beat
speeds of three sample intervals (B for Bass Control Octave A2-A3, T for Treble
Control Octave A3-A4, and D for Double Octave A2-A4), and which program
created the tuning record (Ch1, Ch2, etc.). You may type additional info into the
header up to its 70 character limit.

 Hint
If you’re new to computers or RCT, don’t save tuning records or files for at least
the first few weeks. (When RCT asks if you want to save a tuning file, click Don’t
Save or Cancel.) Instead, calculate a new tuning for every piano. After using RCT
for a while, it’ll be easier for you to learn how to manage RCT’s tuning files and
records. Actually, many RCT users, even the most experienced, don’t save every
record; instead, they create a new tuning for most pianos even if they’ve tuned it
before. Why? To insure the piano always receives the most accurate tuning.

Other visual tuning devices (VTDs) may use the term “page” for what RCT calls a
tuning record. Although they differ slightly, Sanderson AccuTuner (SAT) pages and
RCT tuning records can be translated and interchanged between your computer and a
MIDI-equipped SAT by using RCT’s MIDI Control and some extra hardware. See
chapter 7 “Using MIDI” for more details.

A tuning file holds from 1 to 240 tuning records. An RCT tuning file is a
standard computer file and uses the standard document icon—a page with its corner
turned down. An RCT tuning file can be stored in any folder, double clicked to open
it and its creator application (in this case RCT), dragged to the Trash (Mac) or
Recycle Bin (Win), etc.

Think of a tuning record as one page in a book and a tuning file as the entire book.
A skinny book can have one page and a fat book can have 240 pages; likewise, a
tuning file can contain anywhere from 1 to 240 tuning records. 

You can store as many tuning files on your hard disk as will fit. To further our
analogy, a bookstore (your hard disk) can hold as many books (tuning files) as
space allows. If you own other bookstores in other towns (Zip drive, floppy disk,
external hard drive, etc.) you can store a virtually unlimited number of books (RCT
tuning files).

Identifying and naming notes
Throughout RCT, notes are designated by the popular convention of letter and

octave number. For example C4 signifies middle C. Octaves change at every C and
only sharps names are used. 

To illustrate, the lowest notes on an 88-note piano are A0, A#0, B0, C1, C#1, D1,
etc. The note used to set pitch is A4. The piano’s highest notes are A7, A#7, B7,
and C8. (Music theorists may shudder, but C#3-F3 is the proper designation for this
major third.)

In CyberEar’s Aural Temperament prefs and when specifying the lowest plain
wire note in the CyberEar Pitch Raise dialog box, note numbers (e.g., 49) are
automatically converted to note names (e.g., A4). You may enter a note number into
these two windows, and it will be converted automatically to note name and octave
number when the window is closed.

A graphic piano keyboard appears in several RCT modules. For your
convenience, “C” is displayed on middle C and a tuning fork on A4.
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RCT Menu Bar
When RCT is running, the RCT menu bar (sometimes called the main menu) is

displayed across the top of your computer’s screen.
If you’re even the least bit familiar with computers, most of RCT’s menu bar

commands are familiar to you (Save, Save As, Print, etc.). If you’re new to
computers, please refer to your computer manual or Operating System manual to
learn about these common commands.

Other RCT menu commands:
Open Latest... keeps a sub-menu of the 8 most recently-used tuning files. This

list may be empty if you haven’t opened any RCT files yet.
Revert undoes changes to the current tuning file and goes back to the last saved

version.
Extract Exam pulls PTG RPT Exam data out of a SAT file transferred via MIDI.

See the chapter “Scoring the RPT Tuning Exam” for more details.
Import... translates tuning files from other platforms or other programs, such as

Tuning Manager.

The Edit menu has familiar commands like Undo, Cut, Copy, Paste, Clear, and
Select All. In RCT, these commands can act on words (in headers) or tuning records
(in Icon view with Tuning Hammer pointer selected).

The Edit menu also contains RCT-specific commands:
Paste Blank puts an empty tuning record into the active tuning file. 
Erase Data removes information in the chart cells of selected tuning records.
SoftKey lets you install and uninstall SoftKey, the software version of RCT’s

security device SentinelKey.
Preferences lets you select various settings for display, etc.

The Windows menu lets you open or go to any RCT module. Use the Windows
menu to jump between Chameleon 2, Custom Equalizer, Interval Preview Graph,
Partial Preview Graph, CyberEar, Pianalyzer, Chameleon 1, and MIDI Control.
Any or all of these modules can be open simultaneously.

The Windows menu also lets you choose from three management windows:
Tuning File, Tuning Chart, or Tuning Graph:
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Tuning File displays a tuning file and the all tuning records it contains.
Tuning File windows can be viewed in Icon view (under the View menu, select

Icon view)

or Header view (under the View menu, select Header view).
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Tuning Chart displays cents readings and partials for a tuning record.

A Tuning Chart window has a window displaying A4’s pitch, two buttons for
changing pitch, two information windows, two navigation buttons, a graph button,
a Print button, and a CyberEar button.

Clicking the Sharp and Flat buttons changes the pitch of A4 in increments of one
tenth (0.1) of a beat per second (hertz). The cents readings in every note’s cell will
automatically change the same amount.

To change the pitch of each note by 1 cent (approximately .25 bps) hold down the
Option key (Mac) or Control key (Win) and click the Sharp or Flat buttons. The
Shift key works too for both Mac and Win. The A4 pitch window may not change if
the pitch difference is less than 0.1 bps, but every cell in the chart will change to
reflect the new setting. This feature is used primarily during the RPT Tuning Exam.

You can type in any pitch from 390.0 to 490.0 directly into the A4 Hz window.
In most cases, we recommend you keep the Tuning Chart’s pitch at 440. To tune a

piano to a non-440 pitch, it’s usually better to select that pitch in CyberEar. If a
particular piano will always be tuned to a non-440 pitch, then it’s OK to reset its
pitch in the Tuning Chart

The upper information window displays data in the cell currently under the cursor.
The bottom window displays the name of the creator of the chart’s tuning data (e.g.,
Chameleon, Exam, FAC, Fairchild, etc.)

The Next and Previous buttons send you to the chart for the next and previous
tuning records in this file (if any). Command + right/left arrow key (Mac) or Control
right/left arrow key (Win) works too.

The Graph button displays a graph of the active chart.
The Print button prints the tuning chart. You can also print the tuning chart (and

many other RCT windows) by selecting “Print...” under the File menu or pressing
Command + P (Mac) or Control + P (Win).

The CyberEar button sends you to CyberEar, with the active chart loaded into
CyberEar ready for tuning.
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Tuning Graph displays a graph of a tuning record.

To go to the previous or next graph, hold down the Command key (Mac) or
Control key (Win) while pressing the computer’s left or right arrow keys. As noted
above, this shortcut also works for viewing the next or previous charts.

Closing a chart automatically closes its graph.

When you’re in the Windows menu
• to choose Tuning File, a tuning file must be open.
• to choose Tuning Chart, a tuning chart must be open
• to choose Tuning Graph, a tuning chart or file must be open.

Interval Preview Graph and Partial Preview Graph
In RCT 3.5, two new graphs are available. The Interval Preview Graph and the

Partial Preview graph display data about the most recently sampled piano or the
current Demo piano without first needing to click the Calculate button.

Under the Windows menu, the Interval Preview Graph and the Partial Preview
Graph let you virtually “pre-listen” to the tuning. These graphs are “live,” which
means they are automatically (re)calculated immediately after sampling a piano or
selecting a different OTS or partial. In other words, you don’t need to click Ch2’s
Calculate button first. That’s why they’re called “Preview “ graphs. This is different
from Ch2’s Tuning Graph, which is updated only after clicking Ch2’s Calculate
button. CEQ’s Aural Intervals and Difference graphs are also “live,” meaning they
too are automatically updated after any change in a sampled piano, OTS, CEQ slider
setting, or partial. 

The Interval Preview Graph displays predicted widths of the most important
intervals in either beats or cents and can be displayed relative to the lower or upper
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note. You can view this graph in two sizes, 100% (standard) or 200% (expanded)
for finer detail. Selectable intervals are 5ths (3:2), 12ths (3:1), 4ths (4:3), Major 3rd
(5:4), 10ths (5:2), 17ths (5:1), Octaves (2:1), Octaves (4:2), Octaves (6:3), Double
Octaves (4:1), Triple Octaves (8:1), and minor 3rds (6:5). Intervals are displayed in
different colors denoting intervals types as defined in Pianalyzer.

The Partial Preview Graph displays all the possible tuning curves for the
sampled piano using the OTS settings chosen in Ch2. Each curve is displayed in the
color “family” used in PAZ and the Interal Preview Graph. The sections of the
Partial curves with bolder (boxed) graphlines indictate the current settings for the
chosen OTS and partials; in other words, the boxed area of the graphlines the Partial
Preview Graph are exactly the same curves displayed in the familiar Tuning Graphs.

Interpreting the Interval Preview Graph
The Interval Preview Graph (IPG) can help you “pre-hear” the beat speeds of

your favorite aural intervals before you tune the piano. After viewing the IPG, you
may decide to select another OTS, use CEQ to customize the tuning, set User Limits
to another setting. Or it may alert you to a potential problem somewhere on the
keyboard that you want to aurally verify and, if necessary, corect by ear during (or
after) the tuning process.

Tips:
• Smooth curves in beat speeds of the 2:1, 4:2, and 6:3 octaves indicate a well-

scaled piano.
• Parallel curves for 3rds, 10ths, and 17ths also indicate a well-scaled piano.

Sometimes the 10ths will show a spike near A4; this in normal and sounds just fine.
To view the relationship of these curves more easily, select the “Lower” note radio
button.

• Look at the curves for 5ths and 12ths. On grands and well-scaled verticals these
curves will be smooth and stay narrow (negative beats) or close to pure. If they are
positive or non-smooth it means the 5ths and 12ths are wide, instead of narrow as
they should be. This may occur in short-scale pianos such as spinets. RCT’s Limits
function automatically creates the best compromises in the tuning calculations for
such poorly scaled pianos, so there may be nothing you can do to improve the
tuning (although you can try using a wider Bass SOM setting in User Limits in CEQ
or a wider OTS). At the least, you should aurally verify the notes where the curves
are positive or non-smooth. To better gauge the beat speeds of these slow-beating
intervals, choose the expanded 200% view radio button.
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(PPG). A great way to start is to look at Tuning Graphs (post-calculation) of saved
tunings. For instance, if you have a large Tuning Library, open the first tuning
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library by depressing the Command (Mac) or Control (Windows) key and pressing
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curves have nearby endpoints (indicating consistent inharmonicity), are valley-
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illustrate this point, using the same OTS and the Demo button, create some Partial
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9 graphs.
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The Partial Preview Graph, therefore, can be used to help you analyze the scale of
the piano and let you know if the tuning needs to “massaged” by RCT’s Limits,
which occurs automatically, by RCT’s customizable settings (CEQ or User Limits),
or even moreso by your experienced ears.

RCT’s View menu has three sections: Icon and Header view; Partial Numbers
and Partial Names; and Magnifying Glass and Tuning Hammer

Icon view displays a matrix of small piano icons each representing a tuning record.
Position the pointer (Magnifying Glass or Tuning Hammer) over a piano icon to
display the tuning record’s header.

Header view displays an alphabetical scrolling list of the headers of all tuning
records in the open tuning file.

In a tuning chart, partials in each chart cell can be displayed in two ways.
Partial Name displays note name and octave number. 
Partial Number displays partial number (assuming partial 1 is the fundamental,

partial two is one octave higher, etc.)
For example, let’s assume Chameleon 2 calculated a tuning record using for note

C1 the 12th partial (triple octave plus a fifth), which is G4. If you open the tuning
chart and select Partial Names, “G4” is displayed in the cell for C1. If you select
Partial Number, “12” is displayed. (Note: the 12th partial is recommended only on
large pianos).

3. Select a pointer or cursor. Your choice will depend on the action you wish
to accomplish.

  the Magnifying Glass pointer
 the Tuning Hammer pointer

If the Magnifying Glass is clicked on an icon (Icon view) or a header (Header
view) its tuning chart opens.

The Tuning Hammer pointer is used to select records for editing (cutting, copying,
and pasting). To open a tuning chart with the Tuning Hammer, press the command
key while clicking on a record’s icon or header.
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To cut, paste, and copy entire tuning records to a new location within a file or to
another file (in both Icon and Header view) use the Tuning Hammer pointer to select
a record(s) then use RCT’s edit commands (cut, copy, paste, etc.)

 Hint
Switch pointers by clicking on the pointer icons in the upper right corner of a
tuning file window. The keyboard shortcut for selecting the Magnifying Glass is
Command + M (Mac) or Control + M (Win); for the Tuning Hammer it’s
Command + T (Mac) or Control + T (Win).

The Search menu has two choices. Find Tuning... opens a dialog box for
finding characters within the header of a tuning record. Find Again repeats the
search. Search looks in the headers of all tuning records in an open tuning file. RCT
allows only one tuning file to be open at a time.

The Tools menu can help you organize, convert, and compare tuning records
and files. For more details on Tools menu commands, please see the chapter “Tools
Menu”.

User Temperaments and Historical Temp’ts enables conversion of a tuning
to a different (non-equal) temperament. User Temps can store an unlimited number
of temperaments you can create yourself. Historical Temps stores 57 temperaments
taken from “Tuning” by Owen Jorgensen, the definitive text on historical
temperaments and a must-have for anyone seriously interested in this subject. This
feature is explained in the chapter “Tools Menu.”

Tuning Doctor searches for anomalous cents readings (greater than twice the
RPT exam tolerance) or partial numbers (decreasing treble-ward) in all tuning
records in the open tuning file.

Sort alphabetizes all records in a selected file based on the entire text of the
header.

 
Math functions Average, Difference,  and Sum compare cents data of tuning

records. See the “Tools” chapter for details. 

Tuning Exam... is used for measuring and scoring the PTG Registered Piano
Technician tuning exam. For more details, please read “Scoring the RPT Tuning
Exam.”
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chapter 2

CHAMELEON 2

Chameleon 2 (Ch2) is RCT’s main brain. 
Ch2 calculates an 88 note tuning record by listening to sample notes of a piano

using a microphone (built-in or external) and the computer’s digital audio
capabilities. Chameleon 2 creates a tuning record that can be named, saved, edited,
graphed, searched, and analyzed.

Easy/Advanced mode for Ch2 
Chameleon 2 has two modes — “Easy” mode with fewer choices or “Advanced”

mode with more choices.

The first time RCT starts up, Easy mode is selected.
To change modes, click and drag the Easy/Advanced switch or click the non-

selected end of the switch. RCT remembers its mode when it quits and restores this
mode the next time RCT opens. 

In Easy mode, all you do is sample the A notes and click Calculate, then go to
CyberEar and start tuning. Easy mode makes all the decisions for you and is
recommended for less-experienced piano tuners or anyone learning to use RCT.
Many users like Easy mode so much they leave Ch2 in Easy mode forever! 

 
Easy mode automatically selects Octave Tuning Style 4 and Tuning Partials 6, 6,

and 3. Almost all pianos will sound very good with these settings. In fact, these
settings were chosen for Easy mode because they’re the preferred choice of many
RCT users.

Anytime you switch from Easy mode to Advanced mode, the OTS and partials for
Advanced mode will be reset to Easy mode’s defaults: OTS 4 and partials 6, 6,3, 2,
and 1.

22

chapter 2

CHAMELEON 2

Chameleon 2 (Ch2) is RCT’s main brain. 
Ch2 calculates an 88 note tuning record by listening to sample notes of a piano

using a microphone (built-in or external) and the computer’s digital audio
capabilities. Chameleon 2 creates a tuning record that can be named, saved, edited,
graphed, searched, and analyzed.

Easy/Advanced mode for Ch2 
Chameleon 2 has two modes — “Easy” mode with fewer choices or “Advanced”

mode with more choices.

The first time RCT starts up, Easy mode is selected.
To change modes, click and drag the Easy/Advanced switch or click the non-

selected end of the switch. RCT remembers its mode when it quits and restores this
mode the next time RCT opens. 

In Easy mode, all you do is sample the A notes and click Calculate, then go to
CyberEar and start tuning. Easy mode makes all the decisions for you and is
recommended for less-experienced piano tuners or anyone learning to use RCT.
Many users like Easy mode so much they leave Ch2 in Easy mode forever! 

 
Easy mode automatically selects Octave Tuning Style 4 and Tuning Partials 6, 6,

and 3. Almost all pianos will sound very good with these settings. In fact, these
settings were chosen for Easy mode because they’re the preferred choice of many
RCT users.

Anytime you switch from Easy mode to Advanced mode, the OTS and partials for
Advanced mode will be reset to Easy mode’s defaults: OTS 4 and partials 6, 6,3, 2,
and 1.



23

 Hint
It’s OK if you don’t save tuning records or files, and instead create a new tuning
at every piano, which after all only takes a minute or two. If you like Ch2’s Easy
mode, you might really like this simpler approach. Many RCT users, including
some of the most experienced, do this. If you’re new to computers, creating a
new tuning record at every piano will help make RCT easy to learn and to use.

 Hint
For suggestions on rubber mutes vs felt strips, making your own rubber split
mutes, tuning one string per note or unisons as you go, etc., please see
Appendix E.

Advanced Mode
To access Ch2’s full capabilities, switch to Advanced mode.
Advanced mode gives you the capability to create an almost infinite variety of

tuning styles. Octave Tuning Styles (OTS) let you choose an overall stretch style
from almost pure (OTS 1) to very wide (OTS 9). You can select different Tuning
Partials to prioritize certain partial matchings. And with Custom Equalizer, you can
micro-adjust the beat rates for every octave of any OTS, creating tunings with your
own personalized sound and viewing graphs to “pre-listen” and optimize your
tunings.

You may be asking, “But I thought there’s only one way to tune a
piano—correctly— and everything else is simply wrong. Why does Advanced mode
give me so many choices?”

That’s a good question. But for experienced tuners with good ears and educated
judgment, piano tuning is not that simple. Depending on varying conditions and
taste, a non-standard stretch or a different tuning partial may sound as good or better
than a traditionally “correct” tuning.
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Some piano tuners may find this a difficult concept. You may have been taught,
for example, that the F3-A4 10th should always be exactly one-half beat per second
faster than the F3-A3 3rd, or that a tenor interior 3rd should beat exactly the same as
its exterior 6th. 

While it’s true that these tests can create great-sounding tunings in most situations,
these aural tests (and others) are really just guidelines, not commandments. You are
the boss and, if you want, you can bend the rules to produce an “uncommon” tuning
that may sound just as good — or even better — than a “middle of the road” or
“safe” tuning. 

For example, experienced concert tuners often tune concert pianos such as the
Steinway D with very wide overall stretch, approximating OTS 7 or 8. On the other
hand, most home pianos sound best when tuned more moderately, such as OTS 3,
4, or 5. 

Another example: Listen to a piano freshly tuned by another tuner. He may have
tuned the high treble sharper than you prefer, or left the tenor 4ths surprisingly noisy
(but wow those 5ths!). Another “aggressive” tuner might push the low bass down to
wide 12:6 octaves, whereas you like the more “relaxed” sound of pure 6:3 octaves. 

The point: Some tuners, pianos, rooms, and customers may prefer a tuning style
that differs from a “normal” tuning. As professionals, we should be ready, willing,
and able to create whatever tuning we think sounds best.

Using Chameleon 2 (Easy and Advanced)
Let’s say you’re sitting at a piano and want to tune it with RCT. 
Place the laptop on the piano where the screen can be easily seen. On a grand, it’s

on the plate struts; on a vertical with its lid open, the laptop is on top of the piano or
on the fallboard.

Start up the computer and, if necessary, open RCT. Chameleon 2 will be the active
module.

 Hint
To keep from scratching the piano and to help prevent the laptop from slipping
off the piano and denting the customer’s floor (or worse!), use rubber cement or
contact cement to attach two or three strips of “Rubbermaid Grip Liner” to the
computer’s underside (available in the shelf paper section of most grocery and
hardware stores).

 Hint
Many laptop computers have flip-down or pop-out feet. Use these feet to help
prevent it from sliding off the fallboard, music desk, top, etc.

 Hint
If there’s not much room on top of a vertical piano, open the laptop’s lid widely
and set it on its left side. For better balance, place a rubber wedge mute under the
computer’s lid. Be careful when using the trackpad or button, mouse button, and
keyboard.

 Hint
Some vertical pianos have very little room on top, such as the Kawai UST-7.
For these pianos, place the laptop on the floor, a music stand, modified camera
tripod, or nearby table. RCT works just fine even if the computer is as much as
20 feet away.
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Opening a Saved Tuning Record
To open a tuning file or record that’s already been saved onto your hard disk (such

as the Chameleon 2 Library if it was included with your purchase of RCT, or any
tuning record you’ve created and saved yourself), pull down the “File” menu and
select “Open”. Click a tuning file then click OK. The tuning file will open.

Then either:
1. Click on a record with the Magnifying Glass pointer. Its tuning chart will open.

Select CyberEar.
Or
2. Select a tuning record with the Tuning Hammer pointer, then select CyberEar.

There’s an easier way to select oft-used tuning files. Pull down the File menu and
highlight “Open Latest”. A sub-menu of the 8 most recent tuning files will appear.
Highlight the tuning file you want to open, then release the mouse.

Press Command + L (Mac) or Control + L (Win) to open the most recent tuning
file.

If you’re using RCT for the first time, “Open Latest” may be empty. 
RCT remembers the Open Latest... list even after you quit RCT or shut down your

computer.

Creating a New Tuning Record
 If a piano doesn’t already have a tuning record, you need to create one. You can

also create another tuning record for any piano if, for example, you want to use a
different OTS or tuning partial.

 Hint
Before creating a new tuning record, open the tuning file in which you want
the new record to be stored. This way, the new tuning record will
automatically be placed at the end of this tuning file when you click the Calculate
button.

To create a new tuning record, click the Record button, play the five (or six)
sample notes as indicated. If you’re in Advanced Mode select an OTS or tuning
partials. Click the Calculate button.

Here’s a more detailed description:

Record button
Click the Record button to start the sampling process.

To cancel the sampling process, click Stop.
To pause the sampling process, click Pause.
To continue, click Pause again.
To re-sample a note, click on its graphic keyboard note, tuning fork, or variance

box. To restart the sample process at any note, select that note using the 8va buttons.
To move to another note when sampling, press the computer’s arrow keys.

Ch2 will prompt you through the entire sampling process. You never have to
manually select a note, press any buttons, or manually measure a note’s pitch.

Recording samples usually takes less than two minutes.
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 Hint
Notes don’t have to be at correct pitch to be sampled. (Technical explanation: Ch2
records the partial ladders at their current pitch, sets the first partial to 440, and
equalizes the remaining partials in that ladder.) Ch2 takes good samples even if the
notes are 50¢ off pitch. However, the closer the piano is to proper pitch, the more
accurate the samples and resulting tuning record. For fine tuning, we recommend
the piano be within 10¢ of pitch when sampling.

After clicking the Record button, a finger will point to a note on Ch2’s graphic
keyboard (A4, then A3, A2, A1, A5, and, if needed, A6) and an ear will appear
over the note. This ear indicates Ch2 is ready to listen to that note. (This ear will
show up throughout RCT. It will always mean, “Hey you, I’m ready to listen. Play
this note now.”) Mute off all but one string. Play the note indicated. This will trigger
Ch2 to start recording. Flashing rings will appear around the ear to show that Ch2 is
in the act of recording. Sustain the note. After a few seconds, the ear will disappear,
meaning Ch2 has stopped listening. Let up on the key to stop the note from
sounding. A rotating tuning fork will appear, letting you know that Ch2 is
measuring and calculating the sample — chewing on its lunch of numbers.

For accuracy, Ch2 samples each note three times then averages the three samples.

Most technicians prefer to use the best string for all three samples, but it’s OK if
the samples are taken from different strings (of a bichord or trichord) even if the
strings are not in unison. This multi-string procedure will average out any
discrepancies between the strings and might result in better data under less-than-ideal
circumstances, such as mismatched windings, bad terminations, etc. 

 Hint
Sustain the note while the rings are flashing. When the rings stop flashing, let up
on the key immediately to stop the note from sounding. Otherwise it might
accidentally trigger Ch2 to listen for the next sample before you play the note
again.

 Hint
Ch2 prefers quiet when sampling, but is capable of taking highly accurate samples
even in a noisy room. When Ch2 takes samples, it uses very narrow filters when
listening for partial ladder information. If noise isn’t present at those narrow frequency
“windows,” Ch2 won’t even know it's there. If noise is interfering with sample
taking, variance numbers will be unusually high or the tuning fork will start to spin
before you play the note.

An example of Ch2’s ability to ignore noise:
To help our friend Doug Wood, RPT and an RCT user, prepare for a Sunday class

at the 1997 Pacific NorthWest Regional Conference, we sampled and tuned a piano
late Saturday night while loud boomy dance music played in the hotel’s nightclub
across the hall. (It sounded like King Kong had eaten beans for breakfast.) We were
able to take accurate samples and fine-tune the piano because the dance music had no
signal at the narrow high frequency “windows” at which RCT listened.
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Another war story:
Mitch tuned fifteen pianos with RCT at the 1998 NAMM show, a gigantic music

trade show in LA. Ch2 took low-variance samples (under 0.20¢) even though two
other piano tuners were simultaneously tuning pianos in the same room. Tuning the
pianos went just fine too; CE wasn’t bothered by the noise either unless another
tuner was tuning the same note or a note containing the same partial. (Mitch says,
“I’m not as tough as RCT—I wore musician’s earplugs, used my heavy brass key
pounder, and drank plenty of fluids.”)

 Hint
For the most accurate samples, play every note at the same mezzo-forte
(medium) volume. 

Ch2 remembers all sampled partial ladders until you re-click the “Record” button, even
if you quit RCT or select a Demo piano. This means additional tuning records can be
calculated without re-sampling if, for example, you want to create another tuning record
using a wider Octave Tuning Style or different Tuning Partials. To do so, choose new
settings in Ch2 then click the “Calculate” button.

To clear Demo piano samples from Ch2, click the Demo button and choose “Restore last
recorded piano” then click OK. The most recent samples recorded from a real piano will
be active and ready for recalculating.

If any sampled note’s sustain is too short, Ch2 will display a dialog box asking
you to play the note again. It might help to play the note repeatedly (especially A1,
A5, or A6) or more loudly (especially A5 and A6). Ch2 averages any cents deviation
between attack and sustain.

Accuracy can sometimes be increased (variance numbers decreased) for A5, A6,
and sometimes A1 by playing the note repeatedly while sampling. Try playing A5
twice and A6 three times for each sample.

If Chameleon 2 still has trouble recording a sample note, the mic might be in a
small interference zone. Try moving the laptop or mic a few inches.

If you still have problems, it’s probably excessive background noise or a weak
tone. If you can’t get better readings, click “Use Anyway” if Ch2 gives you that
choice.

For A1 and A5, it’s better to click Skip A1 or Skip A5 in the warning box. Ch2
will then interpolate the samples from the notes it’s already recorded. 

If you record samples at a pitch other than A440, please be cautious. Ch2’s
accuracy decreases, albeit very gradually, when the piano is more than 10¢ off pitch.
At 20¢ off pitch, the inaccuracy is normally less than 0.1¢. If you’re tuning the
piano to a non-440 pitch, then by all means sample it at that pitch. But if you’re
tuning it to A440, we recommend you do a pitch raise, then re-sample and re-
calculate a tuning record for Fine Tuning.

 Hint
If a note is more than about 50 cents flat or sharp, playing that note may not
trigger Ch2 to begin sampling. If so, tune the A notes to rough pitch or pitch
raise the entire piano using a saved or Demo tuning record. Alternately, you
could play A# instead of A for a piano which approaches 100 cents flat.

 Hint
In Ch2, the most recent samples (partial ladders) are saved and restored,
even if RCT has quit, or the computer has been shut down or crashed. This
means a tuning record can be created from the most recently sampled piano at
any time. Demo pianos are ignored and not saved. In other words, a Demo
piano will not displace the most recently saved real piano.
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A4 pitch in Ch2
 After sampling the first note A4, the pitch of A4 is displayed in hertz or as cents

from A440. Click on A4’s pitch reading to toggle between beats and cents.

This feature displays the actual  pitch of a piano when it was sampled. On the other
hand, whenever Ch2 calculates a tuning record (from samples at any pitch), the pitch
of that new tuning record will be A440.0 (as displayed in the pitch box of a tuning
chart). For further explanation, please see “How does RCT know the pitch of a
tuning?” in the chapter “Editing Files and Records.”

Because A4’s pitch is displayed at the start of the sampling process, you can save
time by aborting the sampling process if A4’s pitch is off more than, for example, 2
beats or 8 cents, and immediately do a pitch raise using a tuning record from a saved
or Demo piano of similar design. Then, with the piano at proper pitch, you can record
accurate sample, calculate a tuning record, and fine tune the piano.

If you prefer, you can finish sampling and calculate a tuning record for your pitch
raise. After the piano is at proper pitch, re-sample and create a more accurate tuning
record suitable for fine-tuning. 

Floating pitch
The procedures described above are all you need to know to do accurate pitch raises

and fine tuning with RCT. But remember, on an off-pitch and out of tune piano, the
pitch of A4 is not necessarily representative of the pitch of the entire piano. Different
sections drift at different rates; notes more than an octave from A4 are almost surely at
a different pitch (unless, of course, the piano was recently tuned to a non-A440
pitch). Typically, the tenor’s lowest half-octave drifts the most, the upper tenor less,
the upper bass less again (but sometimes more!), and the lowest and highest notes the
least. 

Some tuners prefer to leave the piano at its current average pitch, on the premise
that minimizing the change in the overall is less destabilizing. This is called “floating”
the pitch. To do so, you need to assess the piano’s overall pitch. Here are three
suggested procedures:

1. In Fine Tune mode, select and play A4. You’ll already know its beats or cents
deviation from Ch2, which you can verify with the gradients in the oval (10¢, 25¢,
50¢, etc.). Play some other notes (all A’s, maybe C’s too, etc.) and estimate the total
average deviation.

2. In Small Pitch Raise mode, play A0. After CE records that note, look at the
Original Pitch box to see how far off A0 is. Octave-up to A1, play it and let CE
measure it, then do the same with A2 and the other A notes. (C’s too?) Look at the
original pitch of each note (re-displayed if the note is re-selected) and estimate the
piano’s overall pitch. If you proceed with a pitch raise, be sure to click “Start New”
in the Pitch Raise dialog box so the measured notes will be re-recorded. (Thanks to
Kent Swafford for this clever tip.)

3. Strip mute the entire piano. Using the Offset Listener in Fine Tune mode (the
Offset Listener is not enabled in Pitch Raise mode), measure the pitch of A4 (or
another note you think may be more typical), then click the NoteSwitcher button to
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re-enable automatic note switching. Select and play A0, then rapidly play all notes
chromatically, looking at the Spinner to gauge which sections are sharper or flatter
than the measured offset. If a preponderance of notes are off pitch, manually adjust
the Offset box reading and re-check until the Offset box reading displays the average
overall pitch. 

Now back to our regular feature movie...

Variance indicates discrepancies between the 3 samples that are averaged together
for each sampled A note. Variance helps you judge the quality of a note’s three
samples.

After recording the three partial ladders, Ch2 mathematically sets the pitch of the
first partial of each sample to zero, re-calibrates the higher partials, then compares the
three ladders at each partial. The largest difference at any one partial is the note’s
variance. 

What variance should I get?
In Easy mode, variances will be shown as Good, Fair, or Poor. Good is great and

Fair is OK, but if you see Poor, which will appear in red, you should try to resample
that particular note (explained below) and try for Good or Fair variance.

In Advanced mode, variance is shown in cents. 

 

A variance under 0.25¢ is very good and is, in effect, almost the same as zero
variance. Most good pianos in a quiet room will result in variances below 0.25¢.
Variances between 0.25¢ and 0.50¢ are OK and acceptable. Variances over 0.50¢
indicate an atypical instability in the recorded partial ladders, and you should attempt
to obtain lower numbers (which, depending on the piano, may not be possible). Any
variance greater than 0.50¢ will appear in red. 

You’ll rarely see a variance of 0.00¢. This would mean all three samples for an A
note are exactly the same, a very improbable occurrence because pianos and piano
strings are made from inexact materials (wood, steel, felt) and are played by inexact
creatures (you and me, well OK maybe just me).
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Variance cents for Easy mode:
Good: 0.00¢ to 0.25¢
Fair: 0.26¢ to 0.50¢
Poor: 0.51¢ or greater

Possible reasons for high variance numbers:
1. Volume differential. In other words, the note was played soft then loud, or vice

versa. Solution: play all sampled notes consistently mezzo-forte (medium volume).
2. Anomalous tone. False beats can make the variance numbers high. Solution: use

another string or fix the false beat. 
3. Excessive noise during sampling. Solution: Close the door, ask the World’s

Loudest Rock Band to take a break, kill the television, etc.

Variance numbers are not error numbers. High variance numbers don't necessarily
mean the tuning will be poorly matched to the piano or sound bad. You should accept
high variances if samples were deliberately taken at different volumes to enable Ch2
to average any differences in the resultant partial series, if samples were taken on
three different strings to average out any string anomalies, or if repeated Redos prove
that high variance is the best the piano is capable of. 

Resampling
If a sample’s variance is Poor (Easy mode) or above .50¢ (Advanced mode), then you

should definitely resample that note. Variances of .25 or better are typical on most good
pianos, with .10 fairly common on high-end grands. Resampling a note is easy and fast,
so it’s OK to see “how low can you go.”

There are several ways to resample an individual note. The easiest method is to click on
the note’s tuning fork, variance box, or its key on the graphic keyboard. The ear will
reappear for that note; play the note again as indicated. You’ll be asked to play it three
times. After resampling is completed for that note, the sampling process ends.

You can restart the sample process at any note by clicking on an 8va button, located at
the top of the Ch2 window. If you click the 8va down button, the highest A note will be
selected. Click 8va down repeatedly to select lower notes. Click the 8va up button to select
the lowest A and re-click to select higher A notes. After sampling a note, the sample
process continues through the rest of the A notes in the order as if you’d clicked the
Record button.

It’s OK to select a note “in passing” even if you don’t want to resample it. Samples for
any A note won’t be erased until and unless you play the note and resample it three times.
In other words, the resample process is “non-destructive” of any note’s recorded samples
until the resample is fully completed.

If re-sampling results in a higher (worse) variance than the original sampling, a dialog
box will appear asking what to do: use the higher variance sample (probably not!), revert
to the previous sample, retry and sample again, or cancel. There’s also a checkbox if you
want to let RCT always choose the better sample without displaying this dialog box (in
other words, auto-reject any new sample with a higher variance). If you check this box, a
beep will let you know when this auto-reject occurs. This box will stay checked for this
session only, and will uncheck itself when RCT quits. 

If you’ve used the 8va buttons to select a note for resampling, the next A note will
automatically be selected for resampling. If you want to resample that note, play it as per
normal. If you don’t, simply reclick an 8va button or re-press the computer’s arrow keys
repeatedly until no more A notes are selected. If you want to resample a note before a
note’s three samples are completed, use the 8va buttons or arrow keys to select an adjacent
note then reselect that A note. To stop a resample in process and restore that note’s
previous samples, click the Stop button. 

Occasionally, a sampled string is wild (beats against itself) which can result in high
variance numbers. To obtain lower variances, choose another string from that unison that
is less wild (or fix the cause of the string’s wildness). Also, try sampling using two well-
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tuned strings of a unison (or even three strings at A5 or A6); the coupling effect can
sometimes smooth out one string’s wildness

Tips for Ch2 recording:
1. Put the laptop (or mic) as close to the piano string as possible.
2. Move or rotate the computer (or mic) if playing the note doesn’t trigger Ch2 to

start listening.
3. On some low notes, it may be helpful to pluck the string (especially A1).
4. Ch2 will successfully ignore most typical household noises, but you may get

better samples if it’s quiet.
5. Play each sample mezzo-forte (medium loud).
6. Use the Redo button if a variance number is Poor or above .50. Actually, on

most pianos you should expect Good or variances below .25¢. But don't  fret if
variance numbers stay high. It may be the best the piano is capable of.

Demo button 
Ch2’s Demo button holds permanently-saved partial ladders from 5 pre-sampled

pianos. The Demo pianos are real pianos that Dean sampled and loaded into Ch2’s
programming. (The Yamaha C3E grand is in his living room.) When you select a
Demo piano, a complete set of samples is loaded into Ch2, exactly as if you’d
sampled a real piano. 

After selecting a Demo piano, click OK to close the Demo dialog box. If you’re in
Advanced Mode, you can select an OTS and tuning partials.

Ch2’s five Demo pianos are:
1. Kimball spinet 
2. Everett console 
3. Kawai UST7 studio upright 
4. Yamaha C3E 6’ grand 
5. Steinway D 9’ grand 

In Advanced mode, the variance numbers will be 0.00. (Dean loaded one sample
three times.) In Easy mode, variance will be listed as “Demo.” The Demo piano’s
name is automatically entered into its Tuning Chart’s header box. 

After selecting a Demo piano, to reload the samples (and variances) of the piano
most recently recorded back into Ch2, click the Demo button and select “Restore last
recorded piano.”

Demo tunings should be used only for pitch raising and experimentation, and not
for fine tuning. 

Easy Mode Users
If you’re using Easy mode, your next step is to click the Calculate button. 

Easy mode users don’t need to read the following lengthy
descriptions of Advanced mode features, and can skip ahead to the
description of the Calculate button.

Advanced Mode Users
If you want to learn more about Ch2’s Advanced mode, put your feet up and your

thinking cap on. It would help if your computer and a piano were nearby.
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To start off, let’s remind ourselves that piano tuning is an art of compromises.
Every aural tuner knows this is true, and so does RCT. Before calculating a tuning
record, Ch2 examines the samples and your tuning choices very carefully, then
makes some carefully controlled compromises “behind the curtain.” Using a
customized curve-fitting equation, Ch2 creates smooth transitions between the
various partial ladders, tuning partials, beat rates, etc. This means the settings you
choose in Ch2 should be regarded as strong tendencies, not absolutes.

Octave Tuning Styles 

Octave Tuning Styles (OTS) let you choose an amount of overall stretch. There are
10 Octave Tuning Styles, ranging from OTS 1, which is almost pure, to OTS 9,
which is very wide. Another OTS is RPT Exam, which approximates a typical PTG
RPT Exam master tuning. 

An Octave Tuning Style may be selected before, during, or after sampling. 

The amount of overall stretch in each OTS is controlled by five parameters:
• beat speed for a 6:3 octave at A2-A3, called B
• beat speed for a 4:2 octave at A3-A4, called T
• Double Octave Maximum beat speed for A2-A4 4:1 double octave, called DMax
• Single Octave Minimum beat speed for T and B, called SOM
• A7 octave type, ranging from single to triple octave

Octave Tuning Style specifications
B = Bass control octave — A2 to A3 6:3 octave
T = Treble control octave — A3 to A4 4:2 octave
Dmax = Double Octave Maximum — A2 to A4 4:1 double octave maximum
SOM = Single Octave Minimum — minimum width for B or T (overrides DMax)
A7 = which octave type is used when tuning A7

Single octave = 1.00
Double octave = 2.00
Triple octave = 3.00

OTS 1 2 3 4 5 6 7 8 9 RPT

 B -0.08 0.06 0.16 0.24 0.30 0.36 0.42 0.54 0.72 0.24

 T 0.00 0.14 0.24 0.32 0.38 0.44 0.50 0.62 0.80 0.32

DMax 0.60 0.76 0.89 1.00 1.06 1.14 1.25 1.42 1.64 0.75

SOM B -0.82 -0.48 -0.38 -0.30 -0.26 -0.20 -0.14 -0.08 -0.03 -0.30

SOM T -0.52 -0.18 -0.08 0.00 0.04 0.10 0.16 0.22 0.27 -0.10

 A7 1.50 1.67 1.83 2.00 2.16 2.33 2.52 2.75 3.00 1.60

beats per second
Chart 1

Octave Tuning Style specifications
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More about OTSes
OTS specs progress smoothly from pure (Style 1) to very wide (Style 9). Styles 3,

4, and 5 are typical of most aural tunings for home pianos.
The Double Octave Maximum (DMax) specifies the maximum beat speed of a 4:1

double octave at A2-A4. In effect, DMax is a ceiling or outer boundary. Most well-
scaled pianos don’t need DMax. Usually, DMax is invoked only if a piano’s scaling
is unusual (e.g., spinet) and/or the settings for B or T are relatively wide. If the
double octave beat speed “wants” to be greater than its DMax setting, Ch2 will
“shrink to fit” A2-A3 (B) and A3-A4 (T) as needed until the double octave beat
speed (D) no longer exceeds the double octave maximum (DMax). In other words,
the beat speed of the actual A2-A4 double octave may be less than its DMax setting
but will never be greater — except if SOM is invoked.

SOM, or Single Octave Minimum, is another layer of built-in safety features that
prevents DMax from narrowing B and T too much. On extremely poorly scaled
pianos, DMax may try to shrink B and T till they’re actually narrow! If Dmax
shrinks T or B to less than their SOM setting, SOM kicks in. D is allowed to expand
beyond DMax until T and B equal SOM. (A more complete explanation of DMax
and SOM appears later in this chapter.)

If all this seems confusing, don’t worry. All you need to remember is Ch2 is very
smart and will automatically create a great-sounding tuning even on weird spinets or
bizarre short grands. 

Some interesting terminology
Some people use the term “artificial stretch” for what RCT does when creating an

Octave Tuning Style wider than OTS 1. Artificial stretch is defined as the amount of
additional sharpness or flatness beyond what’s required for octaves to be beatless.

“Natural stretch” is a less common term, leftover from the old days before
inharmonicity was widely understood. Natural stretch means that, due to
inharmonicity, specific octave partials must be tuned wider than a whole-number
multiple in order to be beatless (or, for tempered intervals, to have a specific beat.)

Inharmonicity is a characteristic of piano wire whereby the frequencies of a note’s
partials get proportionately sharper the higher the partial number. Inharmonicity is a
fundamental concept in piano tuning. If you want to learn more, some excellent texts
available from PTG are On Pitch by Rick Baldassin, The Calculating Technician by
David Roberts (you’ll need advanced math skills for this one), The Tuning Exam
Source Book, and anything written by Dan Levitan in the Piano Technicians
Journal. Dan teaches must-see classes on inharmonicity at PTG conventions.

Selecting an OTS
To select an OTS, click on its radio button. There are three buttons under three

piano keyboards for a total of nine standard OTSes. OTS 1 is the left button in the
Clean grouping; OTS 9 is on the right of the Stretched group.

The numbers for the nine OTSes are visible momentarily under a group of three
radio buttons if you hold down the mouse on any radio button of that group.

In the above example, OTS 4 is selected. OTS 4 is a typical and common choice,
and sounds good on almost all pianos. That’s why OTS 4 is used for Easy Mode.
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 Q&A
Question
How do I know which OTS to choose? Does wide stretching work well on all

pianos? What OTS should I use for spinets? 
Answer
OTS 4 approximates a typical tuning style for most professional piano tuners on

most home pianos. If you want to use only one OTS, use OTS 4; if so, you might
prefer to leave Ch2 in Easy Mode, which uses OTS 4 exclusively (and uses the most
common partial choices too). 

Other OTSes that are typical are OTS 3 (a little less stretched) and OTS 5 (a little
more). 

OTSes 1 and 2 are used less often, usually only on Asian pianos with low
inharmonicity which you want to tune with very quiet octaves.

Wider OTSes, such as OTS 6, 7, 8, and 9 are used most often on large grands.
These wide tunings are preferred by concert tuners willing to accept beating double
octaves and buzzy 17ths in order to get more “sparkle” and “lift” in their tunings. 

A word of warning: pushing the stretch past OTS 6 is neither for the faint of heart
nor the inexperienced. Some pianos sound good with extra-wide stretch and some
don’t; if you don’t have enough experience to tell the difference, stick with a more
typical OTS such as 4. Furthermore, if a room’s humidity increases, a super-
stretched tuning could be pushed “over the cliff.” Generally, we recommend that
wide OTSes such as 6, 7, or 8 be used only on long well-scaled large grand pianos
that see frequent service.

Spinets don’t sound good with wide stretch in the tenor single octaves because the
resulting double octaves beat too much. Fortunately, Ch2 has built-in safeguards to
take care of this. The Double Octave Maximum and the Single Octave Minimums
automatically create good sounding tunings on spinets and short grands. We
recommend sticking with OTS 4 for these pianos. 

General guidelines: 
• The longer the piano, the more stretch it can tolerate. 
• Asian pianos tend to have relatively low overall inharmonicity and therefore

sound best with moderate OTSes such as 3 or 4 (or less). 
• Steinways seem to like wide OTSes more than other brands. Many experienced

RCT users think the Steinway model D sounds great in a big concert hall with OTS
7 or 8 and low bass partial 12. For the Steinway B, they may use OTS 6 or 7 and
low bass partial 10.

 • Look at the predicted beat rates in the tuning chart’s header to “pre-listen” to the
sound of the tuning before you actually tune any notes. Remember that all OTSes
have built-in Limits that will keep the A2-A4 double octave from getting too wide
and the A2-A3 and A3-A4 single octaves from getting too narrow.

RPT Exam style
The RPT Exam Octave Tuning Style approximates a typical aural master tuning for

the RPT Tuning Exam. It uses the same stretch as Style 4 except for slightly smaller
setting for A7 and the A2-A4 double octave maximum (see chart 1).

Please read this
The “RPT Exam” style is based on Dean’s experience creating master tunings with

many Certified Tuning Examiners (CTE) on a large number of pianos. This style is
not  a sanctioned PTG universal master tuning — there is no such thing — nor will
using it necessarily guarantee you a perfect score on PTG’s RPT tuning exam. The
best way to achieve a high score is to work hard and become an excellent aural
tuner, a skill we strongly suggest you acquire. If RCT helps more people become
great aural tuners, we’d be happy as slugs in spring.
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To learn more about aural tuning, the RPT exam, or PTG, call a Registered Piano
Technician. For help in finding an RPT or CTE, contact the Piano Technicians
Guild.

Custom Equalizer
Custom Equalizer (CEQ) is an advanced feature that lets experienced tuners micro-

adjust the stretch of any octave of any OTS, offering unparalleled freedom in
creating your own personalized Octave Tuning Style. To open CEQ, click on its
icon. To use the current CEQ settings for a new tuning record (and not open CEQ),
click on the CEQ radio button then click Calculate. 

CEQ is explained in greater detail later in this chapter.

A6 sampling 
A6 is sampled only when needed, which is only for OTS 1, 2, and 3 and RPT

Exam. A6 is not needed, and therefore not sampled, for OTS 4 through 9. Ch2
needs to know A6’s partial ladder only when A7 is to be tuned to a narrow double
octave. For OTSes 4 and wider, A7 is calculated from samples taken at A5, not A6.

In other words, if A7 is to be tuned flatter than a double octave (A7 < 2.0), its
pitch will be calculated based on the fourth partial of A5 and the second partial of
A6. If A7 is to be tuned to a double octave or wider (A7 ≥ 2.0), its pitch will be
calculated based on the fourth partial of A5 and the eighth partial of A4.

 Hint
If you take samples with an OTS that doesn't need A6 (OTS 4 and higher) then
change your mind and wish to select an OTS which uses A6), Ch2 will
interpolate the A6-A7 octave and create a tuning that’s as accurate as if it had
sampled the A6 partial ladder.
Alternately, if you want Ch2 to actually take samples at A6, select the lower OTS
then click the A6 tuning fork over the graphic keyboard. The ear will appear over
A6, indicating you should play A6 so that its samples can be taken.

 Hint
When sampling A6, play it forte repeatedly 2 or 3 times a second to get a lower
variance number and a better Ch2 tuning. Sampling two strings tuned in unison
may also help if the sustain is short.

Ch2 handles A6 differently than other sampled notes. If Ch2 sees variance
numbers higher than 2.00¢ on A6, it will ignore the A6 partial altogether and
interpolate it. If the variance is between 1.00¢ and 2.00¢, it will weight the
consideration of the A6 partial ladder. If A6’s variance is below 1.00¢, Ch2 uses the
A6 partial ladder unaltered. 

Tuning Partials
In Advanced mode, you can choose Tuning Partials for the low bass (A0-G#1),

bass (A1-G#2), tenor (A2-G#4), and treble (A4 to G#5).

Click on a popup menu and drag to highlight the desired partial, then release the
mouse. When you click on a popup menu, the affected notes are darkened on Ch2’s
graphic keyboard. You can choose tuning partials before, during, or after sampling.

Partials 12, 10, 8, 7, or 6 can be chosen for low bass notes A0 to G#1. (In RCT
3.5, partial 16 can be used for the low bass but must be entered manually in the a
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tuning chart.) Partials 6, 5, or 4 can be chosen for bass notes A1 to G#2. Partials 4
or 3 can be chosen for tenor notes A2 to G#4. Partials 2 or 1 can be chosen for A4
to G#5. (For A5 and above, only partial 1 is available.) RCT will remember the
current settings and re-use them on subsequent tuning records, even if you quit
RCT.

RCT’s default settings are low bass partial 6, bass partial 6, tenor partial 3, treble
partial 2, and high treble partial 1. These choices work great for almost all pianos. In
fact, these are the Easy mode settings. 

The low bass Tuning Partial is the only choice that materially affects the amount of
stretch. Depending on the piano’s scale, a different bass partial (5 or 6) and the tenor
partial (3 or 4) might affect the smoothness of the beat rates between the A's, but the
overall stretch is (or should be) the same.

Most RCT users change the low bass partial only.

 Hint 
Generally, notes should be tuned using their loudest partial. On short scale
pianos, also try to tune to the partial that allows a maximum of other partials to
be in tune too, which is usually low bass partial 6; if you’re lucky, it’s also the
loudest partial. For a more complete explanation of this seminal principle, read
Rick Baldassin’s classic book “On Pitch.” 

Low bass (A0-G#1) Tuning Partials
12th partial: Ch2 gradually expands the octaves as it tunes down the piano until the

last octave A0-A1 is a perfect 12:6 octave. The 12:3 double octave pointer is shown
in CEQ but not considered.

10th partial: Same as above, but A0-A1 will be a perfect 10:5 octave.

8th partial: Ch2 gradually expands the octaves as it tunes down from  A1, reaching
a slightly expanded 8:4 octave at A0-A1. Ch2 and CEQ consider both the 8:4 single
octave and the 8:2 double octave. The 8:4 single is given twice the weight of the 8:2
double octave, each of which try to be expanded about the same as the octave and
double octave above them.

7th partial: Ch2 gradually expands the octaves until A0-A1 is a slightly expanded
7:3.5 octave. Even though there's no real 3.5 partial at A1, Ch2 interpolates it from
the 3rd and 4th partials of A1. This produces a stretch halfway between the 8th and
the 6th partials.

The 7th partial is very loud in the low bass on most pianos and therefore works
very well. This is a very popular setting, second only to partial 6.

6th partial. Ch2 gradually expands octaves down the piano until A0-A1 is a
slightly expanded 6:3 octave, matching the expansion of the A1-A2 6:3 if possible.

The 16th partial is available for tuning but must be manually entered in a tuning
chart.

 Hint 
Low bass partials 12 and 10 usually work best for long-scale pianos such as 7’-
9’ grands.

Bass Tuning Partials
The 6th partial works best in the bass (A1-G#2) in most cases. If you find that the

Spinner is hard to read in this area or if the tuning sounds too flat, try partial 5. For
spinets or very small grands, try using partial 4.

36

tuning chart.) Partials 6, 5, or 4 can be chosen for bass notes A1 to G#2. Partials 4
or 3 can be chosen for tenor notes A2 to G#4. Partials 2 or 1 can be chosen for A4
to G#5. (For A5 and above, only partial 1 is available.) RCT will remember the
current settings and re-use them on subsequent tuning records, even if you quit
RCT.

RCT’s default settings are low bass partial 6, bass partial 6, tenor partial 3, treble
partial 2, and high treble partial 1. These choices work great for almost all pianos. In
fact, these are the Easy mode settings. 

The low bass Tuning Partial is the only choice that materially affects the amount of
stretch. Depending on the piano’s scale, a different bass partial (5 or 6) and the tenor
partial (3 or 4) might affect the smoothness of the beat rates between the A's, but the
overall stretch is (or should be) the same.

Most RCT users change the low bass partial only.

 Hint 
Generally, notes should be tuned using their loudest partial. On short scale
pianos, also try to tune to the partial that allows a maximum of other partials to
be in tune too, which is usually low bass partial 6; if you’re lucky, it’s also the
loudest partial. For a more complete explanation of this seminal principle, read
Rick Baldassin’s classic book “On Pitch.” 

Low bass (A0-G#1) Tuning Partials
12th partial: Ch2 gradually expands the octaves as it tunes down the piano until the

last octave A0-A1 is a perfect 12:6 octave. The 12:3 double octave pointer is shown
in CEQ but not considered.

10th partial: Same as above, but A0-A1 will be a perfect 10:5 octave.

8th partial: Ch2 gradually expands the octaves as it tunes down from  A1, reaching
a slightly expanded 8:4 octave at A0-A1. Ch2 and CEQ consider both the 8:4 single
octave and the 8:2 double octave. The 8:4 single is given twice the weight of the 8:2
double octave, each of which try to be expanded about the same as the octave and
double octave above them.

7th partial: Ch2 gradually expands the octaves until A0-A1 is a slightly expanded
7:3.5 octave. Even though there's no real 3.5 partial at A1, Ch2 interpolates it from
the 3rd and 4th partials of A1. This produces a stretch halfway between the 8th and
the 6th partials.

The 7th partial is very loud in the low bass on most pianos and therefore works
very well. This is a very popular setting, second only to partial 6.

6th partial. Ch2 gradually expands octaves down the piano until A0-A1 is a
slightly expanded 6:3 octave, matching the expansion of the A1-A2 6:3 if possible.

The 16th partial is available for tuning but must be manually entered in a tuning
chart.

 Hint 
Low bass partials 12 and 10 usually work best for long-scale pianos such as 7’-
9’ grands.

Bass Tuning Partials
The 6th partial works best in the bass (A1-G#2) in most cases. If you find that the

Spinner is hard to read in this area or if the tuning sounds too flat, try partial 5. For
spinets or very small grands, try using partial 4.



37

Tenor Tuning Partials
Choosing tenor partial 3 causes notes A2 to G#4 to be tuned primarily as intervals

that include partial 3, such as 3:2 5ths, 4:3 4ths, and 6:3 octaves. 
Choosing tenor partial 4 causes notes A2 to G#4 to be tuned primarily as intervals

which coincide at the 4th partial, such as 5:4 major 3rds, 4:3 4ths, and 4:2 octaves. 

Treble Tuning Partials
Treble partial 2 works best on most pianos. If the Spinner is weak in the area,

recalculate a tuning using partial 1. 

 Hint
Tenor partial 3 is an especially good choice when tuning pianos with short scales
or uneven inharmonicity at the bass-treble break. For a more complete
explanation, please read Kent Swafford’s article in Appendix A, excerpted from
his review of RCT in the January 1997 issue of the Piano Technicians Journal.

 Hint
Tenor partial 3 is a good choice for all pianos because it works perfectly for
tuning 5ths (3:2 coincidences), producing smooth parallel 5ths in the tenor while
making only minor (no pun intended) sacrifices in parallel 3rds and 10ths.
Between F4 and B4, the CE display is stronger when using the 3rd partial
because on most pianos it’s louder than the 4th.

 Hint
If CE has trouble hearing a note (weak Spinner display) try calculating another
record using a different partial.

 Hint 
If the Spinner is set to Hertz (beats) instead of Cents, it will rotate more slowly
for an equal cents deviation when a lower partial is chosen (such as 3 instead of
4). If so, be sure to stop the Spinner more carefully or get a fuller Target blush.
When the Spinner is set to Cents, it’s immune to such sensitivity changes.
That’s one reason why Cents is highly recommended and RCT’s default.

Limits — DMax and SOM

Ch2 has a feature called Limits which helps insure that poorly scaled pianos will
be optimally tuned. There are two components to Limits —  Double Octave
Maximum and Single Octave Minimum. They work together to help create tuning
records with the best possible compromises on pianos with less-than-perfect scaling.

Double Octave Maximum
Double Octave Maximum (DMax) prevents A2-A4 from being too wide. It does so

by shrinking B (A2-A3) and T (A3-A4).

Single Octave Minimum
Single Octave Minimum (SOM) prevents DMax from making A2-A3 (B) and A3-

A4 (T) too narrow. SOM uses separate settings for T and B. 

In Ch2, SOM and DMax are invoked automatically as necessary in Easy and
Advanced mode.

In Custom EQ, you can use the standard DMax and SOM settings or you can
create your own customized settings. (For further details, please see “Custom
Equalizer” later in this chapter.)
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DMax and SOM overview
With imperfectly scaled pianos, inharmonicity tends to be excessive and/or

inconsistent in the lower tenor (e.g., at the lowest plain wire note, the bass-treble
break, or where the strings change from wound to plain wire). This creates
problems with beat rate consistency and progression.

On such problem pianos, normal-width single octaves A2-A3 (B) and A3-A4 (T)
may not fit within a normal-width double octave A2-A4 (D). To make our problem
piano sound as good as possible, compromises are necessary. Either the single
octaves or double octave can be tuned to sound good, but not both. RCT chooses
which interval to prioritize depending on two factors: the degree of the “problem”
and the settings for SOM and DMax.

How DMax and SOM work together
When you take samples of a piano’s A notes and choose an OTS and Tuning

Partials, you’re giving Ch2 a complex set of data for creating a tuning record. Even
though a tuning chart appears very soon after you click the Calculate button, it’s not
instantaneous. Before Ch2 calculates the pitch settings for all 88 notes in the Tuning
Chart, it first goes through a complex series of cross checks and “pre-calculating.”

First, A2-A3 (B) and A3-A4 (T) are set to the beat rates specified for the OTS
you’ve selected. Then Ch2 uses the sampled partial ladders to calculate the beat rate
for the A2-A4 4:1 double octave (D). If D exceeds the OTS’s specification for the
Double Octave Maximum (DMax), the DMax safety feature will shrink the beat rates
of B and T until D no longer exceeds DMax. At this point (and only if SOM is not
invoked — more on SOM in a minute) the tuning record is calculated. You’ll know
when Dmax was invoked because the tuning chart’s header will display predicted
beat rates for B and T smaller than their OTS spec, and D will be equal to the OTS’s
DMax spec. The resulting tuning will have tenor single octaves that will be a little
narrower than expected.

Double Octave Maximum (DMax) specifications
DMax beat settings increase gradually from OTS 1 to 9. RPT Exam is deliberately

set to a tighter tolerance than any OTS.

OTS 1 2 3 4 5 6 7 8 9 E

DMax 0.60 0.76 0.89 1.00 1.06 1.14 1.25 1.42 1.64 0.75

beats per second

Why SOM is needed
On very poorly scaled pianos (such as spinets with extremely fore-shortened tenor

sections or poorly designed wire-type changes) there’s much more discrepancy
between the single and double octaves. As in the previous example, DMax wants to
shrink the single octaves so they’ll fit into a “normal” double octave. However, on
some pianos the scaling is so bad that DMax, in its attempt to keep the double octave
from being too wide, tries to shrink the single octaves til they’re narrow from pure.
That’s too much and DMax needs to be told to stop shrinking the single octaves.
That’s why we need the additional safety feature Single Octave Minimum, or SOM. 

Tenor single octaves that are substantially narrow tend to sound pretty awful and
are almost always avoided by aural tuners. (If a 4:2 A3-A4 octave was tuned
narrow, the F3-A3 3rd would beat faster than the F3-A4 10th.) Rather than let the
A2-A3 and A3-A4 single octaves become narrow, it’d be better to allow the A2-A4
double octave to expand past “normal.”

That’s what SOM does. SOM makes sure B and T are never less than their SOM
setting, which is usually close to zero, or pure.
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Essentially, SOM keeps its eye on DMax, and whenever DMax tries to narrow T
and B too much, SOM grabs control and overrides DMax. SOM expands the A2-A4
double octave past its DMax setting until it’s wide enough to contain the SOM-sized
A2-A3 and A3-A4 single octaves.

To restate it succinctly, DMax overrides B and T, but SOM overrides DMax.

In earlier versions of RCT (1.x), you had to do manually what SOM now does
automatically. For example, when tuning a piano you suspected of poor scaling,
after calculated a tuning you looked carefully at the predicted beat rates. If you saw
negative predicted beat rates for A2-A3 and A3-A4, you selected a wider OTS or
opened the old Custom window and typed in new setting for DMax, then calculated
another tuning. You’d repeat this procedure until T and B were acceptable (typically,
near 0.00).

With SOM, you don’t have to worry about this anymore. SOM automatically
keeps its eye on Dmax for you and, with its big brother Dmax, automatically creates
the best possible tunings on all pianos, no matter how “inharmonically challenged”
they may be. (Without Dmax and SOM, Easy mode wouldn’t be possible.)

Single Octave Minimum (SOM) specifications
SOM settings increase gradually from OTS 1 to 9. RPT Exam matches OTS 4.
The following settings are listed as beats per second.

OTS 1 2 3 4 5 6 7 8 9 Ex

SOM T -0.52 -0.18 -0.08 0.00 0.04 0.10 0.16 0.22 0.27 0.00

SOM B -0.82 -0.48 -0.38 -0.30 -0.26 -0.20 -0.14 -0.08 -0.03 -0.30

beats per second

SOM B is always 0.30 bps less than SOM T.
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Custom Equalizer 

Custom Equalizer (CEQ) lets you micro-adjust the stretch of any octave of any Octave
Tuning Style (OTS) and shows you graphs to let you “pre-listen” to your tunings.

CEQ is a very exciting and wonderful innovation. It’s hard to imagine a better tool for
advancing the current movement to create a “hybrid” tuning method that combines the
best of visual and aural techniques.

But first, a word of caution:
CEQ is designed for experienced tuners and advanced RCT users. To use CEQ

properly, you should have “big ears” and some understanding of inharmonicity,
stretch, interval widths, and coincident partials. 

When you use CEQ, you’re taking over from Ch2’s extensive system of internal
safeguards and cross-checks. It’s possible to create bad-sounding tunings with CEQ,
so please use CEQ only if you’re ready, willing, and able to assume responsibility for
the results. 

Let’s begin with a quick overview of CEQ.

To open CEQ, go to Ch2 and click on the Custom EQ icon.

If you click on the CEQ radio button instead of the CEQ icon, the CEQ window
won’t open. Instead, CEQ will be the selected Tuning Style, and the current CEQ
settings will be used when you click Ch2’s Calculate button. 

The CEQ radio button is auto-selected whenever you quit CEQ.

40

Custom Equalizer 

Custom Equalizer (CEQ) lets you micro-adjust the stretch of any octave of any Octave
Tuning Style (OTS) and shows you graphs to let you “pre-listen” to your tunings.

CEQ is a very exciting and wonderful innovation. It’s hard to imagine a better tool for
advancing the current movement to create a “hybrid” tuning method that combines the
best of visual and aural techniques.

But first, a word of caution:
CEQ is designed for experienced tuners and advanced RCT users. To use CEQ

properly, you should have “big ears” and some understanding of inharmonicity,
stretch, interval widths, and coincident partials. 

When you use CEQ, you’re taking over from Ch2’s extensive system of internal
safeguards and cross-checks. It’s possible to create bad-sounding tunings with CEQ,
so please use CEQ only if you’re ready, willing, and able to assume responsibility for
the results. 

Let’s begin with a quick overview of CEQ.

To open CEQ, go to Ch2 and click on the Custom EQ icon.

If you click on the CEQ radio button instead of the CEQ icon, the CEQ window
won’t open. Instead, CEQ will be the selected Tuning Style, and the current CEQ
settings will be used when you click Ch2’s Calculate button. 

The CEQ radio button is auto-selected whenever you quit CEQ.



41

Intro to CEQ
CEQ’s interface looks like a graphic equalizer for a high-end audio system. An audio

graphic equalizer lets you adjust the relative volume of a limited frequency range, but
CEQ lets you adjust stretch — in effect, the pitch — of a limited range of notes.

The first thing you’ll notice are CEQ’s seven sliders, each of which is located over an
A note called the slider’s control note. Each slider helps you set the stretch for its
control note and surrounding notes. For example, the slider located over A5 controls
the stretch of A5 and a half-octave on either side for a total of a one octave range. As is
the case with most of Ch2, CEQ’s sliders are not “walled off” from each other; an
adjustment in one area is automatically smoothly blended into adjacent areas.

The numbers alongside each slider are beats per second. On each slider is a triangle-
shaped pointer that shows the setting for that slider. This pointer is what you click-and-
drag to change a slider’s setting. An indicator box under each slider shows the exact
setting of its pointer. 

To increase the stretch of an octave, click and drag its slider upwards; to decrease
stretch, click and drag it down.

Go ahead and try this. The number in the indicator boxes change in real time as you
move a pointer. When you release the mouse, a new tuning is calculated using your
new settings and a CEQ mini-graph is created.

CEQ graphs
There are two graphs in CEQ — OTS Difference and Aural Intervals.
OTS Difference shows the difference between an OTS’s standard settings and the

“tweaks” you made when you moved the sliders. If this sound familiar, it’s because
Ch2 already offers this capability as the Difference tool (under the Tools—>Math
menu).
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The other graph is called Aural Intervals because it shows the width of octaves,
double octaves, fifths, twelfths, etc. The Aural Intervals graph displays interval widths
whether or not you’ve moved any sliders.

You can toggle between the two graphs — OTS Difference and Aural Intervals — by
clicking on the labeled button located at the bottom left of the graph.

Both graphs can be toggled between cents and beats by clicking on the Beats/Cents
button located at the right of the graph. 

If beats are selected in the OTS Difference graph, each partial has a separate
graphline, labeled at its right terminus.

In CEQ, beats and cents are calculated at the relevant partials, which may or may not
the same partial at which the graphline is drawn. 

When switching between beats and cents, remember that the proportion of beats to
cents increases as notes ascend from bass to treble.

The horizontal scale of the graphs is the notes of the piano, marked with a vertical line
at each A control note. The vertical scale is ± 5 cents or beats.

CEQ: Dynamic and Self-Adjusting
Before we go any further, there’s a basic principle about CEQ you need to

understand.
CEQ is dynamic. When you adjust a slider, CEQ automatically adjusts the pitches of

outlying notes the same amount in order to retain beat rate relationships. For example,
to increase the stretch of A4-A5, you might move the A5 slider up 0.5 beats, but you
wouldn’t want that to also decrease A5-A6 by 0.5 beats. That’s why if you move A5
up 0.5 beats CEQ automatically raises A6 0.5 beats too. (In this example, A7 would be
raised too.)
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You can watch CEQ do this “self-adjusting.” After raising A5’s pointer, A5’s beat
rate increases but A6 and A7 beat rates stay the same. When we talk about CEQ’s
graphs, you see an even clearer example of CEQ’s dynamic  self-adjusting. 

By the way, there’s no slider over A4 because A4 is the pitch of the entire tuning,
which is better adjusted other places, like CE’s pitch popup menu. It might help to
think of A4 as the centerpoint for all the sliders. 

Learning how CEQ works
For the following example, instead of sampling a real piano, we’ll use one of Ch2’s

stored Demo pianos, the Yamaha C3 Demo piano. Select it by going to Ch2, holding
down the command key, and clicking on the Demo button. If you’re asked to overwrite
an existing tuning or another Demo piano, click OK. Select the Yamaha C3 demo piano
and click OK. This loads pre-sampled partial ladders from a Yamaha C3E into Ch2.
(Using Demo pianos is as great way to learn about CEQ.)

Open CEQ by clicking on the Custom EQ icon (not the radio button). The CEQ
header should say “Yamaha C3E 6’ grand (Demo)”. If this is the first time you’re
opening CEQ, the OTS Difference graph will be selected and cents will be the display
mode. If you’ve already changed it to another setting, change it back.

In the center of the CEQ window are nine OTS radio buttons. Except for being
vertical, these are the same OTS buttons as you see in Ch2. If this is the first time
you’ve opened CEQ, OTS 4 will be selected. (CEQ’s current settings are saved when
CEQ is closed and restored the next time CEQ opens.)

Go ahead and click on a few OTS buttons. When you change to another OTS, the
pointers and beat rates change. Why? Higher numbered OTSes have more stretch and
faster beat rates.

Drag some sliders around. After you move a slider, the graph shows the effect of
these “tweaks.” It’s called the OTS Difference graph because it shows the difference
between the standard OTS you selected and whatever changes you made when you
moved a slider.

Click on the Cents button to toggle the graph to beats. Toggle around for a while. 
When you’re done messing around, make sure you’ve selected the OTS Difference

graph set to cents.
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Click on OTS 4. All sliders will return to their standard settings for OTS 4. The A2
slider will be set to 0.28 bps and the A3 slider will be 0.32 beats, their normal beat rate
for OTS 4 (see Chart 1 in the Ch2 chapter). In CEQ’s header box located below the
graphic keyboard, these appear again as the T and B predicted beat rates.

Alongside each slider are various ratios, such as 4:1, 2:1, 4:2, etc. These are the
intervals used by RCT to calculate the pitch of each slider’s control note. 

(Exception: if the 12th Tuning Partial is chosen in the low bass in CEQ, the 12:3
double octave ratio appears on the A0 slider for informational purposes only.)

The A5, A6, and A7 sliders have the ratio 4:1 (a double octave) at 0.00. We say that
A5, A6, and A7 have 4:1 as their “zeroed” ratio. A3 has 4:2 as its zeroed ratio. A2 and
A1 have 6:3 as their zeroed ratio. A0’s zeroed ratio is not fixed; its zeroed ratio depends
on the Tuning Partial you chose in Ch2 as the low bass partial. For example, if you
chose low bass Tuning Partial 6, the zeroed ratio will be 6:3; for Tuning Partial 7, the
zeroed ratio will be 7:3.5; for Tuning Partial 8 it’ll be 8:4; if 10 then 10:5; if 12 then
12:6. 

The beat rate of each slider’s zeroed ratio is indicated by its pointer and is displayed in
the indicator box. If there’s more than one ratio on a slider, the zeroed ratio is bolded to
help make it easy to see. 

The other slider ratios are called “non-zeroed” ratios and are not fixed to any one beat
rate. Their locations are calculated by RCT and move around depending on the scale of
the piano, the OTS selected, the settings of other sliders, and Limits (SOM and DMax). 

You can figure the beat rate for a non-zeroed ratio by calculating the difference
between the non-zeroed ratio and the pointer.

For instance, look at the A6 slider. It has 4:1 as its zeroed ratio, which means the
pointer and indicator box of the A6 slider tell us the beat rate of the 4:1 double octave
A4-A6, which is .25 bps. In our example, the non-zeroed 2:1 ratio is located
approximately 1.75 bps below the zero point, which means the total distance from the
2:1 ratio to the pointer is 2.00 (1.75 + .25). The A5-A6 2:1 octave will beat
approximately 2 bps for a Yamaha C3E using OTS 4.

Slider Specs
The four bass sliders (A0 to A3) have a scale of -1.0 to +1.0 and gradations of ±.02.

The A5 and A6 sliders have a scale of -2.0 to +3.0 and gradations of ±.05. The A7
slider has a scale of -20 to +30 and gradations of .5. All measurements are beats per
second.

A CEQ tuning is re-calculated automatically after any change to a slider, OTS
selection, or Limit setting, which means pointers or non-zeroed ratios will re-locate and
the graph will be redrawn.

For those so inclined (and you know who you are) this multi-partial dynamicism will
be endlessly fascinating and a powerful research tool.

Using CEQ 
Let’s customize a tuning for our Demo Yamaha C3E. 
Reminder: The CEQ header should read “Yamaha C3E 6’ grand (Demo)”. If it

doesn’t, please go to Ch2 and select the Yamaha C3 demo piano, then return to CEQ.
The OTS Difference graph should be selected and its display mode should be cents.

Let’s say we like the overall sound of OTS 4 for this piano, but would like to make a
few changes:

1. We want the high treble a little sharper.
2. We’d like slightly less stretch in the tenor around A5.
3. We prefer slower 3rds around A2, so we’re going to decrease the stretch at A2. 
Choose OTS 4 by clicking on the OTS 4 radio button. When you do, an OTS 4

tuning is instantly calculated, exactly as though you’d chosen OTS 4 in Ch2 and clicked
on the Calculate button. (In fact, if you wanted a tuning using non-customized OTS 4,
you could click OK to exit CEQ then click Ch2’s Calculate button.) 
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Each slider’s pointers are automatically set to the proper beat rate for OTS 4 and
colored triangles appear next to each pointer. These triangles show the original location
for each pointer. The triangle’s color matches the color of the selected OTS radio
button. (Low-numbered OTSes use “cooler” colors and high-numbered OTSes use
“hotter” colors.) 

 Hint
If your laptop computer has a trackpad, use the “finger roll” technique to change a
slider setting a few hundredths of a beat. Touch a finger to the trackpad and roll
your fingertip forward and back.

Let’s increase the stretch for the high treble.  To do so, we’ll raise A7’s pointer
from its present “stock” OTS 4 setting of 0.00 beats at its zeroed interval, a 4:1
double octave. Click on the A7 pointer and drag it upwards until the indicator box
reads +2.0. 

This means the A7 4:1 double octave will now have 2.0 beats. High treble notes
will now be a little bit wider than a pure double octave; in other words, slightly
closer to an 8:1 triple octave.

When you release the mouse, a tuning with the new settings is calculated in the
wink of a computer’s eye. The change we just made to OTS 4 will be displayed on
the OTS Difference graph. We increased the stretch at A7, which means the notes
around A7 are now higher in pitch. The graph’s curve rises from A6 to A7 showing
that the increased stretch is smoothly distributed.
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The OTS 4 beat rate for the A5 slider is +0.75 beats at the 4:1 double octave. Let’s
decrease it to +0.35 beats. Click on the A5 slider and drag downwards until the
indicator box reads +0.35. When you release the mouse, keep your eye on the graph
and you’ll see several interesting things happen.

1. The graphline will belly down at A5, verifying that the stretch is decreased at
A5. 

2. The graphline around A7 will move down but its shape will remain unchanged,
illustrating that those notes have all been lowered the same number of cents so that
beat rates for A6 and A7 will remain the same, as confirmed by their pointers and
indicator boxes.

3. The pointer for A6 has moved slightly downward all by itself. Why? Look at
the A6 slider. There are two ratios — 4:1, which is a double octave with A4 as its
lower note, and 2:1, which is a single octave with A5 as its lower note. Both ratios
are used to calculate the pitch of A6. (The 4:1 is weighted slightly more than the
2:1.) We just moved A5 down and A5 helps calculate A6. So CEQ moved A6 down
too. 

What if we change our minds about altering A5’s stretch? Any pointer can be reset
to its “stock” OTS setting by clicking on its colored triangle. Click on A5’s colored
triangle and it will return to its original settings. The graph and other sliders will
return to their “pre-A5 tweaked” positions. 
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For this example, we want slower 3rds near A2, so let’s decrease A2’s stretch.
Move the A2 pointer from its present setting of +0.24 downwards till it’s at +0.20.
As expected, the graph at A2 moves up, showing us that A2 is now slightly higher
in pitch. 

If we were done tweaking a tuning in CEQ, we can create a tuning record in two
ways. Most convenient is to click on CEQ’s Calculate button. Or we could click OK
to close CEQ and return to Ch2 where CEQ’s radio button would be selected, then
click Ch2’s Calculate button.

But we’re not done learning CEQ. So stay right here and get ready for more fun.

Aural Intervals graph
Click on the button that says “OTS Difference”. The graph will toggle to the Aural

Interval graph. 
The Aural Intervals graph shows the width of 3:2 5ths, 3:1 12ths, 6:3 octaves, and

2:1 octaves. If you chose low bass partial 12 in Ch2, it shows 12:6 octaves; if
you’ve chosen low bass partial 10, it shows 10:5 octaves.
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You can view the Aural Interval graph as beats too.

Click on different OTS buttons and watch the Aural Intervals graph change. Notice
that this graph shows information even for non-tweaked OTSes, unlike the OTS
Difference graph. Drag some sliders and watch the Aural Intervals change.

For notes above A4, graph points are set at the interval’s upper note; for notes
below A4, graph points are set at the lower note.

Aural Intervals displays data taken directly from the tuning chart. You can look at
the tuning chart cells and do the subtraction in your head to figure the cents width of
any available interval, or you can let Aural Intervals do the hard work for you.

For example, on a tuning chart for the Yamaha Demo piano using standard OTS 4
(no tweaks), D4 reads 3.7¢ at partial 3 and A4 reads 1.9¢ at partial 2, meaning the
D4-A4 3:2 5th is 1.8¢ narrow (3.7 minus 1.9 equals 1.8). If you look at the Aural
Intervals graph in cents, the 3:2 graphline reads about -1.8¢ at A4.

The Aural Intervals graph can be very useful in customizing a tuning because you
can see the actual width of important intervals and how they interact. For example,
you might try raising the A5 slider to make the 3:2  5ths less narrow. At the same
time, you’ll be able to watch the affected 2:1 octaves get wider.

Beats or Cents?
Still using the Yamaha Demo piano, switch the Aural Intervals graph between

cents and beats several times and notice that the 3:2 graph at A4 in beats is half of
what it is in cents. That’s because beats are calculated at the actual coincident partial,
which is A5 for the D4-A4 3:2 5th. At A5 two cents equals about one beat.

Go back to OTS Difference graph and set to cents. Click on OTS 4 to reset all
sliders, then drag A1 to +.70. That makes a big dip in the graph, and seems like it
would affect the stretch in the bass a lot. Now toggle from cents to beats. Hey! The
6:3 octaves spread a little more than a half beat.

Click A1’s colored triangle to reset A1 and the graph should return to a straight
line. Now lower A7’s slider to -1.5, and watch the graph dive sharply down. Now
switch back to cents. The graphline becomes less radical.

You’ve just demonstrated to yourself why cents is better than beats for displaying
Spinner speed. Cents is more accurate in the bass and more controllable in the treble.
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Flipping bass sliders
You can flip the bass slider scales if you prefer that moving a pointer downwards

makes the bass notes go flatter. This means the bass sliders would move in the same
direction as the OTS Difference graphline. 

To flip bass slider scales, click on the “more stretch —>” label on the bass side of
the OTS buttons. Click again to re-flip the bass slider scales. 

The treble sliders don’t flip.

OTS Limits/User Limits
Let’s take a side trip and talk about Limits.
At the lower left of the CEQ window is the Limits popup menu. It has two

selections, OTS Limits and User Limits. 

If OTS Limits is selected, CEQ will display and use the same limits Ch2 uses
when calculating an OTS tuning. Using OTS Limits will result in the safest and most
typical tunings. The OTS Limits are listed in the OTS chart earlier in this chapter.
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If you select User Limits, the User Limits window will appear. This is where you
can specify your own settings for SOM (separately for T and B) and DMax. The
User Limits window also displays the standard OTS Limits settings so you’ll know
what “normal” is.

In User Limits, allowable SOM settings are from -1.00 to +1.00 for SOM.
Allowable DMax settings are from 0.00 to 4.00.

Why would anyone want to customize User Limits?
First, you might like a different stretch than the standard OTS Limits, just like you

might like a different stretch than a standard OTS. OTS Limits are deliberately set a
little on the conservative side; you can create more “liberal” tunings by using your
own User Limits. 

Second, you might find a way to re-set SOM and DMax that solves some
problems for tuning a specific piano. 

Some examples:
• Maybe a narrow A2-A3 sounds great on a certain spinet, but you want slightly

wider octaves in the tenor. In User Limits, you might set A2-A3 SOM to -0.20 and
A3-A4 SOM to 0.15.

• If DMax is constraining A3-A4 and A2-A3 too much for your taste and you’re
willing to have relatively wide tenor double octaves, increase DMax to, for example,
2.0. (You can effectively turn off DMax by setting it 4.0, its upper limit.)

Caution!
If you use User Limits, you should take extra care to aurally verify the entire

tuning, especially if your settings differ substantially from the OTS Limits.
Generally, we recommend you avoid setting DMax higher than 2.5 or SOM less
than -.20. 

The only exception may be some extremely scale-challenged (is that being polite
enough?) spinets, for which a 4:2 octave is preferred over a 6:3 at A2-A3 (B). In
this case, you can try setting A2-A3 SOM to -0.50 to create a narrow 6:3 octave
which might (might!) let you tune relatively pure 4:2 octaves in that region. If you
ever get into situations like this, you’d better be prepared to use your ears and make
lots of compromises.

Back to CEQ
OK, let’s go back to CEQ and try moving some more sliders. You should still be

using the Yamaha C3 Demo piano. Click on OTS 4 to reset the sliders. It doesn’t
matter which graph or scale is displayed. In fact, feel free to toggle between graph
modes and scales throughout the following examples.
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Drag the A2 slider all the way to the top. A dialog box appears that says, “The A2
slider is outside the normal tuning range. A2 + A3 can’t be greater than the A2-A4
Double Octave Max. (See Limits menu)”. RCT is telling us that our new A2 setting
created a double octave that’s wider than the Double Octave Maximum for OTS 4,
which is 1.00. Click on the OK button and watch what happens to the A2 pointer.
CEQ will set the A2 slider to .68! Why .68? A3 is already set to .32, and .68 is as
wide as A2 can get and still stay within the OTS 4 Double Octave Maximum of 1.00
(1.00 minus .32 equals .68). Also notice that the pointers for A0 and A1 have
moved by themselves, for the same reason as the A6 slider moved independently
when we altered the A5 slider — those ranges are calculated based on the slider we
just moved, as indicated by the ratios (zeroed and non-zeroed) on the A0 and A1
sliders.

Select User Limits and set DMax to 2.00. Click OK. Now drag the A2 slider all
the way to the top. Even though we’re not exceeding DMax anymore, another dialog
box appears! This one says, “A2 is outside the normal tuning range. A2 and A3
must be within .75 beats of each other.” CEQ is telling you it won’t allow more than
.75 bps in the A2-A3 single octave. This is a built-in CEQ safety feature that can’t be
overridden.

Click OK, and A2 will auto-set to 1.06 bps, which is just below the .75 limit from
A3’s OTS 4 setting of .32.

CEQ’s User Settings

If you’ve created a CEQ tuning for Mrs. Smith’s Gumbo Brothers piano and want
to tune her piano exactly the same next year, you’d save and re-use her just-created
tuning record. But what if you’d like to use the same CEQ tweaks on a different
piano with a different scale? Good news — you can store and recall up to ten sets of
CEQ slider positions and its OTS in what are called User Settings.

A User Setting doesn’t specify actual pitches like a Tuning Chart. Instead, a User
Setting specifies the OTS you selected and how far each slider was moved.

Different piano models have different scales which have unique partial ladders,
which means the same User Setting applied to two different pianos may result in
very different stretches, beat rates, and slider settings. You’re probably already
familiar with this effect in Ch2, where, for example, OTS 6 creates very different
beat rates on a Steinway D and Lester spinet.

To open the User Settings window, click on the User Settings button. When the
EQ User Settings window opens, you’ll see ten radio buttons, each with a text box
for typing in the name of the User Setting. The Save button saves the current User
Settings, Apply lets you apply a saved User Setting to the presently recorded piano,
Edit lets you examine or edit a saved User Setting’s parameters, OK accepts any
changes to the User Settings and closes the window, and Cancel rejects any changes
to the User Settings and closes the window.
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 More specifically:
To save the current CEQ setting (the selected OTS and how far you’ve moved each

slider) click on a radio button, type in a name for the User Setting (or leave the
default name), then click Save.

After you’ve saved some User Settings, you might wish to apply a saved User
Setting to another piano. After sampling that piano in Ch2, open the User settings
window, click a radio button to select a User Setting, then click Apply. The User
Settings window will close and the selected User Setting will be applied to the
currently recorded piano. (If the sliders on the new piano are different from the
original, it’s probably because the new piano was constrained by the current Limits
settings.)

To view and/or edit the specifications for a User Setting, click on its radio button
then click Edit. The Edit User Settings window will open.

 

In the Edit User Settings window, the User Setting name is displayed above the
set of labelled boxes. The middle box displays the OTS number. The other boxes
display the slider’s offset from the OTS’s original setting; in other words, how far
you moved a slider from where CEQ set it. The numbers in the OTS box and slider
boxes can be edited. (If you’re not careful here, you can make a tuning that sounds
really crazy, so use extreme caution!) To save your edits, click OK. To save and
apply the edited settings, click OK to exit to the User Settings window then click
Apply. 
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Limits are not saved when saving a User Setting. This means whatever the current
Limits are will be applied to a selected User Setting.

User Settings can be a little confusing. You might be puzzled that the User
Settings specs in the Edit User Settings window are not the same as CEQ’s pointer
or indicator boxes, but that’s normal. User Settings indicate how much an OTS has
been altered (in other words, how far you moved the pointers, not the actual pointer
setting), whereas CEQ’s indicator boxes and pointers show deviation from beatless
octaves.

How should I use CEQ? 
• Tune the piano and listen to it. If there are any areas you want to change, move

the appropriate sliders, calculate another tuning record, then re-tune the piano.
This method is the easiest and most direct, and will probably be the most popular.

With the piano at pitch and entirely strip muted, it takes very little time to tune one
string per note, especially if you know you’ll be making subsequent passes. 

A truncated refinement: Especially on problem pianos, don’t bother tuning all
notes. Instead, tune only the tenor. Once you find on OTS that sounds good there,
tune the outer octaves, using CEQ to tweak their stretch if desired

• Use CEQ to analyze and alter the stretch in certain areas to create interval widths
that fulfill your mathematical wishes.

Some RCT users are especially interested in the width of 5ths in the mid-treble.
Select Aural Intervals and look at the 3:2 graphline, which indicates the speed of the
5ths from D4-A4 to G#4-D#4. You might want these 5ths to be approximately the
same size or, at best, get narrower very slightly. If the graph indicates that fifths at
the top of this range are more than 3 cents narrow, the fifths are probably beating too
fast and likely to sound bad. If they are too fast, you can decrease the beating of the
fifths by raising the slider nearest the upper notes, which in this case is the slider at
A5. (Lowering the slider near the lower note would work too, but that usually
creates worse problems and is not recommended).

If this line of thought interests you, remember that as octaves ascend, beat speeds
double for the same cents differential. This means a 2 cent narrow fifth in octave 4
will beat approximately 1 bps, but a 2 cent narrow fifth in octave 5 will beat twice as
fast at 2 bps (theoretically!).  

• Create a library of your own personal User Settings
After using CEQ for a while, you may find some CEQ settings that you like better

than a “stock” OTS. You may also decide that a certain CEQ setting works especially
well for a certain piano model. For example, you may decide that a Steinway D
concert piano sounds best with OTS 7, a little extra stretch at A5, tons of extra
stretch at A7, and slightly less stretch at A2. But Steinways vary a lot even within
the same model, so you don’t want to use the same tuning record on a different
model D. Instead, you’d save this as a User Setting named “Steinway D special
sparkle” and apply it to your other Steinway D pianos.

• Using CEQ, an aural tuning can be closely matched. Then a similar CEQ tuning
record can be calculated which will have much better note-to-note consistency. 

• It’s possible to use the Tuning Graph (not the OTS-CEQ difference graph in
CEQ) to infer interval widths, especially the 3rd and 2nd partial lines for the interval
of a 5th for notes D4 to G#5 (as described above). If these graph lines are nearly
parallel, then the narrowness of the 5ths is relatively consistent. On the other hand,
if the 2nd partial line is steeper than the 3rd partial line, the 5ths are getting narrower
as they go up the scale, which may result in unacceptable beating.

53

Limits are not saved when saving a User Setting. This means whatever the current
Limits are will be applied to a selected User Setting.

User Settings can be a little confusing. You might be puzzled that the User
Settings specs in the Edit User Settings window are not the same as CEQ’s pointer
or indicator boxes, but that’s normal. User Settings indicate how much an OTS has
been altered (in other words, how far you moved the pointers, not the actual pointer
setting), whereas CEQ’s indicator boxes and pointers show deviation from beatless
octaves.

How should I use CEQ? 
• Tune the piano and listen to it. If there are any areas you want to change, move

the appropriate sliders, calculate another tuning record, then re-tune the piano.
This method is the easiest and most direct, and will probably be the most popular.

With the piano at pitch and entirely strip muted, it takes very little time to tune one
string per note, especially if you know you’ll be making subsequent passes. 

A truncated refinement: Especially on problem pianos, don’t bother tuning all
notes. Instead, tune only the tenor. Once you find on OTS that sounds good there,
tune the outer octaves, using CEQ to tweak their stretch if desired

• Use CEQ to analyze and alter the stretch in certain areas to create interval widths
that fulfill your mathematical wishes.

Some RCT users are especially interested in the width of 5ths in the mid-treble.
Select Aural Intervals and look at the 3:2 graphline, which indicates the speed of the
5ths from D4-A4 to G#4-D#4. You might want these 5ths to be approximately the
same size or, at best, get narrower very slightly. If the graph indicates that fifths at
the top of this range are more than 3 cents narrow, the fifths are probably beating too
fast and likely to sound bad. If they are too fast, you can decrease the beating of the
fifths by raising the slider nearest the upper notes, which in this case is the slider at
A5. (Lowering the slider near the lower note would work too, but that usually
creates worse problems and is not recommended).

If this line of thought interests you, remember that as octaves ascend, beat speeds
double for the same cents differential. This means a 2 cent narrow fifth in octave 4
will beat approximately 1 bps, but a 2 cent narrow fifth in octave 5 will beat twice as
fast at 2 bps (theoretically!).  

• Create a library of your own personal User Settings
After using CEQ for a while, you may find some CEQ settings that you like better

than a “stock” OTS. You may also decide that a certain CEQ setting works especially
well for a certain piano model. For example, you may decide that a Steinway D
concert piano sounds best with OTS 7, a little extra stretch at A5, tons of extra
stretch at A7, and slightly less stretch at A2. But Steinways vary a lot even within
the same model, so you don’t want to use the same tuning record on a different
model D. Instead, you’d save this as a User Setting named “Steinway D special
sparkle” and apply it to your other Steinway D pianos.

• Using CEQ, an aural tuning can be closely matched. Then a similar CEQ tuning
record can be calculated which will have much better note-to-note consistency. 

• It’s possible to use the Tuning Graph (not the OTS-CEQ difference graph in
CEQ) to infer interval widths, especially the 3rd and 2nd partial lines for the interval
of a 5th for notes D4 to G#5 (as described above). If these graph lines are nearly
parallel, then the narrowness of the 5ths is relatively consistent. On the other hand,
if the 2nd partial line is steeper than the 3rd partial line, the 5ths are getting narrower
as they go up the scale, which may result in unacceptable beating.



54

Calculate button

When sampling is completed and Advanced users have made their Ch2 or CEQ
choices, click the Calculate button. A tuning record will be calculated based on the
samples you took and the OTS and tuning partials selected. (If Ch2 is in Easy mode,
the OTS and tuning partials are selected for you.) Chameleon 2 will close and the
tuning record’s tuning chart will be displayed. 

 Hint
Because the Calculate button is default button, as indicated by its dark border.
pressing the Return or Enter key is the same as clicking on the Calculate button.

 Hint
Before clicking the Calculate button, open the tuning file in which you want the
new tuning record to be stored. This way, the new tuning record will
automatically be placed into this tuning file when you create it by clicking the
Calculate button.

Organizing Files and Records

Here’s the most important Hint for organizing your tuning records and files:

 Hint  Hint  Hint  Hint
Store many tuning records in each tuning file. This is very easy to manage.
Here’s how:
Before clicking the Calculate button, open the tuning file in which you want the
new tuning record to be stored. Then select Chameleon 2 and take samples.
When you create a new tuning record by clicking the Calculate button, the new
tuning record will automatically be placed into this open tuning file as the last
tuning record.

 Hint
To help with the previous Hint, create an alias Mac) or shortcut (Win) of your
primary tuning file (e.g.,  Customer Library) and place it in the Startup items
folder. If so, delete the RCT alias/shortcut in the Startup items folder. The
Customer Library will now automatically open when your computer starts up. If
you like this hint but don’t want RCT to automatically open every time the
computer starts up, don’t put an alias/shortcut in the Startup folder. Instead,
open RCT by double-clicking on a Customer Library alias/shortcut on your
desktop (or anywhere else — you can place them anywhere you want). 

On Mac the Startup alias is in Macintosh HD:System Folder:Startup Items.
You can also put your Customer Library into the Apple menu by placing a
Customer Library alias in the Apple Menu Items folder (select the Customer
Library icon or its alias then select “Add Alias to Apple Menu” under Automated
Tasks under the Apple menu).

 The Win Startup shortcut is in C:\WINDOWS\Start Menu\Programs\StartUp\.
You can also put your Customer Library into the Start menu by placing a
Customer Library shortcut in C:\WINDOWS\Start Menu\Programs\Reyburn
CyberTuner 3.5\. Then your Customer file will appear near RCT itself.
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Tuning Record #

A tuning file can contain from 1 to 240 records, and so Ch2 needs to number each
record. To let you know what tuning record is about to be created when you click
the Calculate button, a number is displayed in Ch2 in the “Tuning Record #” (tuning
record number) window. After creating a record and going to CE, the number of the
active tuning record is displayed in the CE header box. 

Ch2 automatically places a “1” in the “Tuning Record #” box when you create a
new tuning file.

When you open an existing tuning file that already contains some records, RCT
automatically increments the Tuning Record # so any new tuning record becomes the
last record in the file.

To assign a different number to a new tuning record, manually enter the desired
number in the Tuning Record # box before clicking the Calculate button. If the
number is higher than the number of saved records currently in the file, blank tuning
records will automatically be created to fill the gap. If the number is lower, a dialog
box will appear asking if you really want to overwrite an existing tuning record; if
you click "OK", the existing tuning record will be erased and the new tuning record
will take its place.

Tuning record numbers can be changed at any time by moving a record to a new
location in its file. To do this, click on the record you want to move with the Tuning
Hammer pointer, select “Cut” under the Edit menu, click the insertion point where
you want the tuning record to be located, then select “Paste”.Tuning record numbers
are automatically assigned consecutively. See chapter 3 “Editing Files and Records”
for more tips.

  Hint
Noise bothers Ch2 more than CE. Keeping a large bank of tunings can save
your bacon if you’re in a situation too noisy for Ch2 to take decent samples. For
super-noisy nightmares (e.g., many pianos tuners, one room), get a magnetic
Fairchild Accu-Pickup from Inventronics.

Headers
When Chameleon 2 is finished calculating a new tuning record, it places

information in the header indicating the OTS and the predicted beat rates of octaves
A2-A3 and A3-A4 and double octave A2-A4. This helps you predict what the tuning
will sound like before you actually tune the piano.

For example, “>5< B=0.30B T=0.38B D=0.73B” means Octave Tuning Style 5
was selected; the Bass 6:3 octave at A2- A3 will be 0.30 bps wide; the Treble 4:2
octave at A3-A4 will be 0.38 bps wide; and the 4:1 Double octave at A2-A4 will be
0.73 bps wide.  

Headers can hold up to 70 characters, including spaces. Type other information in
the header if you wish, but don’t let the information RCT has placed in the header
get pushed off the end; if you do, it will be lost when the window is closed or
another field is made active. To avoid this, select the blank space by double clicking
anywhere in the blank space, then type in the piano or customer info. Stop typing
before the OTS info is pushed off the header. If you like, use extra spaces for
separators.

 Hint
Immediately after calculating a new tuning record, enter header info then save the
tuning file (select Save... under the File menu).
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Using headers to organize records
The information you put into each record’s header is important because a header

serves as the name for a record. 
There are four features of RCT that affect how headers can be used to organize

tuning records:
1. In File View by Icon, each piano icon contains the first letter in its header. 
2. In File View by Icon, when the cursor (magnifying glass or hammer) is over a

piano icon, the entire header of that tuning record is displayed.
3. In File View by Header, the entire header for each record is displayed in a

scrolling list.
4. The “Sort...” command under the Tools menu alphabetizes all tuning records in

one tuning file by the contents of the record’s header.

Basically, there are two choices for the header’s first word: the customer name or
the piano name.

Using the piano name can help you create a file of common piano models. Every
time you see a piano, you can check your file to see if you’ve already saved one of
this model, and if so you can re-use the saved record. After you’ve created a large
Piano Library, you’ll have a bank of tunings you can use to tune a piano if it’s ever
too noisy for Ch2 to take samples.

Using the customer name as the header’s first word can help you create a
Customer Library. This makes sense if you want to use the same record every time
you visit a customer. Use this to your competitive advantage to market your RCT-
enhanced services. “Each time I tune your piano, it will be tuned in exactly the same
way.”

However, many advanced RCT users don’t save every tuning record. It takes so
little time to sample and calculate a tuning record that they create a new tuning record
every time they visit a customer’s piano. This saves the time of finding the saved
record and insures that any seasonal changes in a piano’s inharmonicity are
compensated for, and allows the tuner to make any changes in OTS, tuning partials,
or CEQ settings.

Here’s an example of a header: 

GATES, BILL  STEINWAY B #543210  >7< B=0.50B T=0.50B D=1.00B CH2

This means the customer is Bill Gates, the piano is a Steinway, the model is a B,
the serial number is 543210, OTS 7 was used when calculating the tuning, the
predicted beat rate of the Bass control octave (A2-A3) is a 0.50 beats per second, the
predicted beat rate of the Treble control octave (A3-A4) is a 0.50 beats per second,
the predicted beat rate of Double octave (A2-A4) is 1.00 beats per second, and
Chameleon 2 calculated the tuning data. 

 Hint
Put the piano’s serial number in every header. You’ll be glad you did if you save
many records for one piano model or have any customers with the same name. It
will also help you if you ever want to know the date of manufacture and scale
design of your sampled piano.
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 Hint
 If you’re really pressed for header space, the piano’s serial number can be stored

in the two “Ser” cells in the tuning chart. The serial number will be displayed as
the header’s last item in file view when the pointer is over the record’s piano
icon, but will not appear in the record’s header when the record’s chart is open.
Four numerals can be stored in the first Ser cell and three numerals in the next.
These two cells will be concatenated when displayed; in other words, if “1234”
is in the first Ser cell and “567” is in the second, then “1234567” will appear.
Using Search... under the Tools menu will not find such a serial number. 

 Q&A
Question
Could a saved tuning be used on another piano of the same model?
Answer
Yes, but it’s not recommended. If you do this, please be careful. 
If the scales of the two pianos are exactly the same, the “imported” tuning record

will work just fine on both. But if the manufacturer changed the scale design
between the manufacturing of the sampled piano and the one you’re now tuning,
there may be problems. If there’s variation from one piano to the next within the
same model (e.g., some Steinways) more differences will arise. 

For pitch raises, these differences are inconsequential and probably won’t matter.
But for fine tuning, they may result in significant errors.

Many RCT users take samples of every piano they’re about to tune — even if they
already saved a tuning from this piano. Why re-sample a piano you sampled six
months ago? Because changes in humidity can affect the piano’s pitch, or a
soundboard that is moist and swollen may have a different impedance compared to
dry and flatter. These changes may affect the inharmonicity, which may alter the
partial ladders, which will yield different tuning data.

It’s still a good idea to build a piano library of tunings from all the models you
service in case it’s too noisy to take samples or you’re rushed for time.

 Q&A
Question
Why do I get different tuning data for different pianos that use the same OTS?
Answer
Because different pianos have different inharmonicities, which means a partial

ladder from A2 of Piano A will be different from A2 of Piano B. Ch2 uses partial
ladders to calculate the 88 note tuning, so different partial ladders will cause Ch2 to
calculate different pitches for the 88 notes.

Organizing Tuning Files
It’s most efficient use of hard disk space to put many records into a small number

of files. A full tuning file containing the maximum 240 records occupies about 63K
on a hard disk. A file with only one record occupies 13K (although only 712 bytes
are used). For comparison, 240 files with one record each would occupy 3,120K or
3.12 megs. That's a differential of almost 50:1.

There are several recommended strategies for organizing tuning files. 
When you installed RCT, a folder named “A to Z Library” was created. In it are 26

empty tuning files named A, B, C, etc. You can store records whose headers start
with the letter A in the A file, with the letter B in the B file, etc. If the A file fills up
(each tuning file holds a maximum of 240 records), create another file called, for
instance, A2. This strategy works best if you anticipate saving lots of tuning files.
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A simpler method is to use a small number of files with many tuning records in
each. For example, Mitch has only five files — Customer Library, Piano Library,
Concert Hall, College, and Research. 

Mitch’s Customer Library file holds tuning records for his customers’ pianos. The
customer’s last name is the header’s first word, followed by piano make, model,
and serial number. When the Customer Library fills up with its maximum of 240
records, another file is created called “Customer Library N to Z”, the original file is
renamed “Customer Library A to M”, and records whose headers start with N-Z are
pasted to the “Customer Library N to Z” file. (Moving the N-Z records to their new
file takes one cut-and-paste.)

The Piano Library file holds tuning records for common piano models. The
piano’s manufacturer is the header’s first word, followed by the model and serial
number, which means after selecting Sort... these records are alphabetized by
manufacturer and model. Mitch keeps a Piano Library in case he’s in a situation
where he can’t or doesn’t want to record a piano, such as a noisy room or for pitch
raising. Instead, he’ll open a saved tuning of the same model. Because he keeps a
Customer Library, the Piano Library is not really necessary; Mitch could search in
his Customer Library for a particular model piano. But he thinks worth keeping the
Piano Library is worth a little extra disk space because it makes it quicker to find a
particular model.

The Concert Hall file holds tuning records for the local concert hall’s concert
grand, small grand, and upright. Mitch tunes there quite often and it’s quicker to get
to these records if they have their own file.

 The College file holds records for the 25 pianos at the local college, including
many extra records at different OTSes.

The Research file holds experimental or demonstration records. Nothing in the
Research file ever gets put onto a customer’s piano — in other words, Research is a
safe place for messing around.

 Hint
In your Research file, create tuning records from one piano (actual or Demo)
using each OTS style in order. Scroll through their graphs using Command +
arrow key (Mac) or Control + arrow key (Win) for an interesting lesson on OTS
differences. Or use the Math tool Difference to create a tuning record showing
the difference between two OTSes.

 Hint
The “Find Tuning...” command under the Search menu finds any text string 
within a header (in the active file only). This can be a big help if, for example,
you want to find text in a header that’s not the first word, for example the
piano’s serial number.

 Hint
If you calculate several tuning records before finding one you’ll actually use,
leave the “practice” headers blank. Later, you can easily identify these empty
records because their tuning file icons (Icon View) or headers (Header View)
will be empty. Sort the records and all the empty-header records will be at the
beginning of the tuning file, allowing you to drag-select and delete them all at
once (select Clear under the Edit menu).

 Hint
Saving one record per file, even though it uses disk space inefficiently,
is an option preferred by some users. All records can be viewed directly from the
Finder without opening RCT. If you use this method, name each file
descriptively as suggested above for headers.
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File Formats
RCT 3.5 has a new file format called “RCT extended format.” This format

allows for better resolution (0.01 cents), an extremely accurate prediction for
A4’s pitch in the tuning chart, more flexibility in naming tuning charts (upper
and lower case and multiple languages), a higher number of serial numbers in
the Tuning chart (pre3.5 the serial number field accepted any number up to
1,999,999. RCT 3.5 accepts numbers up to 99,999,999). 

If you open an RCT file created by RCT 3.0 or earlier, you will be asked if
you want to convert and if all future conversions should be automatic. We
recommend you do so. 

RCT’s Save and Save As... dialog boxes has additional options for format
changes and naming. Proper naming helps RCT know which files to display and
how to display them. Click on the Format popup menu to see the list of available
RCT formats:
Tuning File
Historical Temperament
PTG Exam File
Pitch Raise Overpull
Old Tuning File
Old Historical Temperament
Old PTG Exam

“Old” files are those created by RCT 3.0 or earlier. New files are those
created by RCT 3.5 or those that have been converted from old to new.

In the Save and Save As... Dialog boxes, please notice the “ +.rctx” button.
This button will change names to match the file type selected. 
Old file types have three letters in their extensions, and new file types have four
letters. Clicking on this button will automatically append the correct extension to
the name of the file.

.rctx Tuning File

.hist Historical Temperament

.ptgx PTG Exam File

.prop Pitch Raise Overpull

.rct Old Tuning File

.hst Old Historical Temperament

.exm Old PTG Exam

 In RCT 3.5 for Macintosh, you can go to Preferences under the Edit menu
and check a box to automatically put the correct Windows extensions after all file
names. Turning on this options helps make it easier to share RCT files between
RCT Mac and RCT Win. 

Moving to CyberEar
To open CE, click on the CyberEar button in the chart window.

 

You can also pull down the Windows menu and select CyberEar; type
Command + R (Mac) or Control + R (Win) ; or, because the CyberEar button is
a default button, press the Return or Enter key.
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chapter 3

CYBEREAR

What does CyberEar do?
CyberEar (CE) measures the pitch of a piano string and displays its deviation.

Usually, the deviation is relative to a note’s cents reading in a cell of a Ch2 tuning
record. CyberEar can use tuning records that were created by another source (Ch1,
recorded aural tuning, another VTD, etc.). 

If neither a tuning record nor tuning file are open when you select CE, deviation is
from pure (0.00) equal temperament.

How do I choose a tuning record for CE to use?
CyberEar uses the tuning record that’s open or selected (in a file) when CyberEar

is selected.
If a tuning file is open but no tuning record is open nor selected, CyberEar uses

the last tuning record in the tuning file.
If you accidentally select more than one tuning record, the first record in the

selected group will become CE’s active record.

Measuring deviation from pure (0.00) equal temperament
If neither a tuning record nor tuning file is open when you open CyberEar,

CyberEar will display pitch deviation from theoretically “pure” equal temperament
(0.00 cents for all notes). The Tuning Partials (the note at which CE is listening) will
be partial 1 (fundamental) for notes A1 and higher, and partial 2 for notes A0 to
G#1.
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Identifying Notes
You can see which note is selected for tuning in two places on the CE screen: 

in the Note Selection box

and on the graphic keyboard. 

  The graphic keyboard imparts lots of information. The hand’s finger points to the
selected note, its key is darkened, and the note name and octave are written over the
note. At the Tuning Partial (the note at which CE is listening) an ear appears over the
key, a colored dot is displayed on the key (the same color as the Spinner), the note
name appears over the key, and the partial number appears under the key. 

Displaying Pitch Deviation
To display the pitch of a piano string, CE uses the Spinner, which looks like a

circle with two rotating colored pie-slices. Each of these pie-slices is called an arc.
Behind the Spinner is a large horizontal gray oval. Centered in the oval and roughly
the same size as the Spinner is a black circle called the target. 

The Spinner
The Spinner is CyberEar’s most important visual component. You’ll be staring at

it a lot, so let’s discuss it first.
If a note is perfectly tuned (its pitch exactly matches the cents reading in the Tune

box), the Spinner stops rotating and will be located directly over the target. If
Targeting is on, you’ll see a blush (explained below). 

If the note is sharp, the Spinner rotates clockwise; if the note is flat, the Spinner
rotates counterclockwise. Rotation speed increases as the note becomes increasingly
sharp or flat. If the note is more than 2 cents off pitch, the Spinner moves
increasingly right if sharp and left if flat.

When the Spinner moves to the right or left, the numbers under the oval (10¢,
25¢, 50¢, etc.) and the oval’s gray crescents can give a rough idea of the Spinner’s
location and, therefore, the note’s deviation. When the Spinner’s centerpoint is
directly over one of these numbers (which will coincide with the Spinner’s outer
edge lining up with the edge of a crescent), the note being played is off-pitch by the
number under the Spinner. 
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In the following example, the note being played is 10¢ flat.

Some laptop computers may not display all the shaded crescents because they
aren’t capable of such subtle shades of gray. On these machines, align the Spinner’s
centerpoint to the numbered scale under the oval.

The Spinner’s diameter decreases as the note’s volume decreases. If the Spinner is
noticeably smaller than the target, the volume is too low for CE to accurately display
the pitch, and it’s time to “Play it again, Sam!”

The Spinner’s hub size increases in proportion to the Spinner’s shift to the left or
right. The hub size will increase even if the Target has shifted when displaying a
calculated cents overpull in Pitch Raise mode (explained in the Pitch Raising section
below).

Target blushing
When a string is very close to correct pitch, a small dim circle called the “blush”

appears inside the Target (the dark ball behind the Spinner). As the string gets closer
to being perfectly tuned, the blush increases in diameter.

The blush is the same color as the Spinner and half its brightness. If you change
the Spinner’s color in the Spinner dialog box, the blush color will change too.

   
Here’s how Targeting works. 
If the Spinner speed is set to the default rate of 2.0¢ per revolution per second, a

50% diameter blush appears when the string is within 0.3¢ of its correct pitch. The
blush increases in size to 70% diameter when the string is within 0.2¢, increases to
90% when the string is within 0.15¢, and fills the Target when the string is within
0.1¢.

Targeting sensitivity is proportionate to Spinner sensitivity. In other words, if you
double the Spinner rate, the Targeting tolerances double. For example, if you reset
the Spinner to 4¢ per revolution per second, then the Target blush will be 50%
diameter at 0.6¢, 70% at 0.4¢, 90% at 0.3¢, and 100% at 0.2¢.

Targeting works even if the Spinner is set to Hertz (beats). At a Spinner setting of
2 beats per revolution per second, the Target blushing numbers are 50% at 0.3 bps,
70% at 0.2 bps, 90% at 0.15 bps, and 100% at 0.1 bps, and change proportionately
with the Spinner rate.
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Your ultimate goal is to get 100% Targeting for as long as possible, which is
virtually impossible to attain. Most pianos are not well-built enough to generate a
pitch stable enough to show a sustained full blush; some poorly built pianos are
barely capable of blushing at all. (Have they no shame?) Poor terminations, bad
wire, sloppy damping, and imprecise resonances can prevent a piano from being
“blushable.” If you're tuning a troublesome piano, a momentary 50% blush might
be the best you can hope for. In these situations, you might decrease the Spinner's
sensitivity and thereby widen the Targeting tolerances. If you do, remember that the
Spinner spin rate will be less sensitive too.

A tolerance of 0.1¢ is less than almost anyone can discern.  But if you have
exquisite hammer technique and are fine-tuning a well-regulated concert-quality
grand, you may experience the profound satisfaction of seeing full Target blush on
all notes. If you do, you’re one of the world’s best tuners. Did that make you blush?

Target blushing operates in all modes, including Pitch Raising. Even if you've set
the Spinner rate very high for Pitch Raising (e.g., 8¢/rev/sec) Targeting can be
useful.

When using RCT for the PTG RPT Tuning Exam, you should lean very heavily
on Targeting. When measuring a Master or Examinee tuning, you should always see
at least a partial blush before saving a cents reading. This will help ensure high
standards of exam accuracy and minimize variation in examiner measuring skill. If
Target blushing is hard to achieve on a majority of notes, you should re-evaluate the
piano’s suitability for the Tuning Exam.

Spinner Button

To adjust Spinner settings, open the Spinner dialog box by clicking on the Spinner
button. 
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In the Spinner dialog box you can:
• Select whether Spinner rotation speed is relative to cents or hertz (beats).
• Vary the Spinner’s speed rate (sensitivity).
• Select whether “Smoothing” is enabled (default is on). 
• Click the Off checkbox to turn the Spinner into a solid ball.
• Change the arc size from 20° to 140°. CE’s Spinner button reflects the current
arc setting.
• Change Spinner color by clicking Color. . .  and selecting any color your
computer can display. CE’s Spinner button reflects the current color setting.
• Turn Targeting on or off.

The most important of these choices — by far — is selecting whether the
Spinner’s rotation displays deviation as cents or hertz (beats) and Spinner speed.

Beats is the traditional display mode for visual tuning devices. But there’s a big
problem with beats — there are very few beats between notes in the bass and very
many beats between notes in the treble. In fact, there are approximately the same
number of beats in a bass octave as in a high treble half step! This means a beats
display is very slow in the low bass and very fast in the high treble. 

CyberEar’s Spinner can be set to beats, but RCT is the first (and only) piano
visual tuning device to display deviation as cents. The vast majority of RCT users
(actually, as far as we know, all RCT users) prefer cents over beats because:

• The display is more accurate in the low bass and more stable in the high treble. 
• The relative deviation of every note is the same throughout the entire 
keyboard; in other words, if a fifth in the bass and a fifth the treble are both
contracted 1.95¢, their Spinner rotations will be the same.
• There is no loss of accuracy when choosing a lower (often stronger) tuning
partial.

Because displaying deviation as cents is so vastly superior to beats, the Spinner
defaults to cents every time RCT is opened.

Spinner speed
The Spinner speed, or sensitivity, is another important Spinner setting. You can

adjust the Spinner’s sensitivity by clicking and dragging the slider’s pointer or by
clicking anywhere on the indicator tube.

The most sensitive settings are higher up the tube (the lower numbers). One cent
per revolution per second is much more sensitive than sixteen cents per revolution
per second.

This might be hard to grasp at first (how can lower numbers mean higher
sensitivity?), but it makes sense if you stop and think about it. If a note is 16 cents
off pitch, at 1 cent/rev/sec the Spinner will rotate 16 times in one second, but at 16
cents/rev/sec it’ll rotate only once per second. 

For fine tuning, we recommend a Spinner speed between 2 and 4 cents per
rev/sec. At its most sensitive setting (1¢/rev/sec) the Spinner is jumpy and a little
harder to control. (It’s not the Spinner that’s jumpy — it’s the string’s pitch!) For
pitch raising, it’s OK to use a slower speed such as 6 or 8 to help prevent obsessing
and to encourage yourself to move quickly. (“Life is but a pitch raise. I’ll attain
perfection next pass.”)

The Spinner’s current sensitivity setting is graphically indicated on the CE screen
by the thickness of the rim around the Spinner. The thicker the rim, the slower the
speed and the less sensitive.
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fast spinner slow spinner

Spinner speed rate and color are saved and restored for each individual tuning
mode. In other words, you can set a different Spinner speed rate and color for Fine
Tune, Small Pitch Raise, Medium Pitch Raise, Large Pitch raise, and Manual Pitch
Raise. When you select that mode again the Spinner will automatically re-set to those
settings.

Spinner arc size is the same in all tuning modes. The current arc size is saved and
restored the next time RCT opens.

Smoothing
Smoothing helps keep the Spinner display steady by continuously updating a

trailing average of three readings of the current note. The first reading is the current
time window (a small fraction of a second). The other readings are the two
immediately preceding time windows, each of which also have been smoothed.

Smoothing should be left on under almost all circumstances.

First selected note
If RCT hasn’t quit since the previous CE session, the first selected note will be the

last selected note of the previous CE session. If you’re opening CE, the first selected
note will be whatever you’ve set in the Prefs window

NoteSwitcher and Navigating

To advance to the next note, it’s not necessary to press a note switch, click your
mouse, or press a key on your computer’s keypad. (You can, but you don’t need
to.) Simply play an adjacent note and NoteSwitcher “automagically” moves up or
down a half step to the note you’re playing.

To switch to a note further away than a half step:
• Click on any key on CE’s keyboard graphic
• Click on CE’s navigation buttons

• Press one of the computer keyboard’s arrow keys: up-arrow to switch up a half
step, down arrow to move down a half step, right arrow to move up one octave, left
arrow to move up one octave. Holding down one of these arrow keys will make the
key switch repeatedly and rapidly. (The repeat rate is adjustable in your computer’s
Keyboard control panel.)

• Play the intervening notes chromatically. NoteSwitcher can switch notes about 8
times per second on a 100 mHz computer.
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NoteSwitcher preferences 
NoteSwitcher can be set to bi-directional, up-only, or down-only. There are two

methods to select NoteSwitcher settings — in the Prefs window or with a keyboard
shortcut.

To set NoteSwitcher direction in the Prefs window, click CyberEar’s Preferences
button

then select the desired NoteSwitcher setting. 

You can also select a NoteSwitcher direction from CyberEar with keyboard
commands.

b Bi-directional
u Up-only
d Down only

Pressing the command key (Mac) or Control key (Win) is not required.

You can view NoteSwitcher’s direction from CyberEar. The arrows inside the
NoteSwitcher button on the CE screen tell the story.

bi-directional   up-only  down-only

 Hint
Set NoteSwitcher to bi-directional for fine tuning and up-only for pitch raising.

If the room is very noisy, NoteSwitcher might go a little crazy, and you might
prefer to turn NoteSwitcher off. 

NoteSwitcher can be toggled on and off in two ways.
The first method is to click the NoteSwitcher button.
The second method is to press the L key, which will toggle NoteSwitching

between Locked-on and Locked-off.
To see if NoteSwitcher is on or off, look at CE’s NoteSwitcher button.

     

      NoteSwitcher on NoteSwitcher off
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Space bar note switching
Pressing the space bar makes CE note switch up. Holding down the spacebar will

continuously note switch up. 
If a note is sounding while the space bar is pressed, note switching may be slow

and erratic. When the note stops sounding, CE will switch up properly. A non-
techie explanation: Sometimes CE can’t do everything at once, and it has to decide
which task to do first; listening to a note has a higher priority than spacebar note
switching.

 Hint
If NoteSwitcher gets “stuck”— CE won't switch to the next note when you play
it — play the note in the Note Selection box then play the next note again.
NoteSwitcher will probably switch just fine. 
Here's a non-technical explanation: NoteSwitcher sometimes gets lost; playing the
selected note helps it remember where “home” is.

 Hint
Laptop computers automatically go to sleep (Mac) or suspend (Win) if there’s
been no “event” (e.g., mouse click or key press) during a time period specifiable
in the Laptop computer Control Panel. In CyberEar, an “event” includes CE
hearing a strong pitch or any NoteSwitcher action. In other words, the computer
will not auto-sleep if during the specified time period CE hears a note or if
NoteSwitcher has switched to a different note.

 Windows: On some models, note switching may not keep the laptop awake.
Most Windows laptops can “Suspend” from the Start menu. If your laptop
suspends by itself too soon, this can usually be changed in a battery or power
management Control panel.

 Mac: To put your computer to sleep in CE, press the “Z” key. 
To spin down your computer’s hard disk in CE, press the “H” key.

Tuning Modes
CyberEar has three tuning modes, selected with the popup menu or keyboard

commands.
Normally, CE starts up with Fine Tune mode selected. You can change the default

tuning mode (and the start note) by clicking the Prefs button and selecting the
desired start mode and note. 

 

 

Fine Tune mode is the most commonly used tuning mode. It’s the
recommended mode for pianos that are fairly close to pitch (within about 8¢ or 2
beats), although it can be used at any time. The easiest keyboard shortcut is T (no
modifier key required). Command + T (Macs) or Control + T (Win) work too. If
your screen is smaller than 800 x 600 the keyboard shortcuts are not displayed but
still work.

In Fine Tune mode, the selected note’s cents reading is displayed in the Tune Box.
This reading is read directly from the selected note’s cell in the active Ch2 tuning
record.

 Hint
After completing a fine tuning, check the tuning visually and aurally.
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To check a tuning visually with RCT, simply start at A0 and play the notes
rapidly, watching for a stopped (or nearly stopped) Spinner. If you find a note
the Spinner indicates is off, check it aurally to see if it can be improved by tuning
it in the direction indicated by the Spinner. (The Spinner is usually right.) 
When checking the tuning aurally, pay special attention to the bass-tenor break,
especially intervals that span wire types. Pay special attention to the sound of
consecutive slow intervals such as octave and fifths (and their octave-added
extensions), which can help you detect minutely mistuned unisons that may be
missed when listening to only a single note.

 

Pitch Raise mode is similar to Fine Tune mode with the notable exception of
its use of overpull. Pitch Raise mode is recommended when the tuning (or a few
notes) is 6 cents or more off pitch, either flat or sharp, although it can be used at any
time. Pitch Raise mode works equally well for pitch lowering too. The keyboard
shortcut is “r” or Command + R (Mac) or Control + R (Win). 

 Pitch raising is described at great length later in this section.

Aural Temp. is similar to Fine Tune mode, except that it lets you step through
a sequence for 25 notes (or fewer) that you can specify yourself. The keyboard
shortcut is “A” (Mac and Win) or Command + A (Mac) or Control + A (Win). 

RCT comes with a popular temperament sequence already entered. You can type in
your own sequence in the CE Preferences dialog box, accessed by clicking on the
Preferences button.

The Preferences window displays the current Aural Temperament Sequence.

Twelve different sequences can be created and named. 
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To choose a sequence, hold the mouse down on the popup menu and choose the
desired sequence. 

After a sequence is chosen, you can enter notes into the cells. The sequence starts
at the left cell of the upper row, proceeds rightward to the end of the row, then to the
left cell of the second row, etc . The sequence is automatically saved when you click
“OK.”

To rename a sequence, select that sequence then click the “Edit Name” button.
Any note from A0 to C8 can be entered and any note can be repeated any number

of times. 
When you’re tuning in CE, the Aural Temp. sequence will revert to Fine Tune

mode when it encounters a zero or a blank cell. 
Notes can be entered as numbers (1, 2, 3, ...86, 87, 88) or as note and octave

number (A0, A#0, B0...A#7, B7, C8). Notes entered in number format will
automatically be converted to note name and octave format when the window is
closed.

 In Aural Temp. mode, NoteSwitcher is disabled. To advance to the next note in
your sequence, click on the note-up button or press the computer’s up arrow key.
To go back to a previous note in the sequence, click on CE’s note-down button or
press the computer’s down arrow key.

When tuning in Aural Temp. mode, a black dot is displayed on a note after it’s
been sequenced. Dots are erased when you reverse the sequence (using note-down
button or down arrow key).

     Hint
Create sequences for purposes other than tuning a midrange temperament. For
example, create a sequence to aurally verify a few mid bass double octaves,
parallel 10ths and 17ths across the breaks, and high treble 12ths and 19ths.

CyberEar buttons and boxes

Pitch popup menu

The current pitch of A4 is displayed and re-set in the Pitch popup menu, located
over the Spinner target. 

69

To choose a sequence, hold the mouse down on the popup menu and choose the
desired sequence. 

After a sequence is chosen, you can enter notes into the cells. The sequence starts
at the left cell of the upper row, proceeds rightward to the end of the row, then to the
left cell of the second row, etc . The sequence is automatically saved when you click
“OK.”

To rename a sequence, select that sequence then click the “Edit Name” button.
Any note from A0 to C8 can be entered and any note can be repeated any number

of times. 
When you’re tuning in CE, the Aural Temp. sequence will revert to Fine Tune

mode when it encounters a zero or a blank cell. 
Notes can be entered as numbers (1, 2, 3, ...86, 87, 88) or as note and octave

number (A0, A#0, B0...A#7, B7, C8). Notes entered in number format will
automatically be converted to note name and octave format when the window is
closed.

 In Aural Temp. mode, NoteSwitcher is disabled. To advance to the next note in
your sequence, click on the note-up button or press the computer’s up arrow key.
To go back to a previous note in the sequence, click on CE’s note-down button or
press the computer’s down arrow key.

When tuning in Aural Temp. mode, a black dot is displayed on a note after it’s
been sequenced. Dots are erased when you reverse the sequence (using note-down
button or down arrow key).

     Hint
Create sequences for purposes other than tuning a midrange temperament. For
example, create a sequence to aurally verify a few mid bass double octaves,
parallel 10ths and 17ths across the breaks, and high treble 12ths and 19ths.

CyberEar buttons and boxes

Pitch popup menu

The current pitch of A4 is displayed and re-set in the Pitch popup menu, located
over the Spinner target. 



70

To change A4’s pitch, click on the pop-up menu and select a new pitch, anywhere
from A435 to A444.

 If you select “Other,” a window will open where you can enter a cents offset for
A4’s pitch of plus or minus 1200.00 cents (a total of two octaves!). Any non-zero
Other offset will be displayed in the closed popup menu. When you open the pitch
popup menu (hold the mouse down) the Other setting is also displayed as the
bottommost item. 

For safety, the pitch popup menu defaults to A440 when RCT quits.

If the pitch popup menu is set to a non-A440 pitch, CE gives you an extra
reminder with a # or flat symbol over a grayed tuning fork.

The Offset box can also affect the pitch of CE, so it will display a # or flat symbol
to the right of the pitch popup menu as a reminder.

To quickly reset the pitch popup menu to A440 click the left sharp or flat symbol.

 Mac only: Click on the popup menu. You don’t need to select “A440” or enter
“0.00” in the Other window.

RCT uses the exact pitch in hertz. For instance, A442 is not +8.0 cents, but +7.92
cents (and that’s rounded to the nearest hundredth of a cent!).

If the Pitch popup menu is set to non-A440 or Other is set to non-zero, a sharp or
flat symbol will be superimposed over the tuning fork to the left of the pitch popup
menu. If the Offset box is set to a non-zero number, a sharp or flat symbol will
appear to the right of the pitch popup menu. 

When CE opens, if CE is set to non-A440 (either in the pitch popup menu or the
Offset box) a dialog box will open informing you of this. If you don’t want this
dialog box to appear again during the current CE session, click “Don’t bug me.” If
you want to set CE to A440, click “Reset to 440”. If you want to close the window
and leave CE at its current pitch, click “OK”.

When CE opens, if the linked tuning chart is more than 0.5 beats from 440.0,
another dialog box will appear informing you how many beats off it is. After closing
this box by clicking “OK” you can go to the tuning chart to adjust it to A440.0 if
you’d like. Generally, we recommend you leave all tuning charts at A440.0, and do
your pitch adjusting in CE.
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Tune box

The Tune box displays the cents readings for the selected note, as listed in the
active tuning record. To change the Tune box reading in increments of .1¢, click on
the up or down arrows. To adjust it by .01¢, hold down the shift key and click on
the up or down arrows.

To clear the reading in the Tune box (set it to 0.00¢) click on the Clear button, the
little button to the left with the “C” in it.

To auto-measure a note’s pitch, click on the Tune box Listener (see below).

Tune box key equivalents 
clear Tune Box (reset to 0.00) C (no modifier key) 
Tune box up by .1 cent > (period)
Tune box down by .1 cent < (comma)
Tune box up by .01 cent  shift > 
Tune box down by .01 cent  shift <

 Hint
To undo a Clear on the Tune box (in other words, to restore a note’s Tune Box
reading to its saved reading), switch to any other note then re-select the cleared
noted. This hint works because Tune box readings are not saved until you click
the Save Cents button. If a reading has already been saved, this hint will not
work.

Offset box 

The Offset box is used when you want to change the total deviation without
altering the reading in the Tune box. 

Here’s another way to think about the Offset box: If you add the number in the
Offset box to the number in the Tune Box, the resultant sum is what the Spinner
rotation indicates.

The Offset box reading will be 0.00¢ unless you adjust it yourself. 
Clicking on the Offset box’s up and down arrows will increment the reading by

.1¢. Holding down the Shift key while clicking the up or down arrows will
increment the reading by .01¢. Clicking on its Clear button will set the Offset box to
0.00. (There are no key equivalents for the Offset box Clear button.)

To auto-measure a note’s offset, click on the Offset Listener (described below).

The Offset box is as very useful tool because it affects the Spinner while leaving
the Tune box reading untouched. The Offset box can help you alter the deviation for
one note or an entire tuning, measure deviation from a Tune box reading, measure
drift after a test blow during the RPT Tuning Exam, etc.

The Offset box reading will not change when you switch notes. On the other hand,
the Tune box reading will change when you switch notes because the Tune box
shows the cents deviations calculated by Ch2 and displayed in the active tuning
chart.
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 Hint
If you want to tune to piano to a pitch other than A440, you have two choices —
the Offset box or the Pitch popup menu. 
If you enter and leave a cents reading in the Offset box, every note will be offset
by that amount. 
Your other choice is to use the Pitch popup menu to enter a non-A440 pitch
(such as A439, A438 etc. or a cents offset in “Other”). 

Actually, you can use both the Offset box and the Pitch popup menu at the same
time; the two numbers will add together to create a total pitch offset. If you do this,
the sharp and flat symbols for the pitch popup menu and the Offset box will be
displayed normally — in other words, independently of each other and the total pitch
offset. Using opposite-signed pitch popup menu and Offset box can be confusing,
so please be careful.

Offset box readings are not saved when you click the Save Cents button. Any
reading in the Offset box remains unchanged when you switch notes. An Offset box
clear cannot be undone.

For safety, the Offset box defaults to 0.00 whenever RCT quits. 

Overpull box

When CE is in Pitch Raise mode, the Offset box changes to the Overpull box. The
Overpull box displays two pieces of information:

1. The left box displays the overpull cents which CE calculated automatically.
2. The right box displays the overpull percentage for the selected note.
The reading in the Overpull box cannot be adjusted manually. The Clear button is

not enabled.
It’s OK if you don’t understand this Overpull box explanation. The Overpull box

appears only in Pitch Raise mode, which we haven’t explained yet. Be patient.
You’re just a few pages away.

Tune box Listener

The Tune box Listener automatically measures the pitch of a selected note.
To use the Tune box Listener:
1. Select a note to measure. 
2. Click on the Tune box Listener button. A flashing ring will appear around the

Spinner’s target and around the ear over the graphic keyboard. 
3. Play the note and let it sustain. As the Listener measures the note (a few

seconds in the bass, faster in the treble), the ring around the Spinner will fill in
towards the center; at the same time, rings will flash around the ear on the graphic
keyboard. 

4. After measuring is completed, the Tune box will display the note’s pitch. 
5. To double check the accuracy of the Listener’s measurement, play the note

again. If the Spinner is not perfectly stopped, click the up or down arrows to
manually adjust the Tune box reading until the Spinner is perfectly stopped. 

NoteSwitcher becomes disabled when you click on the Tune box Listener. To re-
enable NoteSwitcher, click on the NoteSwitcher button.
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Offset box Listener

The Offset box Listener is similar to the Tune box Listener with one exception.
The Offset box Listener measures the difference between the Tune box reading and
the note’s actual pitch.

NoteSwitcher becomes disabled when you click on the Offset box Listener. To re-
enable NoteSwitcher, click on the NoteSwitcher button.

 Hint
Repeated Listener measurements of the same note may result in slightly different
readings. This is normal. Piano and piano strings are inherently complex and do
not always generate exactly the same pitch at every instant or at every excitation.
Factors affecting the consistency of a string’s pitch include volume, listening
time, noise, etc. To maximize Listener consistency, play the note at a consistent
mezzo-forte (medium) volume. To further increase Listener accuracy, take three
readings and average them. (This is what Ch2 does when sampling notes to
create a partial ladder, where accuracy is super-critical.)

Save Cents button

Clicking the Save Cents button does the following: 
1. The Tune box reading of the selected note is saved to the proper cell in the open

tuning chart.
2. Noteswitcher switches up one note 
3. And the Tune box Listener is auto-enabled.
The Save Cents button is most often used when recording an aural tuning or

making single note changes to a Ch2 tuning.

To record an aural tuning, make a copy of a pre-existing tuning record with the
desired partials. (If there is no such record, manually modify a new tuning record.)
Save and (re)name it, then open its chart. Open CE. 

To measure the pitch of the first note, select it and click on the Tune Box Listener
to auto-measure it. Play the note again to see the Spinner is stopped; if not, adjust
the Tune Box manually by clicking on its up or down arrows until the Spinner is
stopped. Click on the Save Cents button. Automatically, the reading in the Tune Box
will be saved to the proper cell in the open tuning chart, CE will switch up to the
next note, and the Tune Box Listener will be enabled. Play the next selected note and
continue as above.

Using the Save Cents button, an aural tuning can be measured and recorded in
about 12 minutes. (CTEs using RCT for the RPT Tuning Exam will rejoice in the
time savings!) When you’re done measuring an aural tuning, disable the Listener by
clicking on the Listener button. (Until you do, CE will not function normally
because the Listener will be waiting to hear a note.) Also, click on the NoteSwitcher
button to re-enable NoteSwitcher.
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Manual PR button

Manual PR button is used after setting Tune mode to Manual Pitch Raise in the
Pitch Raise dialog box. Click on the Manual PR button to manually measure the
cents deviation and calculate cents overpull percentage based on that one note (as
opposed to the average of 6 notes, which is the method used the other three pitch
raise modes).

Please see the section on Pitch Raising below for more details.

Prefs button

The Prefs button opens CyberEar Prefs (preferences).

 

Here you can change various settings, described below.
When you change a Default Pref, it will take effect the next time RCT is opened.

Start CyberEar defaults
You can choose the tuning mode and the start note for when CyberEar starts up.

The default setting is Fine Tune mode at A0, but is you prefer something different,
you can change it here.

Calibrate
Clicking the Calibrate button opens the Calibrate dialog box, where you can adjust

the pitch setting of RCT to ±.01¢. This button is used only for calibrating RCT to
compensate for a pitch error in a Windows computer’s hardware. 
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Macintosh 
Macintosh computers are manufactured at correct pitch and don’t require any

further calibration. However the calibration techniques below can be used if you
require unusually high accuracy

 Windows 
Windows computers vary in the accuracy of their internal pitch calibration. To

assure that all laptops running RCT are properly calibrated, Windows users should
calibrate their laptops immediately after installing RCT or after changing the
computer’s motherboard (logic board) or sound card.

A quartz pitch source we call a “CyberFork” (grin) is included with every copy of
RCT. The CyberFork generates a very stable A440 tone that it can output two ways:
electronically and as audio. Each CyberFork has been carefully tested and verified as
stable to ±0.01¢. If the CyberFork has a measurable pitch offset, it’s written on its
back. For example, if the CyberFork’s pitch output is 439.90 Hz, you’ll see written
on its back “-0.40¢.” You’ll calibrate RCT/Win in CyberEar at note A4 at its
fundamental. Therefore, before calibrating your computer, make sure all RCT tuning
files and records are closed before opening CyberEar, which will ensure that A4’s
first partial will be used. 

Your goal is to have RCT measure the CyberFork’s pitch at the same pitch the
CyberFork generates—in other words, after calibration RCT should measure the
CyberFork at the same pitch written on the CyberFork.

The most accurate calibration method is to electronically connect the CyberFork
and your computer using a 1/8” audio cable (included). The direct-connect electronic
method is accurate to about ±0.01¢.

If your computer doesn’t have a mic-in or line-in jack, calibrate your computer
using the A440 audio tone from the CyberFork’s speaker and your computer’s
microphone (internal or external). Because sound can be ever-so-slightly distorted as
it moves through air, calibrating with an audio tone is slightly less accurate than
using a direct electronic signal. But if you need to use the audio tone, don’t fret. The
audio tone method is accurate to about ± 0.04¢, which is still extremely close and
many times more accurate than pianos, metal tuning forks, the human ear, etc.

Calibration procedure
If your computer has neither a mic-in nor line-in jack, skip step 1.

1. Plug audio cable (included) into the CyberFork and into a mic-in (or line-in)
jack of your computer. If necessary, select the proper setting in the Windows
Multimedia Control Panel (Mac in Monitors and Sound or in the Control Strip).

2. Open RCT. (If necessary, close all RCT tuning files and records.) Pull down
the Windows menu and select CyberEar. (If a dialog box appears informing you
CyberEar’s pitch is non-standard, click Reset to 440.) After CyberEar opens, make
sure A4 is selected and the finger under the graphic keyboard points to A4. 

3. Click the Tune Box’s sharp and flat buttons to set the Tune Box to the same
number written on the back of the CyberFork. To adjust the Tune box by 0.01
increments, hold down the Command key (Mac) or Control key (Win) while
clicking a sharp or flat button.

4. Turn the CyberFork’s dial so its red pointer is pointing to A4 (located at bottom
of dial). Set the CyberFork’s side switch to “beat.” The CyberFork will now be
generating an A4 tone. If a cable is plugged into the CyberFork, the signal is being
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sent via the cable and you may not hear a tone. If CyberFork is producing an audio
tone (i.e., you’re not using the cable) let CyberFork warm up for at least 30 seconds
and place its speaker 1”-2” from the computer’s mic.

5. Click the Offset box’s Listener button. CE will auto-measure CyberFork’s tone,
displaying the result in the Offset box. On a piece of paper, write down the reading
that appears in the Offset box. Repeat this test at least ten times, especially if you’re
using the audio tone. Throw out the highest and lowest result, then average them
(add them all up then divide by the number of readings). This is your computer’s
pitch error. 

    

6. Click CyberEar’s Prefs (Preferences) button.

The CyberEar Prefs dialog box will open. Click the Calibrate button. The
Calibration dialog box will open. 

In the Calibrate text box, type in the reverse sign number you calculated as the
computer’s pitch error. For example, if your computer’s pitch error is .98¢, type
into the Calibrate text box -.98¢. Click OK to close the Calibrate dialog box. Your
computer is now calibrated.

7. Back in CyberEar, double check the calibration as follows: Set the Offset box to
0.00 by clicking its Clear button, which is the little button labeled “C” located just to
the left of the Offset box. The Tune Box should still display the reading written on
the back of the CyberFork. The Spinner should be stopped and you should see a full
or nearly full blush, which lets you know that CyberEar is measuring the
CyberFork’s tone at the correct pitch.

8. Turn CyberFork’s switch to off. Unplug cable. If necessary, reset your
computer’s Sound Control Panel.
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Done button

Clicking the Done button closes CyberEar. (It does not quit RCT.) The keyboard
shortcut for closing CE is Command-W (Mac) or Control-W (Win).

The Done button is a CyberEar default button (as indicated by the extra border),
therefore pressing the Return key (Mac and Win) or Enter key (Win) is the same as
clicking the Done button.

 Mac: The Mac’s Enter key does not activate the Done button. This is
deliberate; many Mac users requested this “feature” because they were accidentally
hitting the Mac’s Enter key when using the computer’s arrow keys for
noteswitching. 

Pitch Raising with RCT

Pitch Raise mode is used when the piano (or a few notes) is substantially off
pitch, either flat or sharp. In other words, Pitch Raise mode works equally well for
pitch lowering too. 

There are four Pitch Raise modes: Small, Medium, Large, and Manual. These
pitch raise modes are selected from within the Pitch Raise dialog box, discussed
below.

In Small PR mode (oval scale ± 50¢), and Medium PR mode (oval scale ± 100¢), 
CE “automagically” noteswitches up to the next note, measures its pitch, averages its
pitch with the pitch of the previous five notes (except as described below), calculates
the cents overpull based on a percentage for that note (see overpull percentage charts
below), and offsets the Target. All this occurs automatically and very quickly.

Medium and Small pitch raising procedure:
1. Play the next chromatic note and NoteSwitcher will switch to it.  

(Or play any selected note; chromatic NoteSwitcher won’t work, so you’ll
first have to switch manually.)

2. The note’s pitch will be measured and recorded. Don’t tune the string
until the Spinner ball has filled in completely, indicating CE has
finished recording the string’s pitch and calculating the overpull. This
occurs very rapidly, especially in the treble. After the Spinner ball has filled
in, the deviation of the not-yet-tuned selected note (relative to the Tune box
reading) will be displayed in the “Original ¢” box and a grey box will appear
over the key on the graphic keyboard’s Pitch Raise Progress Bar.
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3. The Target will shift left or right to graphically display the note’s overpull
cents as displayed in the Overpull box.
For example, if 25¢ overpull were calculated, the target would shift to the
right like this:

4. Tune the string until the Spinner is centered on the shifted target and has
stopped rotating. (The Spinner will be a solid ball in Large Pitch Raise
mode or in any mode when you select “Spinner Off” in the Pitch Raise
dialog box. In this case, tune the string until the Spinner is centered on the
shifted target and you’re done.)

5. Play the next note up. NoteSwitcher will automatically switch to that note.
Wait for Spinner ball to fill in as CE records and analyzes this new note’s
pitch raise amount and overpull. The target will shift, you tune the string,
etc.

Large PR is recommended when the piano is 100¢ or more off pitch. The oval’s
scale will increase to ± 200¢. Unlike other PR modes, in Large PR mode no note-
measuring is done. Instead, CE assumes the piano is 100¢ off pitch and overshoots
each note by the same number of cents as its overpull percentage (see Overpull
percentage charts). Depending on where you’ve set the Bass and Treble Overpull
Cap settings in the Pitch Raise dialog box, some notes may have their cents
overpulls constrained. 

In Large PR mode, the Spinner is a solid ball.

Note Tuning Order in Pitch Raise modes
In all pitch raise modes, you should start tuning at note A0 and proceed up the

keyboard to C8, tuning unisons as you go. The overpull percentages used by CE are
optimized for this procedure. Other procedures will be less accurate, probably
requiring more overpull. (If you insist on another procedure, try selecting “high”
overpull percentages in the Pitch Raise dialog box.)

  Hint
You can set each tuning mode to its own color and Spinner rate. Mitch sets Fine
Tune to blue and 2.0¢/rev/sec, Small PR to red and 4.0¢/rev/sec, Medium PR to
green and 8.0¢/rev/sec, Large PR to hot pink (which displays a solid Spinner
ball and therefore needs no Spinner setting), and Manual PR to yellow and
4.0¢/rev/sec.

 Hint 
See “Muting Procedures” in Appendix E for tips on muting technique, making
your own split mutes, etc.
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Overpull Percentages
The following chart and graph show the overpull percentages CE uses when

calculating the overpull cents for each note.
The overpull percentages listed below are applied to the differential between a

note’s original pitch (before you tune it) and its target pitch (where Ch2 calculated it
should be after you tune it). 

  note
oct

C C# D D# E F F# G G# A A# B

 8/0 21 0 4 8

 1 12 12 12 12 12 12 12 12 12 12 12 12

 2 12 12 12 12 12 12 12 12 12 12 12 12

 3 32 31 30 30 30 30 30 30 30 30 30 30

 4 30 30 30 29 29 28 28 28 27 27 27 27

 5 27 27 28 28 29 29 30 30 31 32 33 34

 6 35 36 37 38 38 38 38 38 38 38 38 38

 7 38 38 38 38 37 35 33 31 29 27 25 23

Medium overpull percentages, if the tenor break is at B2/C3.
For high overpull, add 3 to all percentages. For low overpull, subtract 3.

For example, if C4’s original pitch was -20¢ but Ch2 calculated its correct pitch at
+5¢, its differential is 25¢. The overpull percentage for C4 is 30%. Thirty percent of
25¢ is 7.5¢. Therefore C4 will be overpulled by 7.5¢, which means you’ll pitch
raise C4 to 12.5¢. After pitch raising the entire piano, you can expect C4’s pitch to
be very close to 5.0¢. (This simplified example does not include overpull averaging,
explained below, and is therefore for illustration purposes only.)

As you can see, CE uses many different overpull percentages. These numbers
were derived experimentally from data gathered by Dean. He tuned hundreds of
pitch raises, recording the pitches of the notes before and after the pitch raise. After
substantial analysis and ongoing refinement, this chart was created.

These percentages will get most pianos very close most of the time. 

Pitch Raise Percentage Slider
You can change all the overpull percentages in one percent increments as much as

5 percent. In the pitch raise dialog box, Click on the Adjust Overpull % tube or click
and drag the pointer. 
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Custom Overpull Percentage Charts
For even more control of overpull percentages, you can create an unlimited

number of custom overpull charts in which you can write any percentage overpull
for any note. This might be useful if you tune many pianos that behave unusually,
for example if you tune for a busy dealer that sells a model of spinet with unusual
ribbing or scale breaks. 

To create a new Custom Overpull Chart, select Open under the File menu. In the
RCT 3.5 folder, open the folder RCT documents. Open the file Custom Overpull. A
standard RCT tuning file will open, inside of which are two tuning records,
Standard RCT Overpull Chart and Yamaha GH1 Custom Overpull Chart. (The
Yamaha GH1 chart is our best guess for overpulls for the common GH1. You may
use this or create your own for the GH1.) To create a new overpull chart, either
create a new blank tuning record and fill in your own overpull percentages or,
perhaps more convenient, create a copy of the Standard Overpull Chart and modify a
note’s overpull as needed. You can name and save this file using normal RCT
techniques. Please note that custom overpull charts are not affected by Lowest Plain
Wire Note settings in the Pitch Raise dialog box, so the usual large difference in
overpull at the break should be reflected in the overpull chart itself. This means that
each custom overpull chart will probably be usable only on one specific model,
which is why you should name the chart with the model piano it is designed for.

To select a Custom Overpull Chart, select Pitch Raise mode to open the Pitch
Raise Dialog box. Click on the Overpull Chart popup menu and select Custom. A
dialog box will display the available custom overpull charts. Select the desired chart
and click OK, which will return you to the Pitch Raise dialog box. Custom Overpull
charts can be gang-modified up to 5% in 1% increments just like Standard Overpull
setting by using the Overpull % slider.

When saving a Custom Overpull Chart file, it’s a good idea to use the correct file
extension in its name. Use the popup menu and file extension naming button in the
Save and Save As.. Dialog boxes to help do this.

Overpull Averaging
The previous five notes’ original cents are averaged in with the original pitch of the

selected note before CE applies the appropriate overpull percentage. This improves
the accuracy of the pitch raise by smoothing out the overpull cents for any single
note that might be abnormally sharp or flat. 

Technical explanation: Soundboard deflection is not single-point; the stiffness of
the soundboard assembly (soundboard, ribs, and bridge) spread out the change in
string plane downforce during pitch raising. In other words, a change in one note’s
downforce will deflect the soundboard assembly throughout approximately a half
octave range. The notes above the selected note will change pitch too, but these
changes are already compensated for in CE’s overpull percentages.

Exceptions to Overpull Averaging
A note with no pitch measurement (not recorded properly or skipped) won’t

display a grey area in its progess bar. Any such note will not be included when
averaging overpull for subsequent notes. This feature (new in 3.5) increases the
accuracy of the overpull averages. It means that if you switch from Fine Tuning to
Pitch Raising in the middle of a tuning, the first five notes being pitch raised will not
have their overpull incorrectly deflated by including empty (zero) readings for
previous notes.

Overpull averaging also works from the highest bass note (just below the LPWN)
to the lowest bass note (A0).
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Low bass overpull averaging
The number of notes included in overpull averaging starts at zero at note at A0 and

increases note by note until five notes have been tuned. For example:

A  0 0% overpull
A#0 4% including the previous note
B  0 8% including the previous 2 notes
C  1 12% including the previous 3 notes
C#1 12% including the previous 4 notes

The rest of the bass is overpulled 12% including the previous 5 notes’ average.

Lowest Plain Wire Note averaging
Pianos have two bridges (usually). The bass and tenor bridges are not connected

and are at different locations on the soundboard. Therefore, on many pianos in need
of pitch raising, the bass and tenor sections have drifted at different rates and react
differently to the change in tension during a pitch raise. If bass notes were included
in the overpull average of low tenor notes, it would decrease the accuracy of a pitch
raise for the tenor notes. Therefore starting at the lowest plain wire note (LPWN),
no previous notes are included in the overpull calculation. On the next five notes, a
trailing average is phased in (similarly to the low bass as described above).

LPWN 32% overpull
LPWN+1 31% overpull including the previous note
LPWN+2 30% overpull including the previous 2 notes
LPWN+3 30% overpull including the previous 3 notes
LPWN+4 30% overpull including the previous 4 notes 

The rest of the notes include the previous 5 notes in their overpull calculations.
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Pitch Raise Dialog Box
When you select Pitch Raise mode in the pop-up menu, the Pitch Raise dialog box

appears. Here’s where you set the parameters for your pitch raise.

Lowest plain wire note (LPWN) tells CE where to change from 12% to
32% overpull. Experienced tuners know that unwound strings in the low tenor need
more overpull than the upper bass wound strings. Type in the number or note name
and octave of the lowest plain wire note in this box or use the down/up arrows.

 The LPWN is indicated on the CE graphic keyboard with a small triangle.

 Hint 
Lowest Plain Wire Note is very important. Always make sure it’s properly set
and double check it from CE with the triangle over the graphic keyboard.
Usually, LPWN will be the only thing you change in the PR dialog box.

Bass overpull cap and Treble overpull cap limit the cents overpulls during
pitch raises to help prevent string breakage. Default settings are 5¢ in the bass (notes
below LPWN) and 25¢ in the treble (LPWN and above). After you get comfortable
with pitch raising with RCT, you might want to raise these to 10¢ in the bass and
30¢ in the treble. Recommendations: Higher settings are OK on newer pianos; if you
come across a piano with rusty strings, use smaller settings. 

Maximum allowed settings are 25¢ in the bass and 50¢ in the treble.
During a pitch raise, whenever a note’s calculated Overpull (in cents) exceeds the

Bass or Treble Overpull Cap (in cents), the numbers in CE’s Overpull box’s turn
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red. This helps you know that RCT is doing its job to help prevent string breakage
and, consequently, these notes may not be as close as usual during your subsequent
Fine Tune pass. If some notes are more out of tune then normal during Fine Tune,
you can switch to Pitch Raise for a while then back to Fine Tune mode.  (RCT 3.5
ignores any zero reading when calculating Pitch Raise mode’s traling average, which
enhances the accuracy of overpull calculations if you select Pitch Raise mode during
a Fine Tuning or get a non-reading of any note during pitch raising.)

Pitch Raise Type

Small calculates cents overpull based on the average differential of the selected
note and the 5 previous notes (except as noted above). Small PR is most appropriate
for pitch adjustments of less than approximately 60¢, although it can be used at any
time.

Medium calculates cents overpull based on the average differential of the selected
note and the 5 previous notes. Medium PR is most appropriate for pitch adjustments
of less than approximately 60¢ to 100¢, although it can be used at any time.

Large calculates a pitch raise without measuring. It assumes the piano is 100¢ off
pitch and applies the percentage overpull for each note. This usually results in cents
overpulls that equal the percentage overpulls. The cents overpulls may be less than
the percentage overpulls depending on what you’ve specified in the Treble and Bass
Cents Maximums in the Pitch Raise dialog box.In Large PR the span of the oval is
plus or minus 200¢.

Large PR is most appropriate for tuning pianos that are off pitch 100¢ or more. 
In Large PR mode, the Spinner doesn’t rotate but appears as a solid ball. To

indicate deviation, the solid Spinner ball moves left or right. This feature is designed
to encourage speedy pitch raising; if the Spinner doesn’t rotate, you may not be
tempted to spend as much time trying to perfectly tune the string.

Manual  calculates cents overpull as a percentage of a selected note’s original pitch
deviation (unlike Large PR and Small PR, which use an average of the original
pitches of the selected note and the 5 previous notes). 

In Manual pitch raising, pitch measuring happens only when CE’s Manual PR
button is clicked. 

This original pitch is then used to calculate overpull cents for all notes (or until the
Manual PR button is clicked again) using the overpull percentage chart (Overpull
percentage charts above). Click on the Manual PR button at any time to record
another original pitch.

Overpull % lets you vary the overall pitch raise overpull by +5% to -5% in 1%
increments. This changes the overpull percentages in group fashion, in other words
adds (or subtracts) 1 to 5 percentage points from the standard overpull percentages.

Tuning techniques vary and so do pianos. For some pianos or piano tuners the
standard amount of overpull may be too much or too little. It’s not unusual for
lightly built pianos (spinets, consoles with no backposts, etc.) to drop more during a
pitch raise or for strongly built pianos (massive concert grands, pianos with ultra-
stiff or old soundboards) to drop less. It’s also not unusual for some tuners to find
that their pin-setting technique favors a different overpull setting that RCT’s
defaults. 
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To adjust the overpull perncentages for all notes, click and drag the pointer or click
on the slider. This new setting will increase or decrease the overpull percentages for
all 88 notes equally. This setting will apply to both a Standard or a Custom overpull
chart.

You can change the Overpull Percentage at any time, such as in the middle of a
pitch raise. (If you want to do this, be sure to click “OK” and not “Start New” when
exiting the Pitch Raise dialog box.) The Overpull % setting will normally return to
zero when RCT quits; if you’d rather have a non-zero percentage always be the
setting for the Overpull % slider, set the slider where you want then check the box
“Save as default.”

 Hint 
RCT’s pitch raise percentages are optimized for starting at A0 and tuning
unisons as you go. If you use any other method, such as tuning one string per
note then pulling up the unisons, you’ll probably need more overpull. To
compensate, use a higher overpull %, especially in the treble. (And be prepared
to make an extra pass to compensate for the possible decreased accuracy.)

Notes Recorded
Just above the Start New and OK buttons is the “Notes Recorded” box, which

displays the number of notes that have already been measured and recorded during
the most recent pitch raise. The number in this box will exactly correspond to the
number of notes over which appear the Pitch Raise Progress Bar. This information
can help you decide whether to click on the “Start New” or “OK” buttons (see
below).

Start New and OK buttons

As you may recall, to help create smoother and more accurate pitch raises in
Medium and Small pitch raise modes, the original cents readings of (up to) five
previous notes are saved and averaged with the selected note.

These five previous note readings are automatically erased when you quit RCT.
But you may want to pitch raise another piano without first quitting RCT, so we
need a way to make sure the five previous notes from pitch raise #1 don't get
averaged in with any notes from pitch raise #2.

RCT helps you manage this with the Start New button and OK button in the Pitch
Raise dialog box. Clicking on Start New button erases all previously recorded notes
so you can start a new pitch raise. Clicking on OK retains all previously recorded
notes so you can continue on with your present pitch raise.

Depending on certain conditions, either button may be the default button. (A
default button has a darker border.) The default button is the one you’ll usually
want, and you can select it by pressing the Return or Enter key or by clicking on it
manually.

To leave things as they are, click Cancel.
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Info during Pitch Raising
Lots of interesting numerical data is displayed in CE while pitch raising: 

• The Tune box displays the selected note’s cents deviation as calculated by Ch2
(or other source).

• The Overpull box displays the note’s calculated cents overpull.
• The selected note’s specified Overpull percentage is displayed to the right of the

Overpull box.
• The (not yet tuned) selected note’s cents offset from the Tune box reading is

displayed in the “Original ¢” box.
• The Pitch Raise Progress Bar is filled in above each note that’s already been

measured.
• The Spinner target is shifted to the right matching the Overpull box.

Pitch Raise Progress Bar 
In Pitch Raise mode, a grey bar called the Pitch Raise Progress Bar appears over

each key on the graphic keyboard after the note has been measured and its overpull
calculated. 
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To erase a note’s measurement, click on the Progress Bar immediately above the
note; the grey area over the note will become blank to indicate the note’s
measurement has been erased. (The grey area over each note is fairly small, and it
may take you a few tries before you learn where to click.)

Click on the Progress Bar to erase and re-record a note if its measurement was
faulty or incorrect, for example if CE accidentally was set to the wrong note, if you
played the incorrect note, or if you accidentally measured a string of an A you’d
previously tuned to pitch to allow taking samples prior to a pitch raise. 

LPWN indicator triangle
A triangle over the graphic keyboard indicates the Lowest Plain Wire Note

(LPWN) that you specified in the Pitch Raise dialog box. Since the pitch raise
overpull percentage changes from 12% to 32% at the LPWN, it’s a good idea to
check the triangle to make sure the LPWN is set correctly.

Pitch Raising tips 
A tuning record must be used when pitch raising. Why? Because there must be a

target pitch for CE to overshoot for each note. Pitch raising is a relatively imprecise
process, so the accuracy of this tuning record is not crucial. It’s OK to use a tuning
record from another piano (one of Ch2’s Demo pianos?) of a similar model. After
the pitch raise is completed, we recommend you create a new tuning record with
samples from the piano you’ve just pitch raised.

More pitch raising tips: 
1. Keep your eye on the Note Selection Box when pitch raising to make sure

NoteSwitcher is on the correct note and switching properly (especially in the bass,
where it sometimes grabs onto a note a minor 3rd below where you think you are).
NoteSwitcher can't see what note you're playing; it just hears a pitch and assumes
it’s the note closest to the readings in the tuning chart. To prevent accidents, you
might want to disable NoteSwitcher or set it to up-only. (It defaults to up-only in
Medium and Large PR mode.). It's easy to switch notes manually — just press the
right arrow key conveniently located at the lower right corner of your Computer’s
keyboard, or press the space bar. You can also switch notes by positioning your
cursor over the “note up” on-screen navigation button and tapping the mouse button
with an index finger. In CE, if any arrow key or the space bar is held down it'll
switch repeatedly. The repeat speed is set in the “Keyboard” control panel under the
Apple menu. The mouse button is single-switch only. 

2. Tuning records used during a pitch raise can come from several sources: 
• an already-saved record from a similar model piano (maybe from the Chameleon

2 Library if it came with your purchase of RCT) 
• a new tuning record you just calculated (if necessary, after pulling up the A notes

to rough pitch —see next hint).
• a new tuning record you just calculated using A# notes (!) for samples.
After the piano is at pitch, we strongly recommend you to create another tuning

record to use for your Fine Tuning pass. Why? Because a piano's inharmonicity is
affected by tension of the string, so after a pitch raise, a string's partial ladder may
have changed significantly. Furthermore, some thoughtful piano “engin-ears”
suspect inharmonicity is affected by the stiffness of the soundboard, which varies
with downforce, which is affected by overall string tension. So for maximum
accuracy, we recommend you calculate a new tuning record after a pitch change of
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10¢ or more. This effect has been noticed in climates where a piano's pitch changes
a lot between seasons. 

3. Sometimes, a note's pitch is so low it won't trigger Pitch Raise mode's
"original pitch" measurement; in other words, the Spinner ball won't fill in. The
outer limit for triggering notes is about 50¢ in the bass; in the treble it's about 80
cents. If you encounter this problem, try tuning the note up slowly until it triggers
the ball to fill in. Once it triggers, stop raising the string's pitch till measuring is
completed (as indicated by the Spinner ball being filled in and the Original Pitch box
has a new reading). Another trick is to set NoteSwitcher for up-only and to manually
noteswitch up (press the spacebar or the up arrow key), then play the note.

4. If you'll be creating another Ch2 record for Fine Tuning, don't bother typing
any info in the header of the pitch raise tuning record. Later, remove all headerless
tuning records (those with no letter in the piano icon) by using the tuning hammer
pointer to highlight them and select "Clear" under the Edit menu. (Another hint: If
you first alphabetize all records in a tuning file with the Sort command under the
Tools menu, all your headerless tuning records will be grouped together as the
lowest numbered records.)
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chapter 4

EDITING FILES AND RECORDS

To avoid duplication, some information that might normally be expected to appear
in this chapter is instead included in chapter 2 “Chameleon 2” including tips on
organizing files and records . We suggest you read both chapters.

A tuning file can be displayed in two views — Icon view or Header view.
A tuning record can be displayed in two views — a Chart or a Graph window.

Chart view
A tuning chart looks like a spreadsheet. 

   To identify the note for each cell, look at the left of each row to see the note name,
and look at the top of each column to see the octave. The number at the right of each
cell is the cents readings; the single digit number to the left is the number of the
partial Ch2 uses for that note. Position the cursor over a cell and a small box at the
top of the Tuning Chart window will display the note name and octave number. For
ease if identification, the cell for A4 is highlighted with a bold border.

Pull down the View menu and notice that Partial Numbers is already selected.
Select Partial Name to cause the partials to change to note-and-octave designations.
This allows you to see the exact note Ch2 uses as a tuning partial. 

There is also a header box in which you can type up to 70 characters. RCT’s
“Search...” command looks for matching characters in the header, so what you type
into the header can be useful later when you want to find a specific tuning record.
You might want to type in the model of the piano  (eg, “Steinway D” or “Lester
spinet”), the piano’s serial number (123456), and maybe the customer name (e.g.,
“Mary Smith” or “Acme Concert Hall”. (For a more complete discussion of using
headers and organizing files and records, see chapter 2 “Chameleon 2”.)

By clicking on the arrows at the upper left, the pitch of the entire tuning is
adjustable from A390 to A490 by one-tenth of a beat. To adjust the pitch of A4 by 1
cent (approximately 1/4 beat) press the Command key (Mac) or Control key (Win)
while clicking a pitch arrow key. You can edit the number in any cell in the chart. 

Naturally, any changes you make in the chart can be saved. If you don’t want to
save your changes, close the file and click the “Don’t Save” button when you’re
asked if you want to save changes. You can also pull down the File menu and select
“Revert”, which will display the file as it appeared when last saved. 
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The File menu has an Import... choice for importing files from the older RPS
software program “Tuning Manager”. RCT (on any platform) can import TM files
saved by TM/Mac or TM/DOS.

RCT supports exchanging tuning files between Mac and Win, here’s how:

 RCT/Mac users can do a File Save (or Finder copy) to a IBM formated floppy
disk using file names such as “TUNINGS.RCT”. The file name can be any length
and upper or lower case doesn’t matter. Just add the extension “.RCT”, “.HST” or
“.EXM”. Make sure to enable the extension called “PC Exchange” to allow the Mac
to read and write to IBM formatted disks.

 RCT/Win users should see RCT/Mac or TM documents appear with the
correct icon if RCT was installed with the RCT installer, and if the documents have
the correct extension, “.RCT”, “.HST” or “.EXM”. If not, try installing RCT again.

Graph view

After a chart is open, selecting “Graph” in the windows menu or clicking on the
“Graph” button takes you to a graph for that record. Any change in the chart is
instantly reflected on the graph. A chart and a graph can both be open at the same
time. 
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The graph displays the same information in the chart. Because different partials are
used depending on a note’s location (eg, partial 6 for A0 to G#2, partial 4 for A2 to
G#4, etc.), the graph displays a separate line for each partial and identifies the partial
at the right of each graph line. 

Any change made in the chart is automatically reflected in the graph. If a chart and
a graph are open at the same time, any change made in a chart will be displayed on
the chart after advancing to the next note or pressing “Enter”. The graph is not
directly editable. 

To view the graph or chart of the previous or next tuning record, hold the
Command key (Mac) or Control key (Win) and press the left or right arrow keys.

Interval Preview Graph and Partial Preview Graph
In RCT 3.5, two new graphs are available. The Interval Preview Graph and the

Partial Preview graph display data about the most recently sampled piano or the
current Demo piano without first needing to click the Calculate button.

Under the Windows menu, the Interval Preview Graph and the Partial Preview
Graph let you virtually “pre-listen” to the tuning. These graphs are “live,” which
means they are automatically (re)calculated immediately after sampling a piano or
selecting a different OTS or partial. In other words, you don’t need to click Ch2’s
Calculate button first. That’s why they’re called “Preview “ graphs. This is different
from Ch2’s Tuning Graph, which is updated only after clicking Ch2’s Calculate
button. CEQ’s Aural Intervals and Difference graphs are also “live,” meaning they
too are automatically updated after any change in a sampled piano, OTS, CEQ slider
setting, or partial. 

The Interval Preview Graph displays predicted widths of the most important
intervals in either beats or cents and can be displayed relative to the lower or upper
note. You can view this graph in two sizes, 100% (standard) or 200% (expanded)
for finer detail. Selectable intervals are 5ths (3:2), 12ths (3:1), 4ths (4:3), Major 3rd
(5:4), 10ths (5:2), 17ths (5:1), Octaves (2:1), Octaves (4:2), Octaves (6:3), Double
Octaves (4:1), Triple Octaves (8:1), and minor 3rds (6:5). Intervals are displayed in
different colors denoting intervals types as defined in Pianalyzer.

The Partial Preview Graph displays all the possible tuning curves for the
sampled piano using the OTS settings chosen in Ch2. Each curve is displayed in the
color “family” used in PAZ and the Interal Preview Graph. The sections of the
Partial curves with bolder (boxed) graphlines indictate the current settings for the
chosen OTS and partials; in other words, the boxed area of the graphlines the Partial
Preview Graph are exactly the same curves displayed in the familiar Tuning Graphs.

How to Interpret the Interval Preview Graph
The Interval Preview Graph (IPG) can help you “pre-hear” the beat speeds of

your favorite aural intervals before you tune the piano. After viewing the IPG, you
may decide to select another OTS, use CEQ to customize the tuning, set User Limits
to another setting. Or it may alert you to a potential problem somewhere on the
keyboard that you want to aurally verify and, if necessary, corect by ear during (or
after) the tuning process.

Tips:
• Smooth curves in beat speeds of the 2:1, 4:2, and 6:3 octaves indicate a well-

scaled piano.
• Parallel curves for 3rds, 10ths, and 17ths also indicate a well-scaled piano.

Sometimes the 10ths will show a spike near A4; this in normal and sounds just fine.
To view the relationship of these curves more easily, select the “Lower” note radio
button.

• Look at the curves for 5ths and 12ths. On grands and well-scaled verticals these
curves will be smooth and stay narrow (negative beats) or close to pure. If they are
positive or non-smooth it means the 5ths and 12ths are wide, instead of narrow as
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they should be. This may occur in short-scale pianos such as spinets. RCT’s Limits
function automatically creates the best compromises in the tuning calculations for
such poorly scaled pianos, so there may be nothing you can do to improve the
tuning (although you can try using a wider Bass SOM setting in User Limits in CEQ
or a wider OTS). At the least, you should aurally verify the notes where the curves
are positive or non-smooth. To better gauge the beat speeds of these slow-beating
intervals, choose the expanded 200% view radio button.

How to Interpret the Partial Preview Graph
Experience is the best teacher for learning how to use the Partial Preview Graph

(PPG). A great way to start is to look at Tuning Graphs (post-calculation) of saved
tunings. For instance, if you have a large Tuning Library, open the first tuning
record, go under the Windows menu and select Tuning Chart, then page through the
library by depressing the Command (Mac) or Control (Windows) key and pressing
the left or right arrow keys on your computer keyboard.

You’ll notice that well-scaled pianos have curves that are relatively parallel. In
other words, the curve for notes using the 6th partial will have a similar slope to the
curve for notes using the 3rd partial, etc. You’ll also see that well-scaled pianos
curves have nearby endpoints (indicating consistent inharmonicity) are valley-shaped
(indicating normal amounts of inharmonicity), and have smooth curves in the low
bass and high treble (assuming a moderate OTS such as OTS 4). To illustrate this
point, using the Demo button in Ch2, create some Partial Preview Graphs (or
Tuning Graphs) for the Kimball spinet, and notice how these curves differ from, for
example, the Steinway D using the same OTS. Then make a similar set of tuning
graphs using OTS 1 and OTS 9 and compare them to each other and with the
different piano types.

The Partial Preview Graph, therefore, can be used to help you analyze the scale of
the piano and let you know if the tuning needs to “massaged” by RCT’s Limits,
which occurs automatically, or even moreso by using your ears and RCT’s
customizable settings.

Formats allowed
Reyburn CyberTuner® can save tuning records created by Ch2, Ch1, and an SAT.

RCT lets you to manually create a tuning record by typing in cents readings and
partials.

CyberEar can use tuning records created by Chameleon 1, Chameleon 2,
Fairchild,  FAC, manually entered, or recorded aural tunings.

Overview of files and records
One tuning file at a time containing up to 240 tuning records can be opened for

viewing, editing, etc. You may create as many tuning files as your disk space will
allow. A tuning file can be viewed in two ways: Icons or Headers. 

When a file is opened (or tunings are received via MIDI), a File window is
opened. This window gives an overall view of the tuning records in a tuning file. 

Each small grand piano icon represents a piano tuning record. If a valid record is
present, the icon displays the first byte of the header (whatever you’ve entered,
usually the piano make) and an eighth note. If an invalid or empty record is present,
the icon is empty.

The File window (in View Icons) allows moving records within one file or to
another file. Each piano icon is treated like a single character in a word processor. A
tuning file can be treated as a contiguous list of separate items, corresponding to a
sentence in the word processor.
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To move records in the File Window (cutting, copying, pasting, etc.) use the
Tuning Hammer pointer . When you want to view the whole tuning chart,
choose the Magnifying Glass  and click on the desired tuning’s icon. 

 Hint 
To bring up the Tuning Chart window, press Command (Mac) or Control (Win)
while clicking the mouse button on an icon or header. The magnifying glass
appears momentarily, followed by the Tuning Chart window. When you return
to the File window, the cursor will still be the tuning hammer.

Icon View Editing Features

Use the Tuning Hammer pointer  for moving (copying, pasting, etc.) entire
tuning records. Select a record or records, then cut or copy, click at desired new
location, and paste.

There are three ways to select the Tuning Hammer pointer:
1. Click on the Tuning Hammer icon in the file window, -or-
2. Choose “Tuning Hammer” in the View menu, -or-
3. Press Command + T (Mac) or Control + T (Win).

Some standard editing techniques:
• Undo/Redo, Cut, Copy, Paste, Clear, and Select-All
• Click-drag to select groups of tuning icons.
• Shift-click to select multiple records. Discontinuous selections are supported.
• Shift-arrow keys can be used to make a selection.
• Insertion point can be moved with the arrows keys or mouse, and is used to

indicate where to paste (if no selection).
• Erase data (a special RCT feature) will erase all data in all selected tunings.

Icon View 
When a pointer is over a record, the tuning record number, header, and serial

number are displayed at the top of the file window.
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The number of a particular tuning record can be determined by pointing at it with
the mouse and looking at the top-left corner of the file window, or by adding the
numbers at the left of that row and at the top of the column.

The total number of tunings in the file is shown at the bottom of the window.
The window can be resized, but can be no smaller than is needed to view all tuning

icons in the file.

Double click on a tuning record’s icon to view its Chart. The icon representing the
record currently in the Chart window will have a “marquee” or “marching ants”
around it, even if the File window is not active. 

Erase Data under the Edit menu erases all text from the selected record’s (or
multiple records’) header, sets all 88 partials to 1 (fundamental), and sets all 88 cents
settings to 0.0 without removing the tuning record from the file. 

Erase Data is different from Clear. Clear (like Cut) reduces the number of tuning
records in the file; Erase Data does not. 

If you make a mistake with Cut or Clear, you can always Undo or Redo your most
recent action, or Revert to the last saved copy.

Cut, copy and paste uses a private RCT clipboard for tunings. The clipboard is
available only within RCT, and can’t copy and paste into other programs.

The small eighth note symbol inside a record’s icon indicates whether there is any
data in a specific sample note (C4, which is middle C). RCT does not check for data
in every cell because this would slow the program down unnecessarily. RCT checks
only the sample note since this is a commonly used temperament note and is unlikely
to be blank in an actual piano tuning. If the sample note’s cents is 0.0 AND partial is
1 (fundamental), then RCT does not display an eighth note in the icon.

The view can be toggled between Icons and Headers with the view menu or by
using the short cut Command + I and Command + H (Mac) or Control + I and
Control + H (Win). 

Header View
Any number of tuning headers to the maximum file size of 240 can be viewed. The

header view window can be resized but can be no smaller than is needed to view all
tuning icons in the file (if the view were set to icons). The same tunings that are
selected in icon view will be selected in header view. The selection can be extended
by shift-clicking with the Tuning Hammer. 

Full editing is allowed in Header view. Use the Tuning Hammer pointer to select
records, then use the edit commands cut, copy, paste, or clear.

Header view is especially useful for printing out a list of tuning records. Choose
Print from the File menu to print 60 headers per page. 

Command + click (Mac) or Control + click (Win) on a header with the Tuning
Hammer cursor or click with the Mag Glass cursor to open its tuning chart (just like
in icon view).

Chart Window
Header and Serial Number
The “Header” is a 70 byte field which tags along with the tuning wherever it goes.

RCT’s predicted beat rates and the tuning chart’s creator (usually Ch1 or Ch2) are
entered automatically; you may have added the piano make and serial number,
customer name etc.. If you are new to RCT, you will probably want to edit the
header on tunings transferred from any other VTD. 
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In the Chart window RCT displays all the information stored in one tuning record.
Use the chart for viewing and editing any note’s cents reading.

Partials can be viewed by Partial (Note) Name or Partial Number. Make your
selection from the View menu or use the Command keys on the View menu.

For each of the 88 notes two pieces of information are listed; 1. Partial, 2. Cents

1. The partial is the “listening note”, the note that appears on the CyberEar graphic
keyboard with a colored dot on it and the partial number under it. In RCT the partial
can be viewed as a partial note name (A2, E4, etc.) or as a partial number (1,2,4,6,
etc.), and can be “toggled” in the View menu.

2. The Cents is the same number that appears in CyberEar’s “Tune” box. It is the
deviation from theoretical pitch. There are 100¢ in a theoretically perfect semitone,
and 1200¢ (12 semitones) in a theoretical octave. Of course, real-life pianos never
tune theoretically. 

The note name or field name that the I-beam cursor is hovering over is always in
the small box in the upper left portion of the tuning chart window. The note name
can also be determined by the row and column headings. The column headings are
the octave numbers. 

The first column includes octave 0 and octave 8, since octave 0 only has 3 notes
(A0, A#0, and B0) and octave 8 has just one note (C8). The highlighted note in the
middle of the window is pitch standard A4, which is usually tuned to 440 Hertz. 

The note name is the note being tuned. This corresponds to the note which appears
in the center box in CyberEar.

All the data can be edited in normal Mac/Win fashion. The following standard
editing keys are implemented to move between fields:

TAB key: Forwards editing to the next field to the right, or if at the end, to the next
line down.

RETURN key (Mac) or ENTER key (Win): If editing the partial field, this key
moves you forward so you can edit the cents field of the same note. If editing the
partial field, it will forward to the partial field in the next note up chromatically.

UP and DOWN arrow keys: move editing to the appropriate field in the direction
of the arrow.

ENTER key (Mac only): Press this when you are done editing. It simply locks
in the changes for the current field, and quits editing.

The small line which appears between the partial and cents fields when editing
reminds the user that the two fields are separate.

 Hint
To view the chart or the graph of the previous or next tuning record, press the
Command key (Mac) or the Control key (Win) while pressing the left or right arrow
keys.
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Partials used by Reyburn CyberTuner®

name partial number interval half steps
from partial 1           from partial 1

1st Sub-Partial  -1 1 semitone below fundamental  -1
Fundamental   1 0    0
Second   2 1 octave 12
Third   3 1 octave + fifth 19
Fourth   4 2 octaves above 24
Fifth   5 2 octaves + major third 28
Sixth   6 2 octaves + a fifth 31
Seventh   7 2 octaves + a seventh 34
Eighth   8 3 octaves 36
Ninth   9 3 octaves + 2 semitones 38
Tenth 10 3 octaves + a major third 40
(11 Semitones) 11 1 octave - 1 semitone 11
Twelfth 12 3 octaves + a fifth 43
(23 Semitones) 13 2 octaves - 1 semitone 23
Fourteenth 14 3 octaves + seventh 46
5th Sub-Partial  -5 5 semitones below  -5

 If you are typing the partial number (as opposed to the partial note name) into the partial
field, RCT will use the number listed under the “Partial Number” column. Not all these
are actual partials; some are for use in organ tuning, especially -1, 11, and 13?

Changing Pitch
Using the pitch change control buttons at the top of the tuning chart window, the

tuning can be raised or lowered in pitch by any number of beats per second (bps) or
Hertz (Hz) in 0.1 increments. This corresponds to 0.4 cents. Click once for 0.1
cents change, or hold the button down (just like the cents buttons in CyberEar) to
change the pitch a larger amount. To increment by .01 bps, press the Command key
(Mac) or Control key (Win) or Shift key (Mac and Win) while clicking a pitch
control arrow. All 88 notes are changed simultaneously. The pitch can also be
changed by simply selecting the text in the box underneath “A4 Hz:” and typing in
the desired pitch.

Frankly, we recommend you leave the tuning chart at 440 and make all your pitch
changes in CyberEar. The only instance we recommend changing the Tuning
Chart’s pitch is for a specific piano which will always be tuned to non-A440.

Tuning Type
Next to the Change Pitch box is another box that displays the probable origin or

usage of the record in the tuning chart. RCT makes an educated guess by examining
the partials. RCT recognizes the following types:

1. Exam (Piano Technicians Guild Tuning Exam)
2. Chameleon (Reyburn Piano Service)
3. FAC (Inventronics)
4. Fairchild (Steve Fairchild super-tuning)

Using The Graph
From the tuning chart window, press the GRAPH button 
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 or choose the Window menu Graph item to see a graph of the tuning in the tuning
chart window. The two windows can be viewed at the same time if you have a large
enough screen (or two monitors), and any change in the tuning chart numbers will
immediately be reflected in the graph!

When you view the graph of a piano tuning you normally see several “curves” or
lines which end with a number to the right. This number is the partial number of the
notes to the left. The graph function adds another dimension to piano tuning. After
you have seen a number of tunings graphed it is possible to quickly spot errors in a
tuning. Look for these irregularities:

1. A partial number out of place or extra; may mean a partial that is in error.

2. A steep “spike” in the graph may indicate an error. Some pianos will have a
rather bumpy tuning curve to keep the aural check proper, so be careful what you
assume is a mistake!

3. Unusual partials such as 9 or 11 may indicate an error.

4. Partial numbers scattered around or on top of a curve, partials usually only
change every octave or two.

Search Menu
“Find Tuning...” and “Find Again” will locate a specific tuning in the currently

open tuning file. The 70 byte header attached to each tuning will be searched for any
combination of characters. You can enter a search phrase of any length, and it will
be found no matter where in the header it’s located. The search is non-case sensitive
(upper and lower case differences are ignored).
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chapter 5

TOOLS MENU

 If you want to undo changes made by any item on the Tools menu, use the
File/Revert function (assuming you saved the file) or the MIDI Receive function, if
you just received the tuning file via MIDI. It may be advisable to save the file just
prior to using any of these tools, in case you change your mind. The Edit menu’s
undo only applies to items on the Edit menu.

Sort
The Sort tool puts all tuning records in the open tuning file into alphabetical order

by header. RCT uses all 70 bytes of the header for sorting. 
Records with blank headers will be sorted to the front. This can be useful for

housekeeping. If you create a record that you don’t plan to keep (e.g., to try out a
new OTS ), leave its header blank. After sorting, you can drag the tuning hammer
pointer over all the blank records to select them all at once, then under the Edit menu
select Clear. The selected records will poof! vanish.

Math Tools
The math tools Average, Difference, and Sum will perform calculations on the

cents values of two (Difference and Sum) or more (Average) tuning records, then
place the results into a third tuning record. All the records must have the same
partials on all notes. Use the tuning hammer in File view to select two records as
you would for a copy or cut operation, then select the Math tool. RCT will
automatically create a new empty tuning record and place the results in it.

The Average tool takes two or more selected records and averages the cents
values for each note. This is very useful for creating a generic tuning record from
several aural or calculated tuning records of the same model. The Average tool can
also be used when tuning two or more different models together — average all the
tuning records and tune all pianos to the average. (Of course, if the pianos are of
wildly different sizes or types, neither piano may sound perfectly in tune with itself.
But if you’re in this situation, there’s no perfect solution anyway.)

The Difference tool requires that two and only two  pianos be selected. Then it
takes the first tuning and subtracts the cents values in the second tuning. For
example, if you select tunings 1 and 2, choose Difference and choose to place the
result into tuning #3, RCT will do the following:

T1 - T2 = T3

Each note’s cents value in tuning number 2 is subtracted from the same note’s
cents value in tuning number 1 and the result is stored at the same note in tuning
number 3.

This tool can be useful for comparing two tunings, since the difference can be
graphed!

The Sum tool requires two, and only two pianos be selected. This tool then takes
the first tuning, and adds the cents values in the second tuning to it. For example, if
you select tunings 1 and 2, choose Sum, and choose to place the result into tuning
#3, RCT will do the following:

T1 + T2 = T3
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Each note’s cents value in tuning number 1 is added to the same note’s cents value
in tuning number 2, and the result is stored in the same note in tuning number 3.

This tool can be useful for modifying tunings is special ways, such as custom
historical temperaments that use more than 12 offsets.

Historical Temperaments
The Historical Temperaments tool will covert an equal temperament tuning record

to one of 57 built-in historical temperaments described in the classic reference
“Tuning” by Owen Jorgensen.

Open the chart or graph of a tuning record or use the tuning hammer pointer to
select a record from a tuning file. Pull down the Tools menu and select Historical
Temperaments. A dialog box will appear. The record number of the tuning about to
be converted will be shown in the “Convert Tuning” box. If you want to convert a
different tuning, enter the number of that tuning record into the Convert Tuning box.
Select a historical temperament from the scrolling window. “Page” is the page
number from Owen Jorgenson’s “Tuning”. Click Convert. The tuning record will
now be converted from equala temperament into the historical temperament you
selected. We recommend you next immediately enter new header info describing the
historical temperament used. 

You might want to keep all converted tuning records in a separate file. 

 Convert only an equal temperament record. If you convert an already-
converted Historical temperament, the result will be bizarre, to say the least.

“Tuning” by Owen Jorgensen
Michigan State University Press
1405 S. Harrison Rd.
Suite 25, Manly Miles Building
East Lansing, MI 48823-5202
Phone: 517-355-9543
FAX: 1-800-678-2120

 Hint 
Before you convert a tuning, create and save a spare copy of the equal
temperament tuning record. That way you can create additional records of that
piano using different temperaments. In the tuning file window select the Tuning
Hammer pointer, click on the equal temperament pre-converted tuning record,
and under the Edit menu select Copy then Paste. Another method: if the piano in
question is still the most recently sampled piano, its partial ladders are still in
Ch2, so you can simply go to Ch2 and click the Calculate button to create
another equal temperament record.

 Hint 
To view the offsets for any Historical Temperament, use the Edit menu to paste
in a blank tuning record then convert it. The readings in the Chart will be the
temperament’s offsets.

User Temperaments
To convert an equal temperament to a non-equal temperament not included in

Historical Temperaments, create your own User Temperament. 
To create a User Temperament, use the Open command (under the File menu) and

open User Temperaments. You’ll see a standard RCT tuning file window, with the
cursor blinking before the first tuning record. Under the Edit menu, select Paste
Blank, and a new empty record will appear as tuning record #1. (The new blank
tuning record will be pasted at the cursor’s location. If you’d rather the new file be
the last tuning record, click after the last record before selecting Paste Blank.) Open
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this record and enter cents offsets describing your User Temperament. Be sure to
enter the name of your User Temperament into the header. 

Only 12 offsets need be entered into a User Temperament tuning record, which are
the cents offsets from standard equal temperament for each note. All notes with the
same letter name are sharpened or flattened the same amount.  (RCT uses the lowest
12 notes that are non-zero.) You may enter your offsets into any octave you prefer,
but we recommend that you include middle C as one of the notes so the eighth note
symbol appears in the piano icon in the File Window. 

RCT ignores the partials in User Temperament files. As with RCT’s Historical
Temperaments, any OTS or CEQ setting can be applied to any User Temperament,
before or after conversion. 

A sample file called “User Temperaments” is included with RCT. To view or use
it, under the Tools menu select User Temperaments. If it’s the first time User
Temperaments has been opened, you’ll may see a dialog box asking you to open
User Temperaments. It’s normally in the folder RCT Documents. After it’s been
opened once, RCT will open User Temperaments automatically. 

After selecting User Temperaments, a list of User Temperaments will appear. It
works just like Historical Temperaments—you first select the tuning record you
want to convert, open User Temperaments, and click Convert. 

You can create more than one User Temperaments file. Rename the original User
Temperaments file or drag it to a new folder. Create a new file and title it User
Temperaments. The next time you use the User Temperaments command, locate and
choose the new file.

The “User Temperaments” file included with RCT has a few User Temperaments
already in it as examples. 

 Hint 
To return a converted non-equal temperament back to equal temperament, re-

convert the non-equal tuning record using a “reciprocal” User Temperament of the
non-equal temperament. To create a reciprocal User Temperament, set the 12 notes
to the same cents setting but the opposite sign (positive vs negative). In other words,
if a User or Historical temperament used -0.4 for C4, to return that note to its equal
temperament setting, use +0.4 for C4.

Tuning Doctor analyzes all tuning records in the open tuning file for unusual
readings. 

Select either cents or partials by clicking the appropriate radio button.
The partial check looks for any partial numbers that increase ascending from notes

1 to 88. Partial numbers normally stay the same or decrease as you go up the piano
chromatically.

The cents check looks for a cents spike of twice the allowable error on the PTG
tuning exam (from plus or minus 2.0 cents in the midrange to +/- 12.0 cents at the
ends of the keyboard).

Tuning Doctor highlights the cell in the tuning chart if it finds readings outside
these normal parameters.

Tuning Exam... calculates (or re-calculates) data on RCT’s tuning records used
for the RPT exam. An exam’s tuning records are not updated unless Tuning Exam...
is selected and the Score button or Detuning button is clicked. In other words,
entering a new number (recording a note’s pitch via the Save Cents button) in the
Examinee or Master Tuning records does not affect the Points, Difference, or
Detuning records until the Score button or Detuning button is clicked. This may be
different from other approved tuning devices which update related records
immediately when new data is entered. 

For more details, please read chapter 9 “Scoring the RPT Tuning Exam”.
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chapter 6

Pianalyzer
Pianalyzer — making piano tone visible
Pianalyzer measures cents deviation, inharmonicity, sustain time, and volume for

partials 1 to 16 for any note.

PAZ will quickly become your favorite research tool for studying tone and partials.
No longer will you wish you had an extra $20,000 to spend on a fancy spectrum
analyzer. (You can still wish for the extra $20,000!) 

Pianalyzer gives piano technicians an affordable way to examine piano tone. With
PAZ, piano tone can be discussed with the same objectivity and accuracy now used
for tuning partials. For example, PAZ can measure the effects of voicing by enabling
comparisons of PAZ readings before and after needling. PAZ can compare remotely
located pianos or the effects of string re-scaling and room acoustics.

The potential of PAZ is exciting and endless. You’ll probably discover uses no
one else has thought of yet. If so, please let us know. There’s a free RCT T-shirt in
it for you. 
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Using PAZ

To take a PAZ reading:
1. Select a note by clicking on the graphic keyboard, or switch notes with the

Computer’s keyboard arrows.
2. Click Record.
3. Play the note and sustain it until the ear stops pulsing.

After PAZ records the note, the tuning fork will spin while PAZ calculates. After a
few seconds, PAZ will display pitch, inharmonicity constant, sustain, volume units,
and a volume bar chart for partials 1 through 16

If you take another reading, PAZ will display the preceding volume bars as grey
bars above the current note’s colored bars.

For your viewing pleasure, the volume bars are displayed in color families — the
fundamental in blue; partials 2, 4, 8, and 16 in red (octaves); partials 3, 6, and 12 in
green (octaves + 5th); partials 5 and 10 in yellow (octaves + 3rd); and the 7th partial
(minor 21st), 9th (23rd), 11th (25th), 13th (27th), 14th (minor 28th), and 15th
(major 28th) in black.

For notes below A1, the 2nd partial is used instead of the fundamental. 
Partial ladders can be viewed either as cents offsets from equal temperament

pitches or as cents offsets from perfect harmonics. Click on the appropriate radio
button to select. 

Each partial ladder can have its fundamental equalized to zero by clicking on the
button Fund = 0¢.

“¢ to EQ Temp.” shows the offset cents to the equal temperament note closest  to
the theoretical harmonic pitch of the partial. For example, the 7th partial is 31.1741
cents flat of the note it is closest to (two octaves and a seventh above fundamental)
plus  the effects of inharmonicity and para-harmonicity. Only octave partials are right
on the money.

“¢ to Harmonic” displays a more even progression of inharmonic cents readings
since it shows the cents-off relative to the theoretical frequency of the harmonic. 
This mode of viewing discounts the offsets from equal temperament.

After you record a partial ladder, the Ic column shows the inharmonicity constant
calculated from each partial relative to the fundamental. If the Ic formulae predict the
string's motion perfectly then all these numbers should be the same, but they rarely
are. (The difference is called para-harmonicity.) These Ic readings could be
compared to calculated Ic from string lengths and diameters to prove (or disprove)
the accuracy of the equations.
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To calculate a theoretical partial ladder to compare to the “real” one, start with the
inharmonicity constant (Ic) derived from scale data:

Partial Ladder Series

16th partial Ic *255 Four octaves
15th partial Ic *224 - 11.8113 Three octaves + major seventh
14th partial Ic *195 - 31.1741 Three octaves + minor seventh
13th partial Ic *168 + 39.6006 Three octaves + sixth
12th partial Ic *143 + 1.955 Three octaves + fifth
11th partial Ic *120 + 49.8404 Three octaves + major fourth
10th partial Ic * 99 - 13.686 Three octaves + major third
 9th partial Ic * 80 + 3.9012 Three octaves + major second
 8th partial Ic * 63 Three octaves
 7th partial Ic * 48 - 31.1741 Two octaves + seventh
 6th partial Ic * 35 + 1.955 Two octaves + fifth 
 5th partial Ic * 24 - 13.686 Two octaves + major third
 4th partial Ic * 15 Two octaves
 3rd partial Ic *  8 + 1.955Octave + fifth
 2nd partial Ic *  3 One octave
 1st partial 0 Fundamental

from Steve Fairchild’s class notes handout, July 1990, Dallas PTG convention.

AGC
AGC stands for Automatic Gain Control. When AGC is enabled, notes played at

low volumes are automatically boosted and therefore more apt to trigger recording.
RCT has its own software AGC which works just fine on computers that don’t have
hardware AGC.

On older Mac PowerBooks, hardware AGC is enabled in Ch2 and CE at all times.
AGC is optional in PAZ and should be turned off only to allow for unusual
situations such as noisy environments, or to give you more control over sampling
volume. RCT 1.1 and earlier did not make use of any hardware AGC.

Printing and saving with PAZ
To print a PAZ reading, select Print... under the File menu.
Currently, RCT does not save PAZ readings with the normal Save... command

under the File menu. Instead, you can save a picture of a PAZ reading by creating
and saving a picture of your Computer’s screen on your hard drive. 

 Macintosh
Press the key combination Command-shift-3. The Mac will make a Ka-Click

sound (like a camera shutter) as it takes the picture. A “screen shot” of whatever is
currently displayed on your computer’s screen will be saved to your hard drive (at
the root level) and named “Picture 1” or a higher number if necessary. You can view
these screen shots in Simple Text or most graphic applications (where you can edit
them too.) In the Finder, you may wish to re-name this PAZ screen shot (e.g.,
“Steiger ser# 12345”) and move it to another folder.

 Windows
Save a PAZ screen by pressing the Print Screen key. On laptops it may be named

“PrtSc” or “PrntScrn”. This key is usually located near the F12 key. Next, and
before doing anything else, open a paint program such as Microsoft Paint and press
Ctrl-V. After pasting the screenshot into MS-Paint, you can edit, save, and print the
picture.
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chapter 7

USING MIDI

CAUTION: If you are new to RCT, read this entire section carefully first. Your
first MIDI transfer should be to send a copy of all pages in the memory of your
Sanderson Accu-Tuner (SAT) to your computer.  

This section only applies to SATs equipped with MIDI. If your SAT is not
equipped with MIDI and you wish to convert it to MIDI-capable, contact
Inventronics.

To transfer data between the SAT and your computer, some additional hardware is
required:

1. MIDI interface (also known as a MIDI converter)
2. a pair of MIDI cables to link the MIDI interface to your SAT

MIDI also works to transfer tuning records between computers running RCT or
Tuning Manager on any platform, mix or match. It may not be as convenient as
using floppy disks, but it works!

 Mac: All Macs have built in networking called “Appletalk”. If you want to
transfer tuning files (or any file) between Macs just use a serial cable connected to
the serial port (same as a printer cable). See your Mac documention for details.

To move MIDI files, pull down the Windows menu and select MIDI Control. The
MIDI dialog box will appear. 
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Setup
Setup allows you to select hardware specific settings for using the MIDI interface

with your computer.
Click the Setup button to show the Setup dialog box.

Most Mac MIDI Interfaces will use the default selections (transfer speed of 1
mHz and Modem port). Read the instructions with your MIDI interface if you’re not
sure about what selections to make. The Altech or OpCode interfaces use these
defaults. 

 Windows users get popup menu choices with all MIDI input and output
devices which are properly connected to the computer. If your MIDI interface is not
listed but is physically connected you probably need to install the driver which came
on a disk with your MIDI interface.

Before connecting any cables, take a good look at the ends of the cables. Most
MIDI cables have a marking on the connector (such as a flat spot, arrow, or screw)
to help line it up with the top of the SAT and the corresponding indicator on the
MIDI interface.
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5. Click on the RECEIVE button in the MIDI Control window. You now have 10
seconds in which to hold down the SAT’s SHIFT button while you momentarily
press the SAT’s MIDI-OUT button.
This will start the SAT sending all its information to the computer. 
We recommend that you verify each time you receive from (or send to) the SAT.
See VERIFY section, below.

MIDI Verify button
Each time you transfer tunings between the SAT and your computer, you should

verify. It’s the only way to be sure is all tuning data has been transferred perfectly
intact. Numerous software or hardware problems can cause transmission failure, so
this is a good idea. It takes so little extra time that it’s worth doing every time. 

To verify, just click the VERIFY button in the MIDI Control window. The
computer will then compare the data it receives with the data in the open tuning file
(which may contain multiple tuning records). 

In other words, if you’ve just sent data from the SAT to the computer, Verify will
re-send the data and check to see it’s exactly the same. Likewise, if you’ve just sent
data from the computer to the SAT, verify will send the SAT’s data back to the
computer and make sure they’re exactly the same. 

To repeat this important point:
MIDI verify compares the tunings in RCT’s open file with the tunings as received

from the SAT.

Any difference in the content of cents, partials, serial numbers, or headers will
cause a message to be created telling you how many bytes did not match. Any
difference in the number of bytes in the tunings sent from the SAT, compared to
tunings in the open file will cause a message indicating the difference in bytes.

RCT will always verify the number of bytes EXCEPT when RCT receives a
different number of tunings than are in the open file. In this case, as long as an even
number of tunings are received, RCT will verify the content of the tunings received,
and will display a dialog box telling the user that less tunings were verified than
expected.

MIDI Verify Procedure
1. Make sure your computer and your SAT are off.

2. Make sure the MIDI interface is properly connected to your computer.

3. Using a MIDI cable, connect the SAT’s “MIDI OUT” port to the interface’s
“MIDI IN” port. Using the other MIDI cable, connect the SAT’s “MIDI IN” port
to the interface’s “MIDI OUT” port. 
DO NOT FORCE THE CONNECTORS TOGETHER! If they don’t go in
easily, check the line-up notch, screw, etc. and try again. 

4. Start up your computer and double click on the Reyburn CyberTuner® icon.
Start up the SAT by pressing the SAT “ON” button, and press “TUNE” on the
SAT. 

5. There must be a tuning file open with which to compare the data from the SAT.
Note that an SAT’s contents can be verified against a file by first opening it with
the FILE menu. One SAT’s memory can be compared to another’s, by receiving
and verifying the first (putting that SAT’s contents in the open file), then
verifying the second SAT.

6. Both SAT and computer should be on now, with RCT running.
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7. Click the VERIFY button in RCT’s MIDI Control window. You now have a 10
second window of time in which to hold the SAT “SHIFT” button and press
“MIDI-OUT” on the SAT. A MIDI verify dialog box will appear when finished,
informing you of the results.

SENDING TUNINGS TO THE SAT
CAUTION 
Sending tunings to the SAT will OVERWRITE the tunings in the SAT!!! MAKE
SURE you do not send tunings to the SAT unless you are ABSOLUTELY
SURE of what you are doing, and have a backup copy of what is in the SAT.
Reyburn Piano Service will absolutely not be responsible for lost data under any
circumstances (see SOFTWARE LICENSE AGREEMENT).

Sending Tunings To The SAT
1. Make sure your computer and your SAT are off.

2. Make sure the MIDI interface is properly connected to your computer.

3. Using a MIDI cable, connect the SAT’s “MIDI OUT” port to the interface’s
“MIDI IN” port. Using the other MIDI cable, connect the SAT’s “MIDI IN” port
to the interface’s “MIDI OUT” port. 
DO NOT FORCE THE CONNECTORS TOGETHER! If they don’t go in
easily, check the line-up notch, screw, etc. and try again. 

4. Start up your computer and double click on the Reyburn CyberTuner® icon.
Start up the SAT by pressing the SAT “ON” button, and press “TUNE” on the SAT. 

5. Click the SEND button in RCT’s MIDI Control widow.

6. If you are sure want to OVERWRITE what is in the SAT, first press the “MIDI
IN” key on the SAT.

7. Press “OK to Send” on the computer to initiate sending tunings. Sending will
take between 4-32 seconds for 20 to 208 tunings respectively.

8. A dialog box will recommend that you verify what was just sent; it is
recommended that you do this every time you send.

The SAT always inserts the tunings it receives through it’s MIDI ports into the
lowest memory pages, for example, if your SAT can hold 30 piano tunings and you
send 5 tunings to the SAT, these tunings will be stored in pages 1-5 on the SAT.
Pages 6-30 are not affected.  

 Hint on Sending Tunings To The SAT 
Any number of tunings can be sent to the SAT from 1 up to the number of pages
you have in your SAT. If you send less than the SAT memory limit, such as 1,
the SAT will keep waiting for the rest and will not release the keyboard. This
does not hurt anything; just press the “ON/OFF” button on the SAT twice to turn
it off, and then back on again.

If you need to change a single high page in memory in the SAT you will have to
send the SAT that page with all the pages lower than that page. Its easy to send the
SAT one Chameleon tuning for use in page 1. I suggest you use the first several
pages as “scrap” pages since they are the most convenient to send to, and use the
higher pages for your standard library of tunings.
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MIDI Troubleshooting
1. Is the MIDI interface installed properly? See the instructions that came with

your MIDI interface. RCT expects the MIDI interface to match the speed and
port indicated in MIDI Setup (Press the “Setup” button in the MIDI Control
window).

2. Check the MIDI cable to the SAT and computer. Are they properly and firmly
connected? Try changing the serial cable or MIDI cable. Try a one foot serial
cable. Long serial cables can cause problems with some computers. Bad serial
cables are one of the most common causes of MIDI communication problems.

3.  Macintosh MIDI troubleshooting
  Some system extensions which are loaded when your computer starts may

conflict with RCT’s MIDI driver. These are the icons you see at the bottom of
your screen when the Computer starts. Try disabling extensions until you
determine which is causing the conflict. If you do discover a conflicting
program, please call Dean and report the offending program. This will enable
me to fix the conflict, or if I can’t fix it, at least let other users be aware of the
problem. See the computer System manual if you don’t understand system
extensions.

Mac OS System 7 has an Extensions Manager which can be used to track
down extension conflicts, but I prefer to use a great program called “Conflict
Catcher” by Cassady & Greene.

QuickTime/MIDI Compatibility Note: If you use Apple’s QuickTime system
extension, you may need to disable it if you have MIDI problems.

4. Check the operation of the buttons on the SAT. The SHIFT button on older
models converted to MIDI tend to be unreliable since it used the most and is
often worn out. The membrane type SAT’s don’t seem to have any problems at
all. Make sure to hold the SHIFT button down while you press the MIDI-OUT
button on the SAT. DON’T roll over from SHIFT to MIDI OUT.

5. Try swapping out one hardware component at a time. This is a very effective
way to determine where the problem is. Swap out:

* Serial cable to the computer
* MIDI Cables
* MIDI Interface
* computer
* Sanderson Accu-Tuner 
* Dock, if your computer has one

6. Reinstall Reyburn CyberTuner®, and restart computer. See installation
instructions at the beginning of this manual.

7.  Some PowerBooks with a combined modem/printer port, including
Macintosh PowerBook Duos, must have AppleTalk turned off and be restarted.
Note also that the Mac PowerBook Duo’s built in combined modem/printer port
may operate differently than the Dock’s ports. 

8. For laptops, use AC power, not battery. This may increase the power the serial
port receives.
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9. New computers may have problems with older MIDI interfaces. Some serial
ports don’t put out enough power for older MIDI interfaces resulting in MIDI
dropout and RCT error messages. Try a different MIDI interface.

MIDI Error Messages
Reyburn CyberTuner® does extensive checking for possible errors in MIDI

transfer to ensure the highest level of protection for your piano tuning records!

RCT
Error ERROR TEXT Meaning
#

0. NO TUNINGS RECEIVED IN 10 SECONDS 
Either the SHIFT-MIDI-OUT buttons on the SAT wasn’t pressed soon enough,
or there is a bad connection somewhere.

1. MIDI INTERFACE NOT RESPONDING 
The MIDI interface may be connected incorrectly, or connected to the wrong
port. Is theWindows driver installed? Check your Mac MIDI interface manual to
make sure it operates at the correct mHz speed, most are 1 mHz.

2. TOO MANY BYTES IN HEADER
There may be leftover tunings from the last unsuccessful receive. Try it again, or
exit RCT and try again. This is often caused by pressing MIDI-OUT on the SAT
before pressing Receive, or Verify on the Computer.

3. TUNING BUFFER OVERFLOW
More tunings were sent to the computer than the tuning buffer had reserved
room for. RCT is limited to 240 tunings in a file. A SAT with MIDI cannot have
more than 208 tuning pages.

4. ONLY HALF OF ONE OR MORE BYTES WERE RECEIVED
The SAT always sends whole bytes. If there is a half byte, then a MIDI
transmission error occurred.

5. TOO MANY BYTES IN FOOTER
The last byte of the SAT SYS-EX message should be one byte long, a MIDI
transmission error probably occurred.

6. Not used for TM/Computer or RCT/Computer.

7. INCORRECT START OF SAT SYS-EX MESSAGE
There may be leftover tunings from the last unsuccessful receive. Try it again, or
exit RCT and try again.

8. INCORRECT SAT ID BYTE
The SAT sends an identification that a SAT is transmitting, not some other
device. The ID was wrong and no data was accepted. This is often caused by
pressing MIDI-OUT on the SAT before clicking Receive or Verify on the 
computer.

9. MIDI INTERFACE NOT RESPONDING
Usually this means that there is no MIDI interface installed on the computer, or
the MIDI Setup is not correct. Press the “Setup” button in the MIDI Control
window, and make sure all the settings are correct. On Windows is the driver
installed? Check the port (Mac) or MIDI input and output devices (Win) in
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MIDI Setup. Make sure the MIDI Interface is properly installed according to the
instructions that came with it. 

10. ONLY ONE BYTE IN SAT SYS-EX MESSAGE
The start of the SAT data must have two bytes, the data was ignored since it is
probably not valid.

11. NO MIDI INTERFACE INSTALLED
No serial MIDI interface was detected by Reyburn CyberTuner®.

12-29 
Not Used.

30. THIS SAT TUNING FORMAT IS NOT SUPPORTED
RCT only supports the current SAT tuning format #2. Format #1 was never
used with MIDI, to date only format #2 has been used. Please call RPS if you
get this one!

31. BYTE COUNT DOES NOT MATCH SAT
The SAT sends how many bytes to expect, and that was NOT the amount that
was actually received. Garbled data is almost 100% certain!

32. TUNING INTEGRITY HAS BEEN COMPROMISED
A part of a tuning was lost, RCT received a fraction of a tuning, and the SAT
only sends whole tunings. Garbage is a sure thing.

UNDEFINED ERROR XX
XX will be a number indicating the number of the undefined error. You should
NEVER see this error, since it would probably mean that RCT’s MIDI error
handler has a bug. If Murphy’s law comes true and you do, please call Dean.
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chapter 8

CHAMELEON 1

Using physical measurements from 5 strings, Chameleon 1 will create an aural
quality tuning for any piano. There are 11 tuning styles built into this version. You
can choose between very narrow to very wide octave widths, a special style for the
RPT tuning exam, and a Custom style. 

Choose Chameleon 1 from the Window menu. A tuning file must be open before
you can calculate a tuning. Chameleon also needs to know which tuning page to put
the calculated tuning; enter this in the box after the words “Calculate Tuning”.

 
To Use Chameleon 1, measure the singing length and wire diameters for notes A1,

A2, A3, A4, and A5. For A1 and usually A2, you’ll also need to measure winding
diameter, unwound segment length, and enter the winding metal type.

Definitions

1.Singing Length
Measurement in inches from one end of the primary sounding portion of the
string to the other end. The singing area may end at a bridge pin, an agraffe, a
pressure bar, a capo bar, or a hitch pin. For example, the singing length might
be from the center of the bridge pin to the center of an agraffe.

2.Core Diameter
Unwrapped steel portion of the wire. Measure in inches with a micrometer
graduated in thousandths of an inch, or use the wire gauge size written on the
plate or bridge, if you can determine if the size is metric or not.

For wound strings only:
3.Winding Diameter

The entire outside width of a wound string, including core, and all windings.
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4.Winding C/I/A
Type of metal used in winding, Copper, Iron, Aluminum. Copper is assumed
unless otherwise specified.

5.Unwound End
Length from the end of the windings to the end of singing length (average the
two ends if different from each other).

Type these measurements into the appropriate boxes in the Chameleon 1 main
window. Ch1 will estimate A1 for you if you leave A1 blank, but a better tuning will
usually result if you measure A1. Ch1 checks most values to make sure they are
sensible. For example, no 12 foot grands or 2 foot spinets allowed!

Wire gauges can be used, but micrometer measurements are less error-prone. Ch1
uses either and knows the difference automatically. 

For help in putting in the numbers, press “Demo Data” button. Sample data for a 9
ft grand will appear in the Ch1 input window.  

The “Clear Data” button is handy if you are calculating several pianos. Just press
this button between pianos to start with a clean slate.

Examples of wire size info:

  17 39 .039

All three mean the same thing to Ch1 (assuming American wire gauge). Pianotek
carries a really nice thin-anvil micrometer that is easy to get between the strings — a
Starrett 1” micrometer model 220AP-1. A digital add-on option is also available
from Pianotek for about $120 (helpful to eliminate errors). Contact Bob Marinelli at
Pianotek at 1-800-347-3854. 

When measuring singing length, convert the measurement to decimal inches. For
example:

                    
A 36 and 5/8 inch measurement would be entered as 36.63 (36.625 rounded up).

Some better hardware or machinist’s supply stores may carry a decimal inches tape
measure (e.g., Stanley). On this type of tape measure the markings are in tenths and
fiftieths of an inch, instead of the normal 1/8” 1/16” etc. This is easier on the brain
since no conversion from fractions to decimals is needed.

To measure singing length, you should theoretically measure from the center of the
bridge pin to the center of the agraffe, or capo bar, but in practice, just hook the end
of the tape over the far side of the bridge pin and measure to the far side of the
agraffe (or pressure bar) and round up to the nearest millimeter (or 1/16th inch). 

If the overhang of your tape is too large to fit between the treble and bass strings,
cut it off to about 2 or 3 mm (1/8” to 3/16”) with music wire cutters, and file it
smooth. A little nameboard felt glued around the end of the tape measure’s overhang
may prevent scratching strings.

For A5 on grands, use a thin ruler to reach as far under the capo bar as it will go.
A Starrett ruler that works wonderful for A5. Since A5 is usually about 8.5” (215
mm) long, the standard 6” rule doesn’t work very well. This Starrett ruler is 12”
long, and is graduated in both millimeters, and decimal inches. It is model number
C334 and costs about $27. This simple tool really speeds up measurements, and
increases accuracy! Taping two 6” pocket rules together may work too.
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The measurement form the unwound end should be the average of the two
unwound ends of that string ( if they are more than 1 mm different).

There are four options at the bottom of the Chameleon window:

1. Lengths
Millimeters or Inches. All singing lengths must be either one or the other; don’t
mix mm and inches!

2. Wire Gauge
Standard or Metric. Only needed if you used wire gauge instead of actual
micrometer measurement. Tuning will be just slightly off if you use gauge
numbers and set the Wire gauge type incorrectly.

3. A1 Wound
Is A1 single or double wound? Double wound strings will have a short telltale
“step” near each end.

4. Bass Partial
Eighth or Sixth. This is the partial which Chameleon will use in the lowest Bass
octave, from A0 to G#1 only. Use the 8th partial if possible; it is closer to where
most aural tuners listen. If CyberEar has trouble “hearing” the 8th partial, try
plucking the string! The tuning is not likely to be as accurate on most pianos if
the 6th partial is used, but may give a more readable pattern on CyberEar for
some pianos. 

When you are finished entering numbers, press the “Calculate” button to calculate
and store the tuning in the selected “Calculate Tuning” page. After calculation, the
tuning header will contain something like:

B=.30B T=.30B D=.70B
This tells you how close to the requested ideal Chameleon could tune the piano. 

The first section, B=.30B, says that the octave A2 to A3 should beat .30 beats per
second at the 6/3 octave check. Confirm this by checking that the minor 3rd A2-C3
is about 1/3 BPS slower than the C3-A3 sixth.

The second section, T=.30B, is saying that the octave A3 to A4 will be .30 Beats
wide at the 4/2 octave check, that is, the F3-A3 major 3rd should beat about 1 beat in
3 seconds slower than the F3-A4 tenth.

The third section, D=70B, is saying that the double octave A2 to A4 ended up .70
BPS expanded, or wide from pure. Check this by comparing the F2-A2 major 3rd
with the F2-A4 17th. The 3rd should be .70 beats slower. This is called a 4/1 double
octave check.

Of course each piano and tuning preference will have a different set of beat speeds,
but if the aural checks match what Chameleon says, then you know everything
worked!  If the speeds don’t match, usually your measurements were off, or were
entered incorrectly! (Or the tuning drifted, or the MIDI transfer was bad etc....)

Chameleon uses a two octave A to A temperament. Tuning this aurally, or
electronically yourself will help you understand the checks better.

For more information on aural/electronic octave tuning, see the Piano Technician’s
Guild Journal article series by Rick Baldassin entitled “On Pitch”, June 1983
through March 1985 (11 articles). This is the all-time classic series equating Aural
and Electronic tuning and on different types of octave tuning.  The PTG now
publishes these articles in book called “On Pitch”.
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Some small or poorly scaled pianos will actually have negative (contracted) single
octave checks! This is normal, and necessary to keep the double octaves from being
too wide, and the 2/1 single octave partials from beating too fast! If the single
octaves sound too narrow on these pianos, simply re-calculate the tuning telling
Chameleon to use a wider tuning style!

When Chameleon uses your tuning preferences, it will replicate the tuning style in
the A2-A4 temperament up and down the piano, giving a smooth transition between
sections of the piano.  The “Octave Tuning Styles” radio buttons function the same
as they do for Chameleon 2, see the Chameleon 2 chapter for more details.
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chapter 9

SCORING THE RPT TUNING EXAM

In this chapter, we’ll learn how to use RCT for measuring and scoring the
Registered Piano Technician tuning exam. It also includes descriptions of many basic
RCT operations because we wrote it as a unified guide for CTEs with little experience
with RCT. If you’re already familiar with RCT operations, some information may be
repetitive.

Overview
Reyburn CyberTuner (RCT) is software that turns a portable computer into a stand

alone visual tuning device. If you’re already a CTE, RCT will be easy for you to
learn because its exam procedures are very similar to those of other approved devices.

When used to measure and score the RPT Tuning Exam, RCT can:
• measure and record a master tuning and an examinee tuning
• auto-calculate points-off, difference, and a de-tuning
• measure deviation for pitch, unisons, and stability
• display charts and graphs of a master tuning, examinee tuning, points off,

difference, and detuning. 

Summary of RCT Exam procedures
Master tunings can be measured with RCT or you can manually enter the pitch

readings if the master tuning already has been measured and written down on an ETS
Master Tuning Record form. A Detuning is then calculated with one click of a mouse
button. 

Measure and record an Examinee tuning. RCT then auto-calculates the difference
(between master tuning and examinee tuning) and points off. You will transcribe the
points off to the official ETS Exam Score Form, where you will then apply the
correct multipliers.

How RCT works
For the RPT Exam, you’ll be using two (out of four) of RCT’s modules: File

Management and CyberEar.

File Management
File management is the module that displays files, records, charts, and graphs for

Examinee tunings, Points off, Master tunings, Difference, and Detunings.

Files and Records
A tuning record is a set of pitches and partials for all notes of one piano.
A tuning file is a container for tuning records. (An RCT tuning file can hold as

many as 240 tuning records.) Just like other common computer files, RCT’s tuning
files can be named, saved, copied, etc.  
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For each RPT tuning exam, you’ll tell RCT to create a special exam tuning file that
will contain six tuning records: 

You’ll notice these tuning records are in the same order as the SAT and use the
same abbreviations. In RCT there’s one extra tuning record named A4 Pitch, which is
used for (duh!) measuring the pitch of A4.

An RCT tuning record can be viewed as a tuning chart.

An RCT tuning chart is like a spreadsheet. Each cell in the tuning chart contains a
note’s partial and cents deviation. To find a particular note’s cell, find the intersection
of the note name’s row (labeled at the left) and its octave number’s column (labeled at
the top). 

RCT lets you type in any cents reading or partial in any cell in a Master Tuning
record. To do so, click twice quickly on the number in the cell, then type in the cents
reading. When you’re done, you can press the Tab key or Return key (Mac) or Enter
key (Win) to select the next chromatic note up or, to select any other note, double
click on any note’s reading anywhere else on the chart.

In order to prevent errors or accidents, manual editing of cells in an Examinee
tuning chart is not allowed. Examinee tunings are measured elsewhere, in CyberEar.
If there was a mistake in reading an examinee tuning, the note must be remeasured
and re-saved from CyberEar.
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Every tuning chart has an accompanying tuning graph. The tuning graph shows
exactly the same information as a tuning chart except in graphic form. The graph’s
horizontal axis displays notes A0 to C8; its vertical axis displays cents. There are
three graph lines because the RPT Tuning Exam uses three partials: partial 4, partial
2, and partial 1, which you can see labeled at each graph line’s right terminus.

No more than one file and one record can be open at a time. An open file or record
is called the “active” file or record.

From a Tuning chart, you can click the Prev and Next buttons to flip to the previous
and next tuning charts. 

Click on a chart’s Graph button to see its graph.

 

To view a Previous or Next graph, hold down the Command key (Mac) or Control
key (Win) and press the computer’s left or right arrow key. 
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To go to CyberEar from a tuning chart, click on the rectangular button with the
CyberEar Spinner inside it. 

Another way to navigate around RCT is to pull down the Windows menu and select
Tuning File, Tuning Chart, Tuning Graph, or CyberEar. (You may see other
modules or commands in RCT’s menus, but they are not needed for the RPT Exam
and therefore are not discussed here.)

CyberEar
CyberEar measures and displays a note’s pitch. You use CyberEar to measure and

save a master tuning or examinee tuning.

Here’s a very important RCT concept you need to understand:
The active tuning record and CyberEar are linked.

CyberEar displays the pitch for each note as listed in its cell in the active (open)
tuning record.

This linkage works in the other direction too. When you measure a note’s pitch in
CyberEar then tell CyberEar to save that measurement, the note’s cents reading will
automatically be written into its cell in the active tuning chart.

If no tuning record or file is active when you go to CyberEar, CyberEar is not
linked to any tuning chart. Instead, it will measure deviation from theoretically pure
equal temperament, similar to the SAT’s Tune mode. 

In CyberEar, a selected note is written in the big box in the center of the CyberEar
window. On the graphic keyboard, the note is indicated by the pointing finger; the
note name and octave are written over the selected note’s darkened key; the “tuning
partial” (as listed in the tuning chart) is shown on the graphic keyboard with an ear, a
dot on the key, note name and octave, and partial number.

At the bottom of the CyberEar window is a long rectangular header box. There
appears the name of the active tuning record that CyberEar is linked to. Just to the left
of the header box is the number of the active tuning record.

To indicate a note’s pitch deviation, CyberEar uses the Spinner, a rotating circle
with two pie slices or arcs. 

The Spinner’s rotation speed is proportionate to a note’s pitch deviation. In other
words, the more the deviation, the faster the rotation. If a note is flat, the Spinner
rotates counterclockwise; if a note is sharp, the Spinner rotates clockwise. The
Spinner also moves proportionately to the left if the note is flat and to the right if the
note is sharp.
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Target Blushing
Target blushing begins when the Spinner has almost stopped spinning; in other

words, then the Spinner and note’s pitch are almost matched. 
When the target starts to blush, a half-diameter dim circle appears inside the

Spinner.

The size of the blush increases as you get closer until it fills up the Spinner. 
Here are the specs for how close the string’s pitch must be to the Spinner’s cents

reading (sum of Tune box and Offset box) and the resulting Blush diameter. These
specs apply only at the recommended Spinner setting of 2.0¢/revolution/second.

0.3¢ 50%  
0.2¢ 70%  
0.15¢ 90%  
0.1¢ 100% 

 Blush specs change proportionately to the Spinner rate. In other words, if you
make the Spinner less sensitive by setting it to 4.0¢/rev/sec, the above-listed Blush
specs will be 0.6¢, 0.4¢, 0.3¢, and 0.2¢. If the Spinner is set to its maximum
sensitivity of 1.0¢/rev/sec, blush specs will be 0.15¢, 0.1¢, 0.075¢, and 0.05¢.

We recommend you always see some degree of target blushing before you save a
note’s cents reading. This will help all examiners maintain high and consistent
measuring standards.

If you can get a full blush for every note, that’s perfect. That means your piano and
your tuning skills are very good.

However, different pianos are capable of different degrees of blushing. After
careful tuning and/or Spinner tweaking, some notes may show full blush (within
0.1¢) while some will be capable of only partial blush (within 0.3¢) no matter how
hard you try. 

If a majority of notes won’t show any blush, you should re-think this piano’s
suitability for the RPT Exam.

CyberEar can display deviation as either beats or cents. The recommended mode is
cents because it yields more accuracy in the bass and more stability in the treble.

To view the Spinner settings, click the Spinner button.
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The Spinner dialog box will open.

With the recommended Spinner rate of 2 cents per revolution second, you can
roughly judge the cents deviation of a string by counting the Spinner’s rotation and, if
the deviation is more than about 5 cents, by gauging how far the Spinner moves to
the right or left.

For example, if a note were 10¢ flat, the Spinner would rotate counterclockwise 5
revolutions per second. The Spinner would also move left as shown below . 

Notice the numbers displayed under the oval (10¢, 25¢, 50¢). They’re there to
help you judge how far the Spinner moved. For example, if the note is 10¢ flat, the
Spinner hub would be over the -10¢ mark, like this:

The Spinner shows the selected note’s deviation. CyberEar adds together the
readings in the Tune box and Offset box to create the total deviation.

           

The reading in the Tune box is taken from the selected note’s cell in the tuning
chart. If the Tune box reading is changed and then saved (described below), the
reading in the selected note’s cell in its tuning chart will be re-written to match the
reading the Tune box.

For RPT exam use, the Offset box is used only when measuring Unisons and
Stability. The Offset box should always be set to 0.00¢ when measuring a master
tuning or examinee tuning. The Offset box is not linked to any cell in a tuning chart,
which means its reading will not change when you switch to another note. The
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reading in the Offset box cannot be saved; in other words, the Offset box reading is
not written into the tuning chart when the Tune box reading is saved.

In the Tune and Offset box, cents readings are shown to .01¢. As you are aware,
RPT exam tolerances are .1¢. Don’t worry. For the Tuning Exam (but not in normal
use), all CyberEar cent readings are automatically rounded off to .1¢ when saved to a
tuning chart.

Usually, you’ll let CyberEar’s auto-measure a string’s pitch when measuring a
master tuning or examinee tuning (described below). CyberEar’s auto-measure
feature is called the Listener, and it’s extremely fast and accurate. Measuring and
recording an examinee tuning can take as little as 12 minutes. The procedure is
described below. 

You can manually adjust the cents readings in the Tune box or Offset box by
clicking on the sharp or flat buttons to the right of the box. Each click will adjust the
box’s reading by .1¢. If you hold the mouse button down over a sharp or flat button,
the reading will continually change by .1¢. After two seconds, it will change rapidly. 

Even though it isn’t necessary for the Tuning Exam, the Tune box and Offset box
can be adjusted by .01¢ by holding down the Command key (Mac) or Control key
(Win) while clicking the sharp or flat buttons. 

To automatically set the Tune or Offset box to 0.00¢, click its Clear button, the
little button with the “C” located to the left of the box.

Tune box cents reading can be adjusted from the computer’s keyboard by pressing
the “<“ or “>” key.  Pressing the “c” key will clear the Tune box. Pressing the
Command key (Mac) or Control key (Win) while pressing the  “<“ or “>” key will
also adjust the Tune box by .01¢.

Note Selection
In CyberEar, notes are selected either manually or automatically. To select a note

manually, click on any note on CyberEar’s graphic keyboard or use the on-screen
navigation buttons or use the computer’s arrow keys. 

Usually, CyberEar will automatically switch notes for you when you’re measuring
a tuning (described below).

To leave CyberEar, click the Done button

or, to also select where you want to go, pull down the Windows menu and make a
selection. 

RCT Exam Procedures
Starting an exam session
Open RCT, pull down the File menu, and choose “New Exam”. A new RCT

tuning file will automatically be created. It will contain six exam tuning records.
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If RCT is set to Icon View, you’ll see the same tuning file but in another display
mode. In Icon View, each tuning record is displayed as a piano icon. You can still
identify the various records because each piano icon will contain the first letter of its
name.

The first five records are in the same order and have the same functions as their
corresponding pages on the SAT. The sixth record, A4 Pitch, is used only for
measuring and recording one note, A4, for the exam’s Pitch section. 

Don’t move or rearrange these tuning records. RCT expects these records in this
exact order when calculating an examinee’s score or calculating a detuning. 

Immediately after creating this tuning file, we recommend you save to disk and
name the file. Select “Save” under the file menu and, if it’s the first time the file has
been saved, you’ll see a window where you can type in a name for this tuning file.
Name it anything you like, but we recommend you identify it as an exam file (to
differentiate it from a customer file) and include the examinee’s name and the exam
date. For example, you might name the file “Exam John Smith Dec. 12, 1997”.

We also recommend you save to disk often when measuring and recording a
master tuning or examinee tuning.

Recording a Master Tuning or Examinee Tuning
In general, the same procedures are used for recording a master tuning or an

examinee tuning:
1. Open RCT.
2. Under the File menu, select New Exam.
3. Click on the appropriate record (either #1 EEE or #3 SUP). All notes will

already be set to their correct exam partials and their cents readings will be zero. 
4. T open CyberEar, click on the Spinner icon at the upper right. Alternate

methods: pull down the Windows menu and select CyberEar; press the Command
(Mac) or Control (Win) key and type the letter R. 
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5. In CyberEar, click the Spinner button (located to the left of the octave-down
button). 

Verify that Spinner sensitivity is set to 2¢/revolution/second, and that Smoothing
and Targeting are checked. Click OK or press the Return or Enter key. 

6. Back in CyberEar, verify that the Offset box is 0.00¢. If not, click the adjacent
small “c” button to clear it to zero. Verify that Pitch (located at top center) is set to
440. If not, hold the mouse down on the improper pitch setting and select 440. 

7. Manually select the first note you wish to record. 
8. To auto-measure the selected note, click the Tuner Box Listener button (with the

ear inside), located under the Tune Box. 

When you do, you’ll see pulsing rings around the Spinner, indicating that
CyberEar is waiting for you to play the note. Play the note and sustain it until the
Spinner ball is completely filled in., indicating auto-measuring is complete. (This
takes about 6 seconds in the bass and 2 seconds in the treble.) The cents deviation of
the note will now be displayed in the Tune Box. To double-=check the accuracy of
your auto-measure, play the note again (but don’t re-click the Tune Box Listener). If
necessary, click the Tune Box’s up or down buttons and adjust the Spinner by .1¢
until the Spinner’s rotation is completely stopped and you get maximum blush. 

It may be possible to get a better maximum blush, even momentarily, by adjusting
the Tune Box in increments of .01¢ by pressing the Command key (Mac) or Control
key (Win) or the Shift key (Mac and Win) and clicking the Tune Box’s up/down
arrow buttons. Piano tone is transient, so measure the note at the same point of
decay. Play softly and consistently for maximum accuracy. 

When you’re satisfied your measurement is as accurate as possible, it’s time to
save the pitch of the recorded note. Call out the note name, octave, and cents reading
so it can be recorded on ETS Form 2 or 3. Then click the Save Cents button, 

and three events will occur simultaneously:
1. The reading in the Tune box will be written into the selected note’s cell in the

open tuning chart (should be either EEE or SUP).
2. CyberEar will automatically switch up to the next note.
3. The Tune box Listener will be enabled, as indicated by the pulsing rings around

the Spinner.
Play the next note(which now is the selected note) and it will be auto-measured.

Continue this procedure until all notes of Part 1 or 2 are recorded.

After measuring the last note, the Tune Box Listener will still be waiting to auto-
measure the next note, so you’ll need to cancel auto-measuring by clicking on the
Tune Box Listener button. 
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It’s a good idea to save the file to disk (under the File menu select Save) several
times during the recording process. 

Adjusting the pitch of a previously recorded Master Tuning
1. Open the exam’s A4 Pitch tuning record (#6).
2. Open CyberEar. A4 will be selected. If not, select A4.
3. Click on the Offset Box Listener button and play A4. A4 will be auto-measured

at partial 1.
4. Verify the accuracy of the auto-measure by playing A4 again and , if necessary,

clicking the Offset Box’s up/down buttons for maximum blush.
5. Select A5.
6. Click on the Tune Box Listener button (not the Offset Box’s) and play A4 (not

A5). A4 will be auto-measured at partial 2. 
7. Verify. 
8. On a scrap of paper, write down the reading in the Tune Box (not Offset Box).
9. Pull down the Windows menu, select Tuning File, and click on the Master

Tuning record to open it. 
10. Adjust the pitch of the Master Tuning chart by holding down the Command

key (Mac) or Control key (Win) and clicking the pitch window’s up/down buttons
(located at upper left) until the A4 cell (which has a bold border) has the same reading
as the Tune Box reading you wrote on the scrap of paper.

Please note:
1. In the Master Tuning chart, if you don’t press the Command key (Mac) or

Control key (Win), the pitch window’s up/down arrows buttons will adjust the pitch
by 0.1 beats, which is 0.4¢.

2. The pitch window in the tuning chart displays beats, and therefore may not
change if you adjust the Master Tuning chart by 0.1¢. That’s OK. The numbers in the
tuning chart will still adjust as normal.

Entering a Master Tuning manually
If a master tuning has previously been measured and recorded onto a Master

Tuning Record form, you can manually enter those numbers into RCT’s Master
tuning chart ( #3 SUP). The correct partials will already be selected for every cell. All
you need to do is click on the cents reading in any cell, then type in the correct
number from the Master Tuning Record form. 

To select the next cell’s cents reading, press the Return key (Mac) or Enter key
(Win) followed by the Tab key, and the cents reading for the next note will be
selected. Type in the correct cents reading for the next note, and continue. Every five
or ten notes, select Save under the File menu so that your new entries will be saved to
the computer’s hard disk.

To type in any other cell’s cents reading, click on the cell’s cents reading then
type.

Creating a Detuning
To create a detuning, a Master tuning must already be recorded onto RCT’s Master

tuning record (#3 SUP). Select Tuning Exam... under the Tools menu. The “Score
RPT Tuning Exam” window will appear:
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 Click the Detune button. The correct detuned cents readings for each note will
automatically be calculated and entered into RCT’s Detuning tuning record (#5
UUU). 

Want a chuckle? Here’s a graph of an example detuning:

To detune the exam piano, open the UUU record, select CyberEar, and with
NoteSwitcher enabled, tune each note until the Spinner stops. For detuning, blushing
is not important. 
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Multiple Master Tunings records
If you’ll be using RCT to administer exams on more than one master-tuned piano,

it’s   a good idea to store copies of the various master tunings in a separate folder
named “Master Tuning Library.” To create a Master Tuning Library, pull down the
File menu, select New and, when asked to save and name this file, type in “Master
Tuning Library.” Click OK.

To place a copy of a Master Tuning into the Master Tuning Library, open the Exam
file that contains the Master Tuning, select the Master Tuning record (by clicking once
with the Tuning Hammer pointer), pull down the Edit menu and select Copy, pull
down the File menu and select Open, click on the Master Tuning Library file and click
OK, then pull down the Edit menu and select Paste.

To put the appropriate saved Master Tuning record in a new exam file, open the
Master Tuning Library, click the Tuning Hammer pointer on the correct Master
Tuning record, pull down the Edit menu and select Copy, open or create the new
exam file, select the new master Tuning record by clicking on it, and pull down the
Edit menu and select Paste.

An advanced alternate method of using multiple Master tuning records: 
In the Finder, open the folder containing an RCT Exam tuning file with the Master

Tuning for the current exam piano. Make a copy of that file and paste it into the
desired location. Name it appropriately and overwrite the Examinee record.

Recording A4’s pitch
To record A4’s pitch, open RCT’s A4 Pitch tuning record (#6 A4 Pitch). Open CE

and select A4. Partial 1 will automatically be selected. Make sure the Offset Box is
0.00. If not, click its Clear button. Measure A4 with the Tune Box Listener button
and verify. Write A4’s cents reading onto the Tuning Exam Score form. 

Measuring an Examinee Tuning
An examinee tuning is measured using the same procedures as for a Master Tuning

(described above). 

Scoring
After an Examinee tuning and a Master tuning are recorded, it’s time to calculate the

points-off (POI record #2) and difference (DIF record #4). Pull down RCT’s Tools
menu and select “Tuning Exam...”

The “Score RPT Tuning Exam” window will appear:
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  Select the lowest note in the Examinee’s temperament (default is F3). Click the
Score button. The Points-off and Difference tuning records (#1 POI and #2 DIF) will
automatically be calculated.

The Points tuning chart will automatically appear.  (This would be a great time to
Save the file to disk.) 
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At the same time, the Pitch Correction Number is automatically calculated and
entered into the header of the Examinee tuning chart.

The detuning (UUU record #5) is recalculated whenever the Score button is
clicked.When scoring Part 1, the examiner with Form 6 takes over the operation of
RCT and supervises the aural verification and recording. The other examiners or the
examinee should not see the points until after verification. On Form 6, verified points
should be circled; points not verified should be crossed out. The examiner with Form
6 should then total up the verified points, convert then to percentage scores and
announce, in order, the scores for pitch, temperament, and midrange.

Part 2 of the exam is allowed 60 minutes and in conducted similarly. The RCT
reader may start reading at C1 (note #4). After B2, he skips to the lowest note of the
temperament and reads the temperaments section, skips to C5 and continues to B7,
calling out note name, octave, and cents reading for each note. The examiner with
Form 6 then takes over and supervises aural verification. As points are tallied for each
section, this examiner converts them to percentages and announces the scores as they
become available.
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Graphs for the points off and difference charts can be very instructive for the
examinee. For instance:
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Unisons and Stability

When measuring unisons and stability, you’ll use the Offset box to measure
deviation from the Tune box reading.

For measuring unisons and stability, you might find it more convenient to use
CyberEar’s automatic NoteSwitcher, which switches CyberEar to the next chromatic
note (up or down) as soon as you play it. While you were measuring the Examinee
tuning, NoteSwitcher was automatically disabled, which happened when you used
the Tune box Listener, the Offset box Listener, or the Save Cents button. To turn on
automatic NoteSwitching  click once on CyberEar’s NoteSwitcher button. If you
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Stability
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to zero. Select the note you wish to measure. (The correct partials are already
chosen.) If the reference string hasn’t moved since you originally measured the
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or click on the Tune Box’s cents up and down buttons until the Spinner stops. 

For the stability section, administer the three test blows, then play the note. Click
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For the unison section, use the Tune box Listener and arrow buttons to stop the
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Be sure to clear the Offset box (reset it to 0.00¢ by clicking on the
clear button) before calibrating the Tune box to the next note’s
reference string. 
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Appendix A

Reyburn CyberTuner
Innovations in Visual Tuning 

by Kent Swafford, RPT

RCT’s ability to calculate slightly wider or narrower tunings is useful for all
pianos but is particularly valuable on small pianos with high inharmonicity. On these
pianos, two contiguous single octaves just don’t “fit” very well into a double octave.
Commonly, if octaves on these pianos were stretched, the double octaves would be
too wide and would beat noticeably. It is a genuine advancement in visual tuning to
be able to calculate successively wider or narrower tunings until a suitable
compromise is reached between the single and double octaves.

I am very excited about the accuracy of Chameleon 2 tunings because of the
specific way I like to use visual tuning devices. A VTD should provide a good
overall framework for a tuning by properly adjusting for the inharmonicity of the
piano, taking into consideration the general level of inharmonicity, the change in
inharmonicity through the scale, and my stretching preferences. This visual tuning is
a macro-tuning, if you will, fitting a tuning to the piano accurately across the scale,
creating a uniform stretch throughout. Final refinement, or micro-tuning, can take
place aurally. Since the visual tuning arranges one partial from each note into a
uniformly smooth curve, the anomalies present in the macrotuning can be assumed
to be the result of inconsistencies in inharmonicity. These anomalies would show
themselves as uneven beat rates across scaling breaks or uneven beat rates on
“maverick” notes, such as notes that exhibit negative inharmonicity. After smoothing
out these anomalies as much as possible, the resulting tuning may be superior
because the tuning will have taken into consideration all three aspects of
inharmonicity, that is, general level, change through the scale, and inconsistency.

Chameleon 2 has the flexibility to calculate its tunings so that the notes from A0 to
G#1 can be tuned from their sixth, seventh, or eighth partials. Similar flexibility is
available in the tenor by providing the option to tune A2 through G#4 from either the
third or fourth partials, and special mention must be made here of Chameleon 2’s
ability to tune well in the piano’s tenor section as a result.

The tenor area and the break between plain wire and wound strings provide unique
tuning challenges. VTD’s must make “assumptions” about the amounts of
inharmonicity a piano will have across its scale, but tenor strings sometimes
conform particularly poorly to the assumptions. Generally, inharmonicity decreases
as one moves down through the piano’s plain wire strings. On some pianos,
however, as one moves down the scale into the tenor’s lower plain wire strings, the
inharmonicity actually increases instead. It is common, particularly in small pianos,
for the lowest plain wire strings to be shorter than would be ideal, resulting in their
inharmonicity being higher than ideal. Visual tuning devices commonly tune from
the fourth partials in the tenor. When a VTD tunes the fourth partials to a uniform
curve, notes with inharmonicity higher than expected will end up with first, second,
and third partials that are too flat, with fifth partials too sharp, and with only fourth
partials tuned “right.” Intervals formed above notes like this will exhibit some very
“wrong” beat rates. Flat second partials will form 2:1 octaves that are wide, even
though the 4:2 octaves may be correct. The major thirds may be slow. So, in order
to tune these notes that, because of high inharmonicity, measure both too sharp and
too flat, depending on which intervals are checked, compromise is in order, but the
solution will be different for different pianos, both because scales differ so widely
from piano to piano, and because of the new flexibility of CyberTuner. On
well-scaled pianos, it will make little difference whether notes in the tenor are tuned
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from their third or fourth partials. However, many piano scales are imperfect, and I
am convinced that tuning the lower plain wire strings from the third partial will by
itself provide a big improvement in the tunings of many pianos. When a VTD tunes
a note with unusually high inharmonicity from the third partial instead of the fourth,
the first and second partials will be less flat, the third partial will be “right,” and the
fourth and fifth partials will be sharp. This means the 2:1 octave, while still wide,
will be less so, and the 4:2 octave will be a bit narrower than if it had been tuned
from the fourth partial. In other words, a VTD using the third partial to tune plain
wire tenor strings which have unusually high inharmonicity should provide a better
compromise (than tuning from the fourth partial), by automatically splitting the
inharmonicity-induced error between the 2:1 and 4:2 octaves. After all, a VTD that is
tuning the lower plainwire strings with the fourth partial will tune the 4:2 octaves
just fine but will put the entire error caused by unexpectedly high inharmonicity on
the 2:1 octave. Third partial tuning tends to produce clean fifths and octaves at the
expense of the major thirds which will slow down on the lowest plainwire strings;
still, this may be the best compromise possible.

It is common for the highest wound string of the tenor to have significantly lower
inharmonicity than the lowest plainwire string right beside it. Tuning a string with
unexpectedly low inharmonicity, as happens when tuning the highest wound strings
of some pianos is the other tenor tuning problem. Tuning these notes from the third
partial would cause the fourth partial to be unexpectedly flat, making the major thirds
formed above such notes to be too fast. An extra tuning record can be prepared by
Chameleon in less than five seconds. Perhaps the beat rates of such pianos could
best be smoothed out across the tenor break by preparing two tuning records and
tuning up through the wound strings above A2 with a tuning calculated to use the
fourth partial, switching at the break to a tuning calculated to tune the plainwire tenor
strings from the third partial. This new dual-record RCT procedure appears to have
clear advantages, especially on the lowest plainwire strings, over the dual-page SAT
technique that I used regularly for years to tune through the tenor break. RCT
provides many new possibilities, including tuning with one partial and checking
with another.

Excerpted from the January 1997 issue of the Piano Technicians Journal

Reprinted by permission © 1997 Piano Technicians Journal

This article reflects only the opinion of the author and is not an endorsement, either
explicit or implied, by the Piano Technicians Guild.
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Appendix B
The SentinelKey Hardware Key
Reyburn Piano Service is a very small company creating software for a very small

market. Without some form of copy protection, we couldn’t afford to develop or
support such high-quality specialized software. 

The SentinelKey is RCT’s very simple and user-friendly protection system. It’s a
small gray unit included with every purchase of RCT. To prevent unauthorized use,
RCT will not run unless SentinelKey is plugged into your computer or unless
SoftKey, its software equivalent, is installed on your computer. SoftKey only
installs on laptop computers. SentinelKey and SoftKey installation procedures are
described in the Getting Started chapter and in the separate Getting Started manual.

An unlimited number of copies of RCT may be made, but SentinelKey and
SoftKey permit RCT to run on only one computer at a time. The proper term for this
is “execution protection.”

If RCT came pre-installed on your computer, SoftKey is already installed and
enabled. This means you can use RCT immediately and don’t need to attach
SentinelKey or install SoftKey. However, you should still know about SentinelKey
and SoftKey. At some future time, you may need to plug in SentinelKey and re-
install SoftKey if you upgrade to a new version of RCT or have hardware problems.

Using SentinelKey
In this manual we use the term SentinelKey, but the actual name of the key may be

different. The keys we use are the most reliable and high quality units available.
They function exactly the same on both platforms.

FYI: Any hardware device that prevents unauthorized copying or use of a
computer application (the SentinelKey being a specific example) is sometimes called
a “dongle” by the rest of the computer world.

The SentinelEve (Mac) can be attached anywhere along the Mac’s ADB or USB
chain. The SentinelSuperPro (Win) attaches to the parallel port on Windows
between printer and PC or USB port. The key takes almost no power to run and is
invisible to the computer and any attached device.

Either Sentinel or SoftKey must be used whenever RCT is running. SoftKey
allows you to run one copy RCT at a time on a computer without the bother of
having to have the SentinelKey dangling out the back. If you want to make run RCT
on a second computer, you must first use the hardware key SentinelKey to uninstall
SoftKey from the first computer.

Rainbow Inc., the manufacturer of SentinelKey, recommends that SentinelKey be
connected or disconnected only when the computer’s power is OFF.

If you have any problem, question, or suggestion about using SentinelKey, please
feel free to contact us. Our goal is to make SentinelKey as invisible as possible while
still protecting RCT.

If you have two computers, you can use RCT on both, but not at the same time.
The SentinelKey/SoftKey system enforces use of only one copy of RCT at a time as
stated in the License Agreement in Appendix C.

Leave SentinelKey in your office in a secure but convenient place (some place
where you won’t forget where you put it!). We strongly suggest you don’t carry
SentinelKey with your computer. To keep SentinelKey safe and clean, store it in its
silver zip lock anti-static bag and original box. 

5 Year Guarantee on SentinelKey
Reyburn Piano Service guarantees the SentinelKey included with RCT for a period

of five (5) years from date of purchase. If the SentinelKey ever fails for any reason
other than misuse, abuse or failure to follow the cautions in this manual, RPS will,
at our option, replace or repair the SentinelKey. After the 5 year period, RPS will

repair    or replace the SentinelKey for a nominal cost.
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Appendix C
Important: please read carefully before using Reyburn CyberTuner.
Software license agreement/notification of copyright
This software program package (“software”) is a proprietary product of Reyburn

Piano Service, Inc., (“RPS”) and is protected by copyright laws and international
treaty. You must treat the software like any other copyrighted material, except that
you may either make copies of the software solely for backup or archival purposes,
or you may place the software on one or more hard disks, provided that only one
copy is in use at any one time.

Acknowledgments
CyberTuner, CyberEar, and Chameleon 2 are trademarks of Reyburn Piano

Service Inc.
Sanderson Accu-Tuner is a trademark of Inventronics, Inc.
PowerBook and PowerBook Duo are trademarks of Apple Computer.
Apple Macintosh is a trademark of Apple Computer.
SentinelEve and SentinelSuperPro are trademarks of Rainbow Technologies.
All product names mentioned in this manual and not listed above are trademarks of

their respective companies.

Read this license agreement before using Reyburn Cybertuner®.
This agreement is a legal contract between you, the end user, and Reyburn Piano

Service, Inc. governing your use of the software. Starting the Reyburn CyberTuner®

program for the first time indicates your acceptance of this agreement. This
agreement shall also be binding on any subsequent, authorized licensee. If you do
not wish to agree to the terms of this agreement, promptly return the complete
software package including the SentinelKey to the dealer from whom you obtained
this product. You will receive a full refund of the purchase price less shipping
provided (i)you return the full software package, and (ii) the disk packages and
SentinelKey are returned in saleable condition, and (iii) the SentinelKey is in original
condition (i.e., SoftKey has been Uninstalled). If you have any questions
concerning this agreement, contact Reyburn Piano Service, Inc., (616) 696-0500.

License
1 . Reyburn Piano Service, Inc. grants you the right to use one copy of the

software on a single-user computer or on a single terminal or workstation of a multi-
user computer or local area network. Each workstation or terminal on a multi-user
computer or a local area network must be separately licensed by Reyburn Piano
Service, Inc.

2 . You may not sublicense, rent or lease the software, but you may permanently
transfer your license to use the software and accompanying materials by delivering
to another party the original diskettes and materials comprising the software
package, and the SentinelKey, notifying Reyburn Piano Service of the transfer so
that we may transfer the registration, and by simultaneously destroying all copies of
the software and accompanying materials in your possession. Such transfer
terminates your license to use the software. The new recipient of the software and
accompanying materials accepts this agreement and is licensed under the terms of
this agreement upon initially using the software.  There may be a charge for re-
registration of the new licensee.

3 . Reyburn Piano Service, Inc., further grants you the right to make a
backup/archival copy of the software diskettes as set forth in the Notification of
Copyright, above.  You may not decompile, disassemble, reverse engineer, copy,
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transfer, tamper or modify this software or the SentinelKey, SoftKey, or otherwise
use the software except as stated in this agreement. If, in the judgment of RPS, you
have tampered with or otherwise intentionally damaged the SentinelKey, or
decompiled, disassembled, reverse engineered, copied, transferred, tampered or
modified the Reyburn CyberTuner® software, Reyburn Piano Service, Inc. reserves
the right to revoke your license, and may, at our option, refuse sale of another Eve,
or another Reyburn CyberTuner® license.

Limited Warranty/Limitation Of Remedies
Reyburn Piano Service, Inc., will replace, at no charge, defective diskettes that are

returned within 30 days of the original date of purchase. Reyburn Piano Service,
Inc., warrants that the software will perform in substantial compliance with the
written materials accompanying the software. If you report a significant defect in
writing to RPS, and RPS is unable to correct in within 30 days of the date you
report the defect, you may return the software and accompanying materials for a
refund of the purchase price less shipping. By opening the sealed disk package, you
agree that the only remedy available to you will be a refund of the purchase price of
this software program package.

Such warranties are in lieu of other warranties, express or implied, including,
but not limited to, the implied warranties of merchantability and fitness for a
particular purpose with respect to the software and the accompanying written
materials. In no event will RPS, be liable to you for damages, including any loss of
profits, LOST DATA, lost savings, or other incidental or consequential damages
arising out of your use of or inability to use the program, even if RPS or an
authorized RPS representative has been advised of the possibility of such damages.
RPS will not be liable for any such claim by any other party. 

This limited warranty gives you specific legal rights. Some states provide other
rights, and some states do not allow excluding or limiting implied warranties or
limiting liability for incidental or consequential damages. As a result, the above
limitations and/or exclusions may not apply to you. Furthermore, some jurisdictions
have statutory consumer protection provisions which may supersede this section of
the agreement.

General 
If any provision of this agreement shall be unlawful, void, or for any reason

unenforceable, then that provision shall be deemed severable from this agreement
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U.S. Government Restricted Rights
The software and accompanying materials are provided with Restricted Rights.

Use, duplication, or disclosure by the Government is subject to restrictions as set
forth in subparagraph (b)(3)(iii) of The Rights in Technical Data and Computer
Software clause at 252.227-7013. Contractor/manufacturer is Reyburn Piano

Service, Inc., 2695 Indian Lakes Road NE, Cedar Springs MI  49319.
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Appendix D

RCT Tuning Tips and Techniques

Tuning Bosendorfer Imperials
Bosendorfer Imperial grands have more than 88 keys, with extra bass notes below

A0. RCT doesn’t reserve chart cells for notes below A0; nevertheless, it’s easy to
tune those “sub-bass” notes with the following procedure.

1. Create a Ch2 tuning using the 12th partial in the low bass. Tune the 88 “normal”
notes.

2. Paste in a new blank tuning (Edit menu -> Paste Blank). In its tuning chart,
manually set the Tuning Partials of A0 to G#1 to the 6th partial. 

3. With this 2nd tuning chart still open, open CE. Using the Tune Box Listener and
the Save Cents button, measure and record the pitches of notes A0 to G#1. (You’ve
already tuned A0-G#1 to their 12th partial. Now you’re measuring each note’s 6th
partial.)

4. Still in CE, select the note one octave higher than its sub-bass note, then tune the
sub-bass note until the Spinner stops. In effect, you’ll be tuning the 12th partial of a
sub-bass note to the 6th partial of the note one octave higher. This will result in pure
12:6 octaves. (If you want wide 12-6 octaves or 14:7 or even 16:8 octaves, adjust
settings accordingly. If you’re smart enough to want this, you should be smart
enough to know how to do this without needing further explanation.)

Some thoughts on tuning and muting procedures
1. Rubber wedges. Some RCT users use two rubber wedges; some use a single

split mute.

 Hint 
Split mutes are easy to make yourself. Make two, one for grands using a pair of
standard 3/4” by 3” mutes with no handle, and another for verticals, using a pair
of long thin rubber mutes 1/4” by 5”; for the vertical split mute insert a wire handle
into the wedge furthest from the strings. Use CA glue (SuperGlue) to glue the two
rubber wedges together, taking care to keep the glue off the lower 2/3 and
offsetting the tips about 1/4” so it’s easier to keep one wedge on one side of the
unison while you “wipe” the other wedge past the unison, making it easier to
quickly bridge a three-string unison. Another hint: with scissors, cut the tip of the
“wipe-past” wedge at an angle so the tip is parallel with the strings; this will help
the tip slip into the gap between the unison you’re on and the next one up.

2. Felt strip mutes. Strip up the entire piano and pop off the mute strip to tune
unisons as you go. The order in which you’ll tune strings within a unison is a little
different from using rubber wedges, so pay attention. Some tuners like to use mute
strips on the bass and tenor sections and a rubber-wedge split mute for the treble
section.

 Hint 
If your felt strips are too thick, try peeling off a layer of felt. With care and maybe
a few tries, you can pull off layer along the entire length of the felt strip.
 
To fine tune a piano, either muting procedure can be used. Some RCT users strip

mute the entire piano and start at A0, tuning one string per note, then listen to the
tuning and make changes as necessary, and finally tune unisons from C8 down to
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A0. (Why unisons from the top down? Because treble unisons are the most difficult,
and it’s better to do them first when your ears are fresh.) Other tuners use a rubber
wedge split mute (or two single mutes) and start at A0 and tune up to the top, tuning
unisons as they go (the same procedure as pitch raising). A few tuners use RCT’s
Aural Temperament mode to tune their favorite aural temperament (e.g., the
Baldassin-Sanderson Two Octave Temperament), then tune up to the treble, then
down through the bass (single strings with felt muting strip for all notes, then
unisons).

136

A0. (Why unisons from the top down? Because treble unisons are the most difficult,
and it’s better to do them first when your ears are fresh.) Other tuners use a rubber
wedge split mute (or two single mutes) and start at A0 and tune up to the top, tuning
unisons as they go (the same procedure as pitch raising). A few tuners use RCT’s
Aural Temperament mode to tune their favorite aural temperament (e.g., the
Baldassin-Sanderson Two Octave Temperament), then tune up to the treble, then
down through the bass (single strings with felt muting strip for all notes, then
unisons).



137

Appendix E

Microphones
Most computer have a high-quality built-in microphone that work very well with

RCT. 
Although not necessary if an internal mic is present, external microphones are

sometimes preferred, especially if RCT runs on a desktop computer. The external
mic’s long cable will let you put the mic nearer the soundboard and perhaps get a
clearer signal. (But not necessarily — RCT is accurate even with the mic twenty feet
away.)

Check your computer’s User Manual for recommended microphones.
Some laptop computers require a third-party line level microphone with pre-

amplification. Choose one with a smooth frequency response from at least 50 Hz to
5 KHz. Radio Shack’s Tie Clip Microphones (part numbers 33-1052 and 33-3003)
are usually acceptable.

For extremely high-noise situations, Inventronics, Inc., offers a magnetic pickup
invented by Steve Fairchild, RPT called the “Fairchild Accu-Pickup” which should
work with most computers except those requiring an Apple PlainTalk mic. 
Inventronics’ phone number is  1-800-FAST-440. Another option for high-noise
situations is a contact mic attached to the soundboard, such as those designed for
violins, violas, etc. Fishman and Barcus-Berry manufacture quality contact mics,
and may need pre-amplification. Ask at your local pro music store for other options.

 Windows
Enclosed with RCT is a blue sheet explaining how to set the mic level

using the Windows Control Panel. You may need to do this if Ch2 or CE are
acting deaf or confused. Here it is again:

1.  Double click on the small speaker icon near the lower right corner of your
screen.

2. Choose Options then Properties in the Volume Control menu.
3. Click Recording radio button in the section tittled “Adjust Volume for”. Click

OK.
4. Adjust the volume slider for the appropriate mic you’re using (Internal or

External/Line In). Usually a setting of halfway to three-quarters works well, but you
may need to experiment with your individual machine to find its best setting. 
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Appendix F

Files created and used by RCT

1. The RCT program. Double click on this to start RCT on any platform.

 

2. An RCT alias (Mac) or shortcut (Win). Double clicking on this starts RCT. An
alias or shortcut is a pointer to a file or program, but is not the file or program itself.
Note that a Mac alias name is in italics. In Windows the “Shortcut” icon has a small
arrow.

 Note: If you rename the Shortcut on Windows, the next RCT version’s Install
program will not be able to replace it with a new one.

3. The RCT manual (this manual! - aka Mitch’s Masterpiece). Double clicking on
this icon will start the Adobe Acrobat reader program. If you don’t have Acrobat, its
free on the internet from www.adobe.com. If the RCT manual has a generic icon,
not like the one below, you are either missing Acrobat (or need to rebuild your
desktop on Mac, or need to reinstall Acrobat on Windows). The manual is text
searchable and is in full color.

4. A standard RCT document which contains tuning records. This file is created
when you calculate a tuning with Chameleon 2 or when you choose “New File” in
the RCT File menu. This file can store up to 240 tuning records. RCT can access
any number of tuning files one at a time (as many as you can save on your hard
drive).

 RCT Tuning files on Windows have an .RCT extension 

5. An RCT Exam document - notice the “E” in the icon. This file is created by
“New Exam” in the RCT File menu and contains 6 standard PTG-RPT Exam tuning
records.
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 Tuning Exam files on Windows have an .EXM extension

         

6. A User Temperament RCT document file - notice the “H” in the icon. One of
these comes with RCT. To create another, simply duplicate this file in the Finder, or
Open it with RCT and choose “Save As”. The first time you select “User
Temperaments” in RCT’s Tools menu, you will select one of these (normally the file
shown below) as your default User Temperaments file.

 User Temp’s files on Windows have an .HST extension

           

7. The RCT Prefs file stores all of the user settings for RCT.  RCT creates this file
from scratch whenever it’s not found in its usual place. If RCT is behaving
strangely, this file may be damaged. Trash or Recycle RCT Prefs to sometimes cure
problems, however if you do that all the user settings (such as spinner colors etc...)
will revert to “Factory Defaults” and you will need to reinstall SoftKey.

 On Mac, this file is in the Preferences folder, inside the System folder.
 On Windows RCT Prefs is in the Windows folder. RCT/Win stores the the

 calibration cents in RCT Prefs. Make sure to reenter the calibration cents if you
 delete this file.

               

8. A standard read-only Read me file. Its a good idea to read these! They often
contain info which was to late to make it into this manual.

        

9. Help files for RCT:

    Windows    Macintosh
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10.  These files are no longer used for RCT 3.5.

 Note: These files may be “Hidden” and may or may not display the three letter
extension depending on how you have your View Options set in Windows.

A new file used by RCT 3.5 is RCTFont.fon (hidden or invisible).

The only two files in “RCT support files...” are

Reyburn CyberTuner 3.5.rsrc
RCTFont.fon

11. PROP is a new file type in RCT 3.5. It must be used after names of User
Temperaments.
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Appendix G

Keyboard Shortcuts
CyberEar (also listed in CyberEar help window)

up arrow octave up
down arrow octave down
right arrow note up
left arrow note down
> Tune Box up by 0.1¢
< Tune Box down by 0.1¢
shift > Tune Box up by 0.01¢
shift < Tune Box down by 0.01¢
A Aural Temperament tune mode 

or Command + A  (Mac);
Control + A  (Win)

B bi-directional NoteSwitcher
C clear Tune box
D down only NoteSwitcher
E erase PR original cents for highest note recorded
H hard drive spin down (Mac only)
L lock/unlock NoteSwitcher
R Pitch Raise tuning mode

or Command + R  (Mac);
Control + R  (Win)

T Fine Tune tuning mode
or Command + R  (Mac);
 Control + R (Win)

U up only NoteSwitcher
Z sleep (Mac only)

Tuning Charts and Graphs

 Macintosh: 
Command  + right arrow next
Command  + left arrow previous

 Windows:
Control  + right arrow next
Control  + left arrow previous

Ending your RCT session

 Macintosh: 
Command + Q Quits  RCT

 Windows:
Alt + F4 Exits RCT
Alt, F, X Exits RCT
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Default buttons 
Press the Return Key or the Enter key to activate a default button (indicated by

extra border around button).

Calculate button in Ch2
CyberEar Icon in tuning chart
Depending on conditions, either OK or Start New in Pitch Raise mode

Done button in CyberEar
 Windows: Done button in CyberEar is the default button and activates with the

Enter key.
 Macintosh: Done button in CyberEar is the default button and activates with

the Return key only (not Enter).
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Change Pitch box  . . . . . . . . . . .  94
Choosing Partials  . . . . . . . . . . .  31
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Creating a New Tuning Record  . .  25
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Easy/Advanced mode  . . . . . . . .  22
Edit menu  . . . . . . . . . . . . . .  15, 96
Edit User Settings  . . . . . . . . . . .  51
Editing  . . . . . . . . . . . . . . . . . .  91
ENTER key  . . . . . . . . . . . . . . .  93
Erase data  . . . . . . . . . . . . . . . .  91
Erase Data  . . . . . . . . . . . . . .  15, 92
Execution protect  . . . . . . . . . .  1, 8
Execution protected  . . . . . . . . .  1, 8

Fairchild  . . . . . . . . . . . . . . . . .  94
File Formats  . . . . . . . . . . . . . .  58
File window  . . . . . . . . . . . . . .  90
File/Print  . . . . . . . . . . . . . . . . .  92
Find Again  . . . . . . . . . . . . .  21, 95
Find Tuning  . . . . . . . . . . . . . . .  21
Find Tuning...  . . . . . . . . . . . . .  95
Fine Tune  . . . . . . . . . . . . . . . .  66
First selected note  . . . . . . . . . . .  68
Formats allowed  . . . . . . . . . . . .  90
Fund = 0¢  . . . . . . . . . . . . . . .  100

Graph  . . . . . . . . . . . . . . . . .  88, 95
GRAPH button  . . . . . . . . . . . .  94
Guarantee  . . . . . . . . . . . . . .  4, 131
Hardware and Software Requirements  

 8, 137
Header  . . . . . . . . . . . . . . . .  14, 92
Header box  . . . . . . . . . . . . . . .  87
Header view  . . . . . . . . . . . .  20, 92
Headers  . . . . . . . . . . . . . . . . .  54
Historical Temp’ts  . . . . . . . . . .  21

How to Interpret the Interval Preview
Graph  . . . . . . . . . . .  19, 89

Ic  . . . . . . . . . . . . . . . . . . . . .  100
Icon View  . . . . . . . . . . . . . . . .  91
Identifying and naming notes  . . .  14
Import  . . . . . . . . . . . . . . . . . .  15
Installing RCT  . . . . . . . . . . . . . .  8
Installing Reyburn CyberTuner  . .  11
Interpret the Interval Preview Graph  . 

 19, 89
Interpret the Partial Preview Graph  . 

 19, 90
Interval Preview Graph  . . . . . . .  18

     Interval Preview Graph and Partial
Preview Graph  . . . . . . .  18

Kent Swafford  . . . . . . . . . . . .  129
Keyboard Shortcuts  . . . . . . . .  128

Large (automatic)  . . . . . . . . . . .  82
Large PR  . . . . . . . . . . . . . . .  77, 82
Lengths  . . . . . . . . . . . . . . . . .  111
Limits  . . . . . . . . . . . . . . . . . . .  44
Listener  . . . . . . . . . . . . . . . . . .  12
Lowest plain wire note  . . . . . . . .  81
LPWN  . . . . . . . . . . . . . . . . . .  81

Magnifying Glass  . . . . . . . . . . .  20

143

Index

A to Z Library  . . . . . . . . . . . . .  56
A1 Wound  . . . . . . . . . . . . . . .  111
A4 pitch in Ch2  . . . . . . . . . . . .  28
A6  . . . . . . . . . . . . . . . . . . . . .  35
AGC  . . . . . . . . . . . . . . . . . . .  100
AppleTalk  . . . . . . . . . . . . . . . .  106
Artificial stretch  . . . . . . . . . . . .  33
Aural Intervals graph  . . . . . . . . .  46
Aural Temp  . . . . . . . . . . . . . . .  67
Aural Temp.  . . . . . . . . . . . . . .  67
Aural Temp’t  . . . . . . . . . . . . . .  12
Average  . . . . . . . . . . . . . . . . .  21

Basic Concepts  . . . . . . . . . . . .  11
Bass overpull cap  . . . . . . . . . . .  81
Bass Partial  . . . . . . . . . . . . . . .  111

Calculate button  . . . . . . . . . . . .  53
Calibrate  . . . . . . . . . . . . . . . . .  73
Calibrate button  . . . . . . . . . . . .  73
Calibration procedure  . . . . . . . .  74
Cents to Harmonic  . . . . . . . . . .  100
Chameleon 2  . . . . . . . . . . . . . .  11
Change Pitch box  . . . . . . . . . . .  94
Choosing Partials  . . . . . . . . . . .  31
Clear Data  . . . . . . . . . . . . . . . .  110
Copy-protect  . . . . . . . . . . . . .  1, 8
Core Diameter  . . . . . . . . . . . . .  109
Creating a New Tuning Record  . .  25
Custom Equalizer  . . . . . . . . .  34, 39
Custom Overpull Percentage Charts   79
CyberEar buttons and boxes  . . . .  68

Default Pitch Raise Overpull %  . .  73
Demo button  . . . . . . . . . . . . . .  31
Detuning  . . . . . . . . . . . . . . . . .  122
Difference  . . . . . . . . . . . . . . . .  21

Differences between RCT/Mac and
RCT/Windows  . . . . . . . .  3

DMax  . . . . . . . . . . . . . . . . .  32, 37
Done button  . . . . . . . . . . . . . . .  76
Double Octave Maximum  . . . . . .  32

Easy/Advanced mode  . . . . . . . .  22
Edit menu  . . . . . . . . . . . . . .  15, 96
Edit User Settings  . . . . . . . . . . .  51
Editing  . . . . . . . . . . . . . . . . . .  91
ENTER key  . . . . . . . . . . . . . . .  93
Erase data  . . . . . . . . . . . . . . . .  91
Erase Data  . . . . . . . . . . . . . .  15, 92
Execution protect  . . . . . . . . . .  1, 8
Execution protected  . . . . . . . . .  1, 8

Fairchild  . . . . . . . . . . . . . . . . .  94
File Formats  . . . . . . . . . . . . . .  58
File window  . . . . . . . . . . . . . .  90
File/Print  . . . . . . . . . . . . . . . . .  92
Find Again  . . . . . . . . . . . . .  21, 95
Find Tuning  . . . . . . . . . . . . . . .  21
Find Tuning...  . . . . . . . . . . . . .  95
Fine Tune  . . . . . . . . . . . . . . . .  66
First selected note  . . . . . . . . . . .  68
Formats allowed  . . . . . . . . . . . .  90
Fund = 0¢  . . . . . . . . . . . . . . .  100

Graph  . . . . . . . . . . . . . . . . .  88, 95
GRAPH button  . . . . . . . . . . . .  94
Guarantee  . . . . . . . . . . . . . .  4, 131
Hardware and Software Requirements  

 8, 137
Header  . . . . . . . . . . . . . . . .  14, 92
Header box  . . . . . . . . . . . . . . .  87
Header view  . . . . . . . . . . . .  20, 92
Headers  . . . . . . . . . . . . . . . . .  54
Historical Temp’ts  . . . . . . . . . .  21

How to Interpret the Interval Preview
Graph  . . . . . . . . . . .  19, 89

Ic  . . . . . . . . . . . . . . . . . . . . .  100
Icon View  . . . . . . . . . . . . . . . .  91
Identifying and naming notes  . . .  14
Import  . . . . . . . . . . . . . . . . . .  15
Installing RCT  . . . . . . . . . . . . . .  8
Installing Reyburn CyberTuner  . .  11
Interpret the Interval Preview Graph  . 

 19, 89
Interpret the Partial Preview Graph  . 

 19, 90
Interval Preview Graph  . . . . . . .  18

     Interval Preview Graph and Partial
Preview Graph  . . . . . . .  18

Kent Swafford  . . . . . . . . . . . .  129
Keyboard Shortcuts  . . . . . . . .  128

Large (automatic)  . . . . . . . . . . .  82
Large PR  . . . . . . . . . . . . . . .  77, 82
Lengths  . . . . . . . . . . . . . . . . .  111
Limits  . . . . . . . . . . . . . . . . . . .  44
Listener  . . . . . . . . . . . . . . . . . .  12
Lowest plain wire note  . . . . . . . .  81
LPWN  . . . . . . . . . . . . . . . . . .  81

Magnifying Glass  . . . . . . . . . . .  20



144

Manual PR  . . . . . . . . . . . . . . .  82
Manual PR button  . . . . . . . . . . .  73
Marinelli  . . . . . . . . . . . . . . . . .  110
Math functions  . . . . . . . . . . . . .  21
Medium PR mode  . . . . . . . . . . .  76
Micrometer  . . . . . . . . . . . . . . .  110
Microphones  . . . . . . . . . . . . . .  137
MIDI Control  . . . . . . . . . . . . . .  13
MIDI converter  . . . . . . . . . . . .  102
MIDI Receive  . . . . . . . . . . . . .  96
MIDI-OUT button  . . . . . . . . . .  104
Moving to CyberEar  . . . . . . . . .  58

Natural stretch  . . . . . . . . . . . . .  33
Noise  . . . . . . . . . . . . . . . . . . .  54
Non-zeroed ratio  . . . . . . . . . . .  44
Notes Recorded  . . . . . . . . . . . .  83
NoteSwitcher  . . . . . . . . . . . . . .  64
NoteSwitcher button  . . . . . . . . .  65
NoteSwitcher preferences  . . . . .  65

Octave Tuning Style specifications   32
Octave Tuning Styles  . . . . . . . .  32
Offset box  . . . . . . . . . . . . . .  69-70
Offset box Listener  . . . . . . . . . .  72
Open Latest  . . . . . . . . . . . . .  15, 25
Opening a Saved Tuning Record  .  25
Organizing Files and Records  . . .  53
Organizing Tuning Files  . . . . . .  56
OTS Limits  . . . . . . . . . . . . . . .  48
Overpull %  . . . . . . . . . . . . . . .  82
Overpull Averaging  . . . . . . . . . .  79
Overpull box  . . . . . . . . . . . . . .  71
Overpull Percentages  . . . . . . . . .  78
Overpull window  . . . . . . . . . . .  71
Overview of files and records  . . .  90
Owen Jorgenson  . . . . . . . . . . .  97

Page  . . . . . . . . . . . . . . . . . . . .  14
Para-inharmonicity  . . . . . . . . . .  100
Partial (Note) Name  . . . . . . . . .  93
Partial ladder  . . . . . . . . . . . . . .  11
Partial Name  . . . . . . . . . . . . . .  87
Partial Names  . . . . . . . . . . . . .  20
Partial Number  . . . . . . . . . . .  20, 93
Partial Numbers  . . . . . . . . . . . .  87
Partial Preview Graph  . . . . . .  18-19,

 89-90
Partials  . . . . . . . . . . . . . . . . . .  35
Paste Blank  . . . . . . . . . . . . . . .  15
PAZ  . . . . . . . . . . . . . . . . . . . .  13
Pianalyzer  . . . . . . . . . . . . . .  13, 99
Piano Service Manager  . . . . . . . .  5
Piano Technicians Guild  . . . . . . .  2
Pianotek  . . . . . . . . . . . . . . . . .  110
Pitch  . . . . . . . . . . . . . . . . .  69, 87
Pitch lowering  . . . . . . . . . . .  67, 76

Pitch popup menu  . . . . . . . . . . .  68
Pitch Raise  . . . . . . . . . . . . .  67, 76
Pitch Raise mode  . . . . . . . . . . .  76
Pitch Raise Percentage Slider  . . .  78
Pitch Raise Progress Bar  . . . . . .  84
Pitch Raise Type  . . . . . . . . . . . .  81
Pitch Raising  . . . . . . . . . . . . . .  76
Pitch Raising with RCT  . . . . . . .  76
PowerBook troubleshooting  . . .  138
Predicted beat rates  . . . . . . . . . .  54
Prefs  . . . . . . . . . . . . . . . . . . .  73
Prefs button  . . . . . . . . . . . . . . .  73
PTG  . . . . . . . . . . . . . . . . . . . . .  2

Recording an aural tuning  . . . . . .  72
Redo button  . . . . . . . . . . . . . . .  30
Registered Piano Technician  . . . . .  2
RETURN key  . . . . . . . . . . . . .  93
Revert  . . . . . . . . . . . . . .  15, 88, 96
Reyburn Piano Service  . . . . . . . .  2
Rick Baldassin  . . . . . . . . . . . .  111
RPT Exam style  . . . . . . . . . . . .  34

Scoring  . . . . . . . . . . . . . . . . .  124
Scoring the RPT Tuning Exam  .  113
Search  . . . . . . . . . . . . . . . . . .  21
SentinelEve  . . . . . . . . . . . . .  9, 131
Singing length  . . . . . . . . . . . .  110
Singing Length  . . . . . . . . . . . .  109
Single Octave Minimum  . . . . . . .  37
Sliders  . . . . . . . . . . . . . . . . . .  40
Small (automatic)  . . . . . . . . . . .  82
Small PR  . . . . . . . . . . . . . . . . .  82
Small PR mode  . . . . . . . . . . . .  76
Smoothing  . . . . . . . . . . . . . . . .  64
SoftEve  . . . . . . . . . . . .  11, 15, 131

Software license agreement/notification
of copyright  . . . . . . . .  133

SOM  . . . . . . . . . . . . . . . . . . .  37
Sort  . . . . . . . . . . . . . . . . . . . .  21
Sort tool  . . . . . . . . . . . . . . . . .  96
Space bar note switching  . . . . . .  66
Spinner Button  . . . . . . . . . . . . .  62
Spinner speed  . . . . . . . . . . . . .  63
Starrett  . . . . . . . . . . . . . . . . .  110
Start CyberEar defaults  . . . . . . .  73
Start New and OK buttons  . . . . .  83
Sum  . . . . . . . . . . . . . . . . . . . .  21

TAB key  . . . . . . . . . . . . . . . . .  93
Tape measure  . . . . . . . . . . . . .  110
Target blushing  . . . . . . . . . . . .  61
Tools menu  . . . . . . . . . . . . . . .  21
Treble overpull cap  . . . . . . . . . .  81
Tune box  . . . . . . . . . . . . . . . . .  70
Tune box key equivalents  . . . . . .  70
Tuning Chart  . . . . . . . . . . . . . .  91

144

Manual PR  . . . . . . . . . . . . . . .  82
Manual PR button  . . . . . . . . . . .  73
Marinelli  . . . . . . . . . . . . . . . . .  110
Math functions  . . . . . . . . . . . . .  21
Medium PR mode  . . . . . . . . . . .  76
Micrometer  . . . . . . . . . . . . . . .  110
Microphones  . . . . . . . . . . . . . .  137
MIDI Control  . . . . . . . . . . . . . .  13
MIDI converter  . . . . . . . . . . . .  102
MIDI Receive  . . . . . . . . . . . . .  96
MIDI-OUT button  . . . . . . . . . .  104
Moving to CyberEar  . . . . . . . . .  58

Natural stretch  . . . . . . . . . . . . .  33
Noise  . . . . . . . . . . . . . . . . . . .  54
Non-zeroed ratio  . . . . . . . . . . .  44
Notes Recorded  . . . . . . . . . . . .  83
NoteSwitcher  . . . . . . . . . . . . . .  64
NoteSwitcher button  . . . . . . . . .  65
NoteSwitcher preferences  . . . . .  65

Octave Tuning Style specifications   32
Octave Tuning Styles  . . . . . . . .  32
Offset box  . . . . . . . . . . . . . .  69-70
Offset box Listener  . . . . . . . . . .  72
Open Latest  . . . . . . . . . . . . .  15, 25
Opening a Saved Tuning Record  .  25
Organizing Files and Records  . . .  53
Organizing Tuning Files  . . . . . .  56
OTS Limits  . . . . . . . . . . . . . . .  48
Overpull %  . . . . . . . . . . . . . . .  82
Overpull Averaging  . . . . . . . . . .  79
Overpull box  . . . . . . . . . . . . . .  71
Overpull Percentages  . . . . . . . . .  78
Overpull window  . . . . . . . . . . .  71
Overview of files and records  . . .  90
Owen Jorgenson  . . . . . . . . . . .  97

Page  . . . . . . . . . . . . . . . . . . . .  14
Para-inharmonicity  . . . . . . . . . .  100
Partial (Note) Name  . . . . . . . . .  93
Partial ladder  . . . . . . . . . . . . . .  11
Partial Name  . . . . . . . . . . . . . .  87
Partial Names  . . . . . . . . . . . . .  20
Partial Number  . . . . . . . . . . .  20, 93
Partial Numbers  . . . . . . . . . . . .  87
Partial Preview Graph  . . . . . .  18-19,

 89-90
Partials  . . . . . . . . . . . . . . . . . .  35
Paste Blank  . . . . . . . . . . . . . . .  15
PAZ  . . . . . . . . . . . . . . . . . . . .  13
Pianalyzer  . . . . . . . . . . . . . .  13, 99
Piano Service Manager  . . . . . . . .  5
Piano Technicians Guild  . . . . . . .  2
Pianotek  . . . . . . . . . . . . . . . . .  110
Pitch  . . . . . . . . . . . . . . . . .  69, 87
Pitch lowering  . . . . . . . . . . .  67, 76

Pitch popup menu  . . . . . . . . . . .  68
Pitch Raise  . . . . . . . . . . . . .  67, 76
Pitch Raise mode  . . . . . . . . . . .  76
Pitch Raise Percentage Slider  . . .  78
Pitch Raise Progress Bar  . . . . . .  84
Pitch Raise Type  . . . . . . . . . . . .  81
Pitch Raising  . . . . . . . . . . . . . .  76
Pitch Raising with RCT  . . . . . . .  76
PowerBook troubleshooting  . . .  138
Predicted beat rates  . . . . . . . . . .  54
Prefs  . . . . . . . . . . . . . . . . . . .  73
Prefs button  . . . . . . . . . . . . . . .  73
PTG  . . . . . . . . . . . . . . . . . . . . .  2

Recording an aural tuning  . . . . . .  72
Redo button  . . . . . . . . . . . . . . .  30
Registered Piano Technician  . . . . .  2
RETURN key  . . . . . . . . . . . . .  93
Revert  . . . . . . . . . . . . . .  15, 88, 96
Reyburn Piano Service  . . . . . . . .  2
Rick Baldassin  . . . . . . . . . . . .  111
RPT Exam style  . . . . . . . . . . . .  34

Scoring  . . . . . . . . . . . . . . . . .  124
Scoring the RPT Tuning Exam  .  113
Search  . . . . . . . . . . . . . . . . . .  21
SentinelEve  . . . . . . . . . . . . .  9, 131
Singing length  . . . . . . . . . . . .  110
Singing Length  . . . . . . . . . . . .  109
Single Octave Minimum  . . . . . . .  37
Sliders  . . . . . . . . . . . . . . . . . .  40
Small (automatic)  . . . . . . . . . . .  82
Small PR  . . . . . . . . . . . . . . . . .  82
Small PR mode  . . . . . . . . . . . .  76
Smoothing  . . . . . . . . . . . . . . . .  64
SoftEve  . . . . . . . . . . . .  11, 15, 131

Software license agreement/notification
of copyright  . . . . . . . .  133

SOM  . . . . . . . . . . . . . . . . . . .  37
Sort  . . . . . . . . . . . . . . . . . . . .  21
Sort tool  . . . . . . . . . . . . . . . . .  96
Space bar note switching  . . . . . .  66
Spinner Button  . . . . . . . . . . . . .  62
Spinner speed  . . . . . . . . . . . . .  63
Starrett  . . . . . . . . . . . . . . . . .  110
Start CyberEar defaults  . . . . . . .  73
Start New and OK buttons  . . . . .  83
Sum  . . . . . . . . . . . . . . . . . . . .  21

TAB key  . . . . . . . . . . . . . . . . .  93
Tape measure  . . . . . . . . . . . . .  110
Target blushing  . . . . . . . . . . . .  61
Tools menu  . . . . . . . . . . . . . . .  21
Treble overpull cap  . . . . . . . . . .  81
Tune box  . . . . . . . . . . . . . . . . .  70
Tune box key equivalents  . . . . . .  70
Tuning Chart  . . . . . . . . . . . . . .  91



145

Tuning chart window  . . . . . . . .  94
Tuning Doctor  . . . . . . . . . . . . .  98
Tuning file  . . . . . . . . . . . .  14, 109
Tuning File  . . . . . . . . . . . . . . .  16
Tuning Hammer  . . . . . . .  20, 91-92
Tuning Hammer pointer  . . . . . . .  91
Tuning Manager  . . . . . . . . . . .  3, 5
Tuning Partials  . . . . . . . . . . . . .  35
Tuning record  . . . . . . . . . . .  14, 90

Unwound End  . . . . . . . . . . . . .  110
Upgrade Policy  . . . . . . . . . . . . .  5
Use Anyway  . . . . . . . . . . . . . .  27
User Limits  . . . . . . . . . . . . . . .  48
User Setting  . . . . . . . . . . . . . .  50
User Temp’ts  . . . . . . . . . . . . . .  21
Using headers to organize records   55
Using this manual  . . . . . . . . . . . .  1

Variance  . . . . . . . . . . . . . . . . .  29
Verify  . . . . . . . . . . . . . . . . . . .  104
View menu  . . . . . . . . . . . . .  20, 87
Virtual direct interval tuning  . . . .  12
Virtual Memory  . . . . . . . . . . . . .  8
Voicing  . . . . . . . . . . . . . . . .  13, 99

Winding C/I/A  . . . . . . . . . . . . .  110
Winding Diameter  . . . . . . . . . . .  109
Window menu  . . . . . . . . . .  15, 109
Wire Gauge  . . . . . . . . . . . . . . .  111

Zeroed ratio  . . . . . . . . . . . . . . .  43

145

Tuning chart window  . . . . . . . .  94
Tuning Doctor  . . . . . . . . . . . . .  98
Tuning file  . . . . . . . . . . . .  14, 109
Tuning File  . . . . . . . . . . . . . . .  16
Tuning Hammer  . . . . . . .  20, 91-92
Tuning Hammer pointer  . . . . . . .  91
Tuning Manager  . . . . . . . . . . .  3, 5
Tuning Partials  . . . . . . . . . . . . .  35
Tuning record  . . . . . . . . . . .  14, 90

Unwound End  . . . . . . . . . . . . .  110
Upgrade Policy  . . . . . . . . . . . . .  5
Use Anyway  . . . . . . . . . . . . . .  27
User Limits  . . . . . . . . . . . . . . .  48
User Setting  . . . . . . . . . . . . . .  50
User Temp’ts  . . . . . . . . . . . . . .  21
Using headers to organize records   55
Using this manual  . . . . . . . . . . . .  1

Variance  . . . . . . . . . . . . . . . . .  29
Verify  . . . . . . . . . . . . . . . . . . .  104
View menu  . . . . . . . . . . . . .  20, 87
Virtual direct interval tuning  . . . .  12
Virtual Memory  . . . . . . . . . . . . .  8
Voicing  . . . . . . . . . . . . . . . .  13, 99

Winding C/I/A  . . . . . . . . . . . . .  110
Winding Diameter  . . . . . . . . . . .  109
Window menu  . . . . . . . . . .  15, 109
Wire Gauge  . . . . . . . . . . . . . . .  111

Zeroed ratio  . . . . . . . . . . . . . . .  43


